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1. New in Samgods version 1.2.3 

The main changes introduced in Samgods version 1.2.3 are: 

• Database Revisions: Updated input and created a separate set of calibration databases 

for the 2019 base year and 2045 forecast year. These revisions include updates to 

costs, networks, and PWC matrices. 

• Node and Zone Management: Revised node naming and indexing conventions. 

Additionally, the "SamGods_zones" table in Input_data.mdb has been updated to include 

19 previously missing Norwegian zones. 

• MPS Program: Following adjustments to the MPS program, model results are now 

aligned with expected values. 

• Buildchain Program: Solved a couple of bugs that affected the model results. 

• Reporting Enhancements (Report 6): Implemented a fix for Report 6 in 

Outputs_Calibration_Template_revXX.xlsx in order to reflect the correct statistics. The 

updated Cube script now includes feeder trains within the "wagonload" category. 

• CBA Report: Refined the CBA report format for seamless Excel integration. Data is now 

correctly delimited and sorted into the appropriate columns when the text file is imported. 

• System Pathing: Improved the core source code to support longer folder directory 

structures. 

• Setup Tracking: To improve configuration tracking, the model now generates a 

[Scenario_Name]_CatalogKeys.csv file. This file logs all Cube run settings used for that 

specific scenario. 

• Sea Link Labelling: Update for the labels for the Sea links. Now they are based on 

loaded + empty (TOTV). This change affects the following GIS maps: 

o Output_[year]_CMD_RCM_GIS_VHCL.mxd 

o Output_[year]_CMD_STD_GIS_VHCL.mxd 

• On-Demand empty GIS Maps: Introduced a new application allowing users to generate 

GIS maps with absolute flows from existing scenarios without requiring a full model run. 

• Module Stability: Resolved various bugs within the BuildChain module. 

• Environmental Compensation: The latest version provides a clearer representation of 

environmental compensation in Input_Data.mdb. The new attribute "SUBKM" has been 

added to the Tax_Country_Base2019 and Tax_Country_Main2045 sheets. 
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2. Preface 

The national model for freight transportation in Sweden is called Samgods. The model aims to 

provide a tool for forecasting and planning of the transport system in Sweden. Samgods can be 

used for forecasting of possible future scenarios, such as the evaluation of the effects of 

transport policies. Samgods consists of several parts, where the logistics module is the core of 

the model system. In the logistic module, different types of commodities are assigned to different 

types of transport chains based on minimization of the total logistics cost. 

To make Samgods more user-friendly, a graphical user interface (GUI), incorporated in Cube, 

has been developed. 

This document is the manual for how to use the model system where Samgods has been 

implemented. For more information about the Samgods model, please refer to: 

• Method report of the logistics model in the Swedish national freight model system [1] 

• Program documentation for the logistics model for Sweden [2] 

• Railway capacity management for Samgods using linear programming with a stochastic 

approach [3] 

• Technical documentation [4] 

• Representation report [5] 

• Kalibrering [6] 

• MPS documentation [7] 

• SelectDirect documentation [8] 

• Samgods PWC-matriser 2019 och 2045 [9] 

SYSTRA has incorporated Samgods in Cube and has produced this manual. 

For questions regarding the system, please contact Petter Hill at Trafikverket, or visit the 

webpage www.trafikverket.se/samgods.
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3. Introduction 

This document is the manual for how to use of the graphical user interface (GUI) of the Samgods 

model in Cube. It describes how to setup input files to run the Logistics Module and Rail Capacity 

Management procedure of the Samgods model, how to visualize the output (modal split, traffic 

work, etc.), and how to compare the output from different scenarios. Moreover, the manual aims 

to show how to use different tools developed to facilitate the handling of the large amount of data 

produced by the model. 

The system consists of a set of main software components: 

• The Logistic module, which is the core of the system. 

• The Rail Capacity module, which is a feature to manage rail link flow volume constraints. 

• Cube Base, where the graphical user interface of Samgods is incorporated. 

• Cube Voyager, which is a transport modelling software used to implement supply and 

assignment models. 

• Cube GIS, which is the geographical information system where the network of the model 

is implemented. 

This is the outline of the manual: 

Chapter 4: Glossary, explaining important glossaries used in this manual. 

Chapter 5: Practical instructions for how to install the Samgods GUI in Cube, together with 

system requirements. 

Chapter 6: General description of the structure of the GUI, the different windows and how to 

work with the applications. It also contains a table with all data that can be accessed via the Data 

Section window in the GUI. 

Chapter 7: Detailed description of all applications, in terms of input data, possible actions and 

choices for how to use the different applications in the system and how to set up the results. This 

chapter should be used more as a look-up guide per application, rather than to be read from start 

to end. 

Chapter 8: General instructions for how to use the graphical user interface, listed after the kind 

of action the user wants to do. A new user to the system is advised to start reading here, after 

having read Chapter 7. 

Chapter 9: Instructions for how to make different kinds of scenario setups. 

Chapter 10: Advanced user options 

Chapter 11: Log reports from the Samgods GUI and Check-list when errors occur. 

Chapter 12: Examples of maps on outputs 

Chapter 13: References 

Chapter 14: Appendices 

For all the users, it is strongly recommended to follow instructions on file naming conventions 

and coding listed in subsection 11.5. 

For the reader who is interested in getting started quickly and who already has some knowledge 

of the Cube system, it is recommended to make sure that the system is properly installed as 

described in Chapter 5, and then jump to Chapter 8 and 9 for the specific analysis that needs to 

be carried out.  
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For the reader without previous knowledge of the Samgods GUI or Cube, it is recommended to 

start with Chapter 6 and then read Chapter 8 and 9 from the beginning and refer to Chapter 7 for 

more information on the specific applications. The appendix (Chapter 14) also contains 

explanations on some parts of the model. 

The use of Cube Base and Cube Voyager is described in the reference guides 

RG_CubeBase.pdf and RG_CubeVoyager.pdf, which can be found where Cube is installed 

(under Citilabs\Cube folder). 

Finally, a technical description of Samgods model is available, please see [4]. 
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4. Glossary 

Below are some important glossaries used in this manual. Observe that for some glossaries, the 

explanation is specific to this context.  

 

Application – a group of programs 

Assignment model – a model where the transport demand is assigned to the network. In this 

context, Voyager is used as an assignment model. The automobile and lorry assignments are 

based on generalized time for route choices and all-or-nothing solution. 

Base scenario (or base) – the scenario that is used as reference scenario. See Scenario. 

Commodity or Product group - commodity type in the model. 

Catalogue – the folder where the Samgods model and its set of scenarios are stored. Several 

catalogues, with their corresponding base scenarios, can be included in a project. 

Demand model – a model of the transport demand in terms of OD matrices. In this context, the 

Logistics Module in the Samgods model is a demand model. The Logistics Module has the 

purpose to produce the OD matrices (demand for vehicle movements on legs) from the fixed 

transport demand provided in the PWC matrices (PWC = Production Warehouse Consumption). 

Domestic – transport volumes between domestic zones. 

EOQ - Economic Order Quantity 

Feature class - used in ArcGIS. This is a collection of geographic features with the same 

geometric type (such as point, line or polygon), the same attributes and the same spatial 

reference. Feature classes can be stored in geodatabases, shape files, coverages or other data 

formats. Feature classes allow homogeneous features to be grouped into a single unit for data 

storage purposes. 

Geodatabase (or short: gdb) – a database designed to store and handle geographic 

information and spatial data.  

Keys – a varying input into an application (i.e., parameter settings). Catalogue keys are used to 

specify settings for the applications etc. 

MAT - extension for matrix file produced in Cube (binary format) 

Layer – used in GIS. This is the visual representation of a geographic dataset in any digital map 

environment.  

LOS (Level Of Service) matrix (or skim matrix) – a matrix where a particular measure, such as 

time, distance, cost, are summarized link-by-link along the minimum cost path for each OD pair 

(OD = Origin Destination). The distance, domestic distance, fee/toll, and extra cost LOS matrices 

(defined per vehicle type) are mandatory input to the Samgods model. 

Program – a single task or an instance. 

regional diff DT – Reference to regional differentiation by domestic and total domestic. 

regional diff DTI – Reference to regional differentiation by domestic, total domestic and 

international. 

RCM - Rail Capacity Management module. 

S/A user - Standard User / Advance User. 

Scenario – refers to a set of input files or values. A scenario can be a base scenario, or it can be 

an alternative scenario that is studied in relation to the base scenario, e.g., a child to the base 
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scenario. An existing scenario means that the scenario-specific tables are included in the main 

geodatabase. 

Scenario folder – the folder containing all the data for a specific scenario, located in the 

Scenario_Tree folder. 

Skim matrix – see LOS matrix 

Standard outputs/reports – the outputs/reports that the Samgods GUI always produces. 

STD - STanDard logistics module. 

Supply model - In this context, a supply model (or network model) is the model of the network 

where the transport infrastructure, such as nodes and links (i.e., ports, railways, roads, etc.), are 

implemented. In this context, Voyager is used as supply model. 

TOC – Table Of Content, see Section 8.15. 

Total domestic (or Tdomestic) – same as domestic + domestic part of international transports 

V/C – flow volume over capacity ratio for rail flows. 

#LEA-vehicles – Reference to loaded, empty and all vehicles respectively. 

NORIG – the Emme node number and its specification comes from a set of rules when edits are 

made in GIS interface 
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5. Installation Instructions 

This chapter describes the installation requirements, required programs for the Samgods GUI 

and their download locations and the installation procedures for each required program. It also 

describes how to setup the Samgods model in Cube. 

5.1. Minimum system requirements 

Cube Base will run on any Intel Pentium 4-compatible personal computer (including Pentium 4, 

Centrino, Xeon, AMD, and Cyrix chips) running the Windows 8.1/10/11 or Windows Server 

2016/2019 operating system. The requirements for processor speed, amount of RAM and hard 

disk space are directly related to the operating system, the network, and other file sizes. At a 

minimum, Bentley indicates: 

• Processor: Intel Pentium 4, AMD Athlon 

• Memory/RAM: 1 GB to run Cube but at least 4 GB to run the full Samgods model. 

• 10 GB for the application and supporting applications and data (like GIS); ATAPI IDE, 

5,400 rpm 

• 100+ GB for output files 

• 24-bit capable graphics accelerator OpenGL version 2.0 runtime and Shader Model 3.0 

or higher is recommended; ATI or Nvidia GPU is strongly recommended for any 3D GIS 

work or Cube Dynasim micro simulation 

• 17-inch monitor, 1024 x 768 higher at Normal size (96dpi); 24-bit colour depth 

• Mouse or another pointing device  

• Colour printer or plotter 

A system with additional resources may be more appropriate for certain applications of this 

software. 

Running the Samgods model at an acceptable performance puts a demand on the hardware, as 

well as, on the operating system. The hardware should preferably have several processors 

available for parallel executions and several GB of RAM to support the allocation of memory to 

each execution and must be based on 64-bit technology. The operating system needs to be able 

to allocate a certain amount of memory to the different processors, see the list below. 

In tests, the Samgods group has lowered the total execution time from over 24 hours to just 

above 4 hours by using a laptop with 8 processors and 16 GB of RAM on a 64-bit Windows 10 

Operating System, instead of a laptop with a single processor. 

The graphical interface of the Samgods model allows the user to set the number of commodity 

groups to run simultaneously, in order to have an optimal performance of the system (note that 

this option is available only if Java runtime environment is installed see Section 5.4 below). The 

monitoring of the parallel executions is done by a Java program underneath the GUI, but the 

actual work of allocating memory and tasks to each processor is done by the operating system 

itself. 

There is an upper limit on how many processors that may be used simultaneously: 

• It is strongly recommended that the number of parallel executions not exceed the 

number of available processors 
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• Each processor should in average have at least 2 GB of RAM available, or the program 

may encounter out-of-memory problems 

• It is mandatory to run the model on a 64-bit system for the RCM procedure to function. 

• The model has 16 commodity groups and this number constitutes the upper limit for the 

number of parallel processes for the main part of the logistics model (should the 

hardware allow it). One task involves construction of OD-matrices for 40 vehicle-types, 

and this can in principle be parallelized into 40 parallel processes. 

5.2.  Cube Software  

For the Samgods GUI to function, certain Cube software is required. They are: 

• Cube Base: 6.5.1 CE 

• Cube Voyager: 6.5.1 CE 

• Cube GIS: ArcGIS Engine 10.8.2 

This software is available at https://bentleysystems.service-

now.com/community?id=community_blog&sys_id=a91a87df1b390690dc6db99f034bcba2 . 

For the above Cube software, Bentley License Management Tool is required. Please contact 

Bentley for further information regarding this. 

The installation also requires some custom-built programs developed specifically for Samgods 

1.1. They are available by contacting Petter Hill at Trafikverket and will be distributed over ftp. 

5.3.  Cube Installation 

To install and run the model full administration rights are required on the PC, or more specifically 

on the model folder, the Citilabs program folder, the ArcGIS program folder and the user folder. 

Do the following steps to install Cube (observe that these steps can be slightly different 

depending on previous installations, newer software versions, etc.): 

• Install Bentley License Management Tool CONNECTION Client 

• Install Cube Base 

• When requested, install ArcGIS Engine 10.8.2 (it is mandatory to use this ArcGIS version) 

• Restart the computer 

• Set the properties for Cube program according to Figure 1. Please ask support from the IT if 

special administration rights is required or the settings changes when restarting the machine.  

https://bentleysystems.service-now.com/community?id=community_blog&sys_id=a91a87df1b390690dc6db99f034bcba2
https://bentleysystems.service-now.com/community?id=community_blog&sys_id=a91a87df1b390690dc6db99f034bcba2
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Figure 1 Compatibility mode “Windows8” for Cube (same in Windows 11) 

5.4. Other programs 

The model uses the programming language Java, therefore it is required to have: 

• Java runtime environment (jre). Platform: 8 Product: jre8 (later program versions are also 

possible to use) 

Location for the above programs: http://www.java.com/sv/download/. 

• For RCM the following CLP software is provided, CLP64.exe. So far, it is a superior 

alternative for RCM-problems according to experience. 

5.5. Samgods GUI installation 

Unzip the zipped file Samgods_V1.2.3.7z, and select a destination folder. The default folder is 

C:\Models\, however, any other folder works as well. It is recommended to select a folder name 

without any blank value neither special character (å, ä, ö). Moreover, an advice is to put the 

folder close to the root. The folder structure for the GUI is displayed in Table 1. 

 

http://www.java.com/sv/download/
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Table 1 Folder structure 

Path Content Type 

C:\Samgods\ Samgods.cat CUBE Catalogue file 

C:\Samgods\ 01_Programs Folder 

C:\Samgods\ 02_Applications Folder 

C:\Samgods\ 03_GIS_Data Folder 

C:\Samgods\ 04_Media Folder 

C:\Samgods\ 05_Input_Data Folder 

C:\Samgods\ 06_Reports Folder 

C:\Samgods\ 07_Python Folder 

C:\Samgods\ 08_Standalone Folder 

C:\Samgods\ Scenario_Tree Folder 

The scenario folder for a specific scenario is in the Scenario Tree folder.  

For the complete list of folders and files, see the technical documentation [4] of the Samgods 

GUI.  

To properly install all the programs connected to the model (GIS tools, user programs), do the 

following: 

1) Open the catalogue file (Samgods.cat) in Cube Base (double click on the catalogue file 

or double click on the Cube icon on the desktop -> welcome screen -> open an existing 

catalogue -> browse to Samgods.cat) 

2) To update the paths for the application, double click on each application (in total 11 

applications) under “Applications” window, and click “Yes” to the following question (11 

times): 

 

“The base path of this Application has been moved from {Old folder} to {Selected folder}. Do you 

wish to update the path for all Application (.APP, .PRJ) and Control (.CTL) files in the Application 

structure? (Note the same subdirectory structure as in the original Applications will be assumed)” 

3) To set the properties of the catalogue file, go to “Scenario” menu on the toolbar and 

select “Properties”. On the Catalogue Properties window, select the “Model User” tab, 

and set the Model User as “Model Applier”. Under Model Applier section select 

"Developer" as shown in Figure 2.  

 

Figure 2 Correct settings for the catalogue file 

Then, select the “Data Panel” tab, and set the values as in Figure 3. 
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Figure 3 Property setting for the catalogue file 

4) Click “OK” to continue 

5) Modify the catalogue keys (i.e., parameter settings) below from the interface in the 

following manner: 

a) Select Scenario_Tree scenario 

b) Select the Installation application 

c) Double-click on the Scenario_Tree scenario 

d) For the following catalogue keys, change to its corresponding installed version if 

needed1 (see Figure 4 for an example): 

i) “Hard Drive where the model resides” (pre-defined: C:) 

ii) “Cube Software” (pre-defined: version 6.5.1)* 

iii) “ArcGIS Software” (pre-defined: 10.8)* 

iv) “Python Software” (pre-defined: version 27)  

v) “Logistics Model Software” (1.2.2) 

For the catalogue key “Location of Python program” change if needed the folder where Python 

27 is installed (pre-defined: C:\Python27\ArcGIS10.8) 

vi) For the catalogue key “Location of Java program” change if needed the 

folder where Java is installed (pre-defined: 

C:\ProgramData\Oracle\Java\javapath) 

vii) For the catalogue key “Path to cmd.exe:” change if needed the folder 

where cmd.exe resides 

 

 
1 If Swedish Windows 7/8 is used, the system name of the standard Program folder is Program Files. So, in the keys in 
the Installation application, will be used “C:\Program Files\...” (i.e., not “C:\Program\...”). 
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Figure 4 Example of catalogue key values for the Installation application 

For the catalogue key “Scenario name for the BASE scenario” point to the scenario that should 

be used as base scenario (pre-defined: Base2019)  

e) Run the Installation application by clicking “Run” in the scenario interface, or by 

selecting Application -> Run Application -> OK on the main toolbar. (If “OK” is clicked 

instead of “Run”, the application will not run – the changes in the settings will only be 

saved.)  

f) Save the model catalogue clicking on save in the top right corner, see Figure 5. 

 

 

Figure 5 Save the catalogue file in the graphical user interface in Cube 

Now the GUI is installed. 

 

* To properly set the values for the catalogue keys indicated with *, see the information under the 

Menu Bar; Help -> About (see Figure 6 and Figure 7 below for an example). 
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Figure 6 How to access the “About …” information 

 

 

Figure 7 Example of the “About …” window 
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6. Cube Interface components 

This chapter outlines the main components of the Cube Interface and explains their functions. 

The Cube Interface has five different windows as shown in Figure 8. When opening the model, 

three different user types can be selected – Model developer or Standard user or Advanced 

user. The Model developer role is mainly used when setting up or installing the system, while the 

Standard and Advanced user roles typically are used when running the model and for scenario 

handling. The set of active windows depends on the user role, and this manual is relevant to all 

user types. 

The large area to the right is a workspace where manager windows and messages are shown, 

i.e., when the user wants to manage a scenario, the Scenario manager window is shown here. 

There are also Application manager windows and Data section manager windows. The manager 

windows are opened from the corresponding window on the left-hand side. 

For more information on the Cube interface, please refer to the Cube Help, accessed from the 

main toolbar: Help -> Cube Help. 

 

 

Figure 8 Example of Scenario manager window 

6.1. Scenario window 

The purpose of the Scenario window is to list the scenarios that exist in the model. 

A scenario refers to a set of specific input files/values. An application is a group of programs. In 

the Samgods GUI a set of applications are defined with different types of functionalities. Different 

scenarios can be set up in the GUI by using the set of available applications. A scenario can be 

opened and managed using different applications by double-clicking on the scenario name in the 

Scenarios window (in Standard user/Advanced user mode). For example, the input data and 

parameters to the scenario can be displayed or edited. When the scenario is open in the 

Scenario manager window, it is possible to select the application which the user wants to use by 

the scroll down menu. Another way to open the application which the user wants to use is to 

Application manager window 

Scenario 

window 

Data section 

window 

Application 

window 

Keys 

window 
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select the application in the Applications window and then double-click on the scenario in the 

Scenarios window. The application is then run by clicking “Run”. 

The tree structure of the scenarios included in the Samgods GUI is visualised in the 

Scenario_Tree in the Scenarios window. The Scenario_Tree is used for scenario management.  

The default base scenario is included in the Scenario_Tree and is called Base2019. In the base 

scenario all the input data is defined and it represents the parent for future sibling and child 

scenarios. 

An example of a Scenario manager window for the application Edit the data is given in Figure 9 

below. 

 

Figure 9 Example of Scenario manager window 

The keys which are possible to set values for in the Scenario manager window are strictly 

connected to the application selected in the Applications window. In Chapter 7, tables of keys 

connected to the respective applications are presented. 

 

 

6.1.1. Implication in scenario setup for new scenarios 

In the following paragraphs will be explained the rules in Cube software and the ones specifically 

designed for Samgods Model under scenario setup. To avoid wrong catalogue definitions in 

specific scenarios is sufficient to: 

• identify which is the model year that the user wants to run 

• create a child scenario under Year_2019 or Year_2045 

If a specific scenario holds catalogue key values that the user wants to preserve in the next runs 

(without the need to change again all the modified catalogue keys), it would be sufficient to 

create child scenarios from that scenario. 

 

 

  

Keys 

Tip. Open an application (in model applier mode) to set the parameters for a scenario by 

double-clicking on the scenario and select the application in the scroll down menu. 
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6.1.2. Catalogue key values definitions in Cube 

The catalogue key value for any catalogue key in a specific scenario is based on the following 

four rules: 

• Rule 0: no default value is specified in the catalogue key. The catalogue key is empty. 

• Rule 1: Default value of the catalogue key: the default value is specified during the 

creation of the catalogue key. 

• Rule 2: Specific value changed by an intentional action of the user. 

• Rule 3: Value from father scenario: creating a child scenario, all the values for all 

catalogue keys will derived from father scenario. 

Which of the above rules is applied depends on the actions performed by the use and their order. 

Rule 0: no default value 

Looking at a simple example in which is present only one scenario (Base) and only one 

catalogue key (numerical) “Example”, see Figure 10. 

 

Figure 10 Example of scenario and key  

The value for the scenario is empty, since no default value has been applied. (Rule 0). For all 

child scenarios created, “Example” will be always empty. See Figure 11. 

 

 

Figure 11 Example of inherited key Rule 0 

Rule 1: default value 

The catalogue key can be created with a default value. Each new scenario will have the default 

value in it without any action. For instance, in “Example”, defining a default value of 99, will result 

in getting 99 in all scenarios (Base and children), see Figure 12. 
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Figure 12 Example of inherited key value according to Rule 1 

From the GUI, it is also possible to understand that the value is derived from the default value by 

the form of the element under Keys window. If is grey, (as in our example above - see red 

rectangle in Figure 12), the key has a default value and neither the current scenario nor its 

parent defines a value for the key. In this example, it means the user can understand that both 

CHILD1 and Base are using a default value, otherwise a different form will be used.  

Rule 2: User changes the value intentionally for a specific scenario 

Suppose that for CHILD1 the user wants to apply a value of -100 rather than the default value. 

This change will affect CHILD1 and all the future child scenarios created under CHILD1. The 

form of the element under Keys window (red rectangle) will be bold, see Figure 13. 

 

Figure 13 Changed value of inherited key, Rule 2 (see value in bold) 

In other words, every time the form is bold, means the rules from father scenario or default value 

are broken. What is specified in the current scenario has been intentionally changed from the 

father scenario.  

Rule 3: Value from father scenario 

Rule 3 is the standard rule which does not require any action from the user. The final value 

depends if the father scenario has Rule 0, Rule 1 or Rule 2 in place. In the examples above, 
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CHILDOFCHILD1 has -100, since father scenario has Rule 2 in place (modified value from 

default). Form under “Example” is in Italics, see Figure 14. 

 

Figure 14 Illustrates inherited key for second child scenario 

CHILDOFCHILD2 has 99 since father scenario and base have Rule 1 in place. Form under 

“Example” is still in grey.  

Summing up what is the content of “Keys window”: 

• The first row of the key grid gives the name of the currently selected scenario. 

• Subsequent rows list each key in the catalogue. 

The value of the key for the current scenario is shown in the Value column. It may appear in one 

of the following forms: 

• Blank if the key value is undefined for the selected scenario. 

• Bold if the value is defined explicitly for the selected scenario. 

• Italics if the value is inherited from the parent scenario. 

• Grey if the key has a default value, and neither the current scenario nor its parent 

defines a value for the key. 

6.1.3. Catalogue key values definitions in Samgods model 

The scenario tree structure in Samgods model follows the rules explained in previous paragraph 

and each catalogue key can follow one of the rules. Scenario Tree holds all the default values for 

all catalogue keys, see Figure 15. In the initial installation only the catalogue keys related to 

program folder location or version must be modified.  
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Figure 15 Default values of scenario tree keys 

“Year_2019” and “Year_2045” Scenarios are functional in keeping in place the right values for 

the following catalogue keys: 

Maximum number of zones: Year_2019 has the default value (1383 grey), Year_2045 has 

default value (1383 grey), see Figure 16  

Year of PWC matrices: Year_2019 has the default value 2019 (grey), Year_2045 has value 2045 

(bold), see Figure 17 
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Figure 16 Default key values for scenario Base2019 
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Figure 17 Default key values for scenario MainSc2045 

Lock solution table (Table with list of locked solutions): Year_2019 has value “2019”, Year_2045 

has value “2045”. 
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6.2. Applications window 

In the Applications window all applications defined in the model catalogue can be found. An 

application group is the collection of programs and sub-groups belonging to the respective 

application. When an application is selected (by clicking on it in the Applications window) the 

application group is shown in the Application manager window. In the Application manager 

window, the user can see Program boxes (e.g., MATRIX, HIGHWAY, NETWORK, and PILOT) 

and/or other applications (called sub-groups) belonging to the application group (see Figure 18). 

In the Applications window, the user can see the main application at the highest level, and go 

through the tree structure down to lower levels. 

 

Figure 18 View of an application and its corresponding application groups 

In the Samgods GUI, the defined applications are (see the Applications window in model 

developer mode): 

• Installation 

• Create the editable files 

• Edit the data 

• Samgods Model 

• Compare Scenarios 

• Handling scenario 

• PWC_Matrices 

• Change matrix format 

• Select Link Analysis 

• Cost Benefit Analysis - ASEK Values 

• Elasticity Module 

• Create Maps 

 

 

Application 

group 
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6.3. Data Section window 

The Data Section window provides direct access to the main input and output files, which can be 

utilized when working with the model (editing, controlling, etc.). It allows the user to display and 

edit the input data, as well as to display the outputs and reports for specific scenarios and runs. 

In conjunction with the Scenario manager window, it enables the user to easily access all data, 

without needing to know where it is actually stored. The structure of the Data Section window is 

described in Table 54 in the appendices section 14.7, which also shows the location of the files, 

the names of the tables/maps, a short description of its contents and which application that 

produces or uses the files.  

There are three main folders in the Data Section window: Scenario Inputs, Scenario Outputs and 

Scenario Reports. The General tables under Scenario Inputs are always accessible from the 

Data Section window. The Editable data (also found under Scenario Inputs) is accessible only 

during the edit phase or if the user has selected not to delete the temporary geodatabase (see 

explanation for the Edit the data applications in Section 7.4). 

The available output in the Scenario Outputs folder depends on the choices made when running 

the Samgods Model application. The available outputs in the folder Scenario Outputs\Samgods 

Report are always listed in the log report Scenario Outputs\ Existing Outputs. There are two 

other log reports except Existing Outputs: Report for the import phase and Report for the edit 

phase (under the folders Scenario Outputs\Scenario_Import_function_Report and Scenario 

Outputs\Edit the data Report respectively, which state any error messages or other messages 

from the applications Handling scenario and Edit the data. For more information on the log 

reports see Chapter 12 Chapter. 

Moreover, the Data Section window includes the standard reports (also called summary reports): 

per Standard Logistic Module, for RCM and for Cost Benefit Analysis, which summarize the 

output from running the Samgods GUI, in Word format. The summary reports are found in the 

Scenario Reports folder and are listed in Table 54. To browse the different pages in the reports, 

use the arrows in the main toolbar. It is possible to export the tables to Excel, by selecting the 

table in the Word format report, right-clicking and selecting “Export” and type in a name with an 

Excel file format ending. Some of the standard reports are also available as spreadsheet reports 

in the Scenario Outputs folder, where they are marked with the same report number as in 

Scenario Reports (see, e.g., Scenario Outputs\Samgods Report\Logistic Module\OD Covered).  

For some of the data files, the variable names that appear in the headings are explained in 

tables in the appendix. Before using and analysing any output data regarding empty 

vehicles/vehicle kilometres or the total number of vehicles (i.e., loaded + empty vehicles), please 

read the Section 14.2 about empty vehicles in the appendices. The GUI allows producing 

different aggregations in the results for Standard Logistic Module. The model could produce the 

total number of loaded, empty and tonnes for all the commodity groups, or just for a specific 

commodity group. The outputs will be saved with different name files ending with a number of a 

suffix. Depending on the user choice, the possible values could be: 

• 0 (zero): all the commodities are aggregated, so the volumes and tonnes represent totals 

• A number among 1 and 16: a single commodity has been run  

In order to access to the different aggregations, e.g., different files, it is requested to set the 

value for catalogue key “Select commodities for the Logistics module (…)” in the Samgods Model 

application to the commodity or commodity group number the user wants to view and clicking 

“Save” (please refer to Section 7.5 for more information). 

For RCM and Cost Benefit Analysis, there are no options and the only available choice is 0. This 

is because the process requires all the volumes to properly assess the congested level on the 
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rail network. Therefore, a run for a specific commodity would show inconsistent results to a full 

run with all commodity group. 

6.4. Keys window 

The model is based on Scenario Manager and Application Manager. Applications represent the 

flow chart of the model containing calculation and specific programs, while the purpose of 

Scenario Manager is to allow an application to be conveniently executed with a varying set of 

inputs. This allows the user to compare the effects that different input values have on the results. 

A set of input values is a scenario and the varying inputs to the applications are called “keys”. 

Catalogue keys define items that vary each time an application in a catalogue is run. They may 

represent a file, number, character string, or Boolean flag. For instance, using a key it is possible 

to specify different values for parameters, different networks for LOS calculation and assignment, 

different control parameters for the Logistics Module or more. 

In general terms the keys may serve different purposes; in summary: 

• To manage input data. 

• To give general settings for the model. 

• To enable different ways to run the model. 

A key can for example be: 

• The name of an input data file. 

• A directory. 

• A check box with true or false value. 

• A check list to choose a specific value. 

• A constant. 

• A radio button. 

Different kinds of keys appear in applications and other places where it is possible to select the 

settings (for rules applied see section 6.1.2 and 6.1.3).  

In Chapter 7, the available catalogue keys for each specific application are listed. Catalogue 

keys are defined as keys for setting up parameters in the applications. The Keys window is 

available in developer mode and it is also possible to display from Main toolbar -> Scenario -> 

View -> Show Keys.  

The following keys in the Cube interface are called system keys:  

• {CATALOG_DIR} is the directory where the .cat file is located 

• {SCENARIO_DIR} is the directory where the scenario folder is located 

{SCENARIO_CODE}, {SCENARIO_SHORTNAME) are defined in the Scenario 

Properties, see Fel! Hittar inte referenskälla.. 

• {SCENARIO_FULLNAME} = 

{SCENARIO_SHORTNAME_PARENT}.{SCENARIO_SHORTNAME}, where 

{SCENARIO_SHORTNAME_PARENT} is the base scenario to the current scenario 

These keys are important components in each scenario. Please refer to the online Cube Voyager 

help available from the menu bar for further information (see for instance Scenario Manager > 

Working with applications and catalogs > Cube Voyager and TP+ scripts). “Scenario properties” 

is accessed by right-clicking on the topical scenario in the Scenarios window and select 

“Properties” (see Figure 20). 
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Each time a scenario is created all catalogue keys should be given a value. Some of the keys 

have a default value. If the default value is changed by the user, it will become specific for that 

scenario. When a scenario is created as the child to another scenario, it will inherit all the 

catalogue key settings from the parent.  

In the Keys window information on the origin of the keys can be found. The keys for a specific 

scenario and application can be viewed by selecting the scenario in the Scenarios window by 

clicking on it, and selecting the application in the Applications window in the same way. The keys 

marked in black in the Keys window are undefined. The keys are shown in bold font if they have 

been explicitly defined by the user and in italics if they have been inherited from the parent 

scenario. If the value is in grey font, it is a default value that has not been changed by the user, 

neither for the current scenario, nor for its parent. 

More information about the keys and the scenarios can be found in the Cube Help, accessed 

from the main toolbar (Help -> Cube Help -> Cube Base -> Scenario Manager -> 

Keys/Scenarios). 

 

Figure 19 Set {SCENARIO_SHORTNAME} and {SCENARIO_CODE} in “Scenario Properties” 

Figure 20 How to open the “Scenario Properties” window 

{SCENARIO_SHORTNAME} 

{SCENARIO_CODE} 
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6.5. Application manager window 

The Application manager window is accessed by double-clicking on an application in the 

Applications window, and it provides a flow chart of a transportation modelling process, see 

Figure 21. The view is in a hierarchical flow style that offers: 

• a view of the individual processes, the flow of data from one application to another, the 

sequence in which the processes are run 

• a clear structure of what the input data and the output data are in each process 

• a convenient interface for running specific parts of the process or the whole model 

 

Figure 21 Application manager window  

6.6. Task Monitor program and the help function 

The Task Monitor program starts automatically from the Application manager when the user runs 

either a single program or an application. The main purpose of the Task Monitor is to report the 

progress of the program/application execution, and to allow control of the run by pausing or 

abandoning it. When a run finishes successfully, a message box will indicate that the run is 

finished without any problem. If a failure occurred, a dialog box, showing the return code and 

error information, will appear.  

The return code from the process gives the information on how the run completed. The codes 

are shown below. 

 

STEP 1 

STEP 2 

STEP 3 

Execution order 

Return codes: 

Return code = 0 – the run completed successfully 

Return code = 1 – along the process, a few warning messages were printed but the run was 

completed successfully 

Return code = 2 – the run ended with a fatal error 

Return code = 3 – the user aborted the process 
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There are facilities that allow showing: 

• The report for the whole run 

• The report for the step that failed, if the run ended with a fatal error 

For more details on the Task Monitor, see reference guide RG_CubeBase.pdf under 

Citilabs\Cube folder, Chapter 16. 

When the user needs help about the Cube Interface, the help function can be consulted. It is 

found on the Menu Bar; Help -> Cube Help. 
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7. Description of the applications 

This chapter introduces the different applications in the Samgods GUI, how they are used and 

how the settings are made. The chapter is written as a catalogue with detailed descriptions of the 

applications and should be consulted for the specifications of the applications rather than for 

instructions on how to use the entire Samgods model. For instructions on how to get started with 

Samgods, how to create and use scenarios etc., the user is referred to Chapter 8. The chapter 

commences with an explanation of the different Model User roles, followed by the description of 

the applications in Samgods model GUI. 

7.1.  Model User roles 

In the Samgods model GUI, three Model User roles are available: 

• Standard user - should be used by the normal user when setting up scenarios and 

running the model. 

• Advanced user - should be used when it is requested to manage some general 

parameters and values such as wait time for the prompt command or for running RCM 

process. 

• Developer - should in general be used when advanced system settings are made, for 

instance when administrating the system by making installations and setting up the 

system. 

In order to set the Model User roles, go to Scenario menu on the toolbar and select “Properties”. 

On the Catalogue Properties window, select the “Model User” tab, where the settings for the 

Model User roles are made, as described below: 

• Standard User – set the Model User to “Model Applier” and Current Applier group to 

“Standard User”. 

• Advanced User – set the Model User to “Model Applier” and Current Applier group to 

“Advanced User”. 

• Model Developer – set the Model User to “Model Applier” and Current Applier group to 

“Model Developer”. 

More details for when the Model User roles are used are given in the catalogue key tables. Most 

of the catalogue keys for the respective applications are described; however, not all keys are 

explicitly explained.  

 

 

 

 

 

 

 

General guidelines for which Model User role to use:  

Standard user – should be used by the normal user when running different scenarios 

Advanced user – should be used by an experienced user of the model that would control some 

specific settings and parameters 

Model developer – should be used when setting system keys, no restrictions are applied in this case 
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7.2. Installation application 

The Installation application is only enabled in developer mode. A screenshot of the application is 

displayed in Figure 22. The purpose of the Installation application is to set the general 

information to properly run different programs involved in the model. In particular there are the 

following programs: 

• Logistics module (executable programs buildchain.exe, chainchoi.exe and 

ConsolidRateMode.exe) 

• RCM module (executable programs LP2CC.exe, MPS.jar, CLP64.exe) 

• Citilabs Cube Software 

• ArcGIS Esri Software 

• Python software 

• DOS command location 

See the installation instructions in Section 5.5 for further details on how to access the keys and 

set the right values. 

 

The first group of catalogue keys, called “Software versions”, is introduced to avoid inconsistency 

of version problems over time. Different versions of the programs can be implemented (typically 

when a software is updated to a newer version), and it is important to know which software 

versions that were used for a particular scenario study to enable proper analysis and consistency 

of the outcome. The keys are displayed in Table 2. 

 

Table 2 “Software versions” 

Text field name in template Example of value 

Cube Software 6.5.1 

ArcGIS Software 10.8 

Python software 27 

Logistic Model software 1.2.2 

The second group of catalogue keys, “Installation parameters”, handles the possible problem of 

having different installation folders on different PC’s by setting the path of the programs. Since 

the path for the ArcGIS program is used by Python, the “\” signs must be replaced by “/” or “\\” in 

this key, see Table 3 for an example. The first catalogue key in the second group indicates the 

hard-disk in which the model is installed. 

 

Table 3 “Installation parameters” 

Text field name in template Example of value 

Hard Drive where the model resides F:\ 

Location of Python Program C:\Python27\ArcGIS10.8 

Location of Java folder C:\Program Files\Java\Java8\bin 

Path to cmd.exe C:\Windows\System32\cmd.exe 

The last key in the second group, see Table 4, defines the base scenario that is used in the 

current model. The base scenario is used as a reference when storing the data for other 

scenarios. Only the differences between the base scenario and other scenarios are stored in the 

database. The value of this key is related to the Handling scenario application; please refer to 

Section 7.7 for more information.  
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Table 4 Base scenario definition 

Text field name in template Example of value 

Scenario name for the BASE scenario Base2019 

 

To open the overview of the application as illustrated in Figure 22, double-click on the 

application. To access the catalogue keys of a specific scenario, mark the application, and 

double-click on the specific scenario in the Scenario window. Please refer to Chapter 5 for further 

instructions on how to use the Samgods GUI. 

 

 

Figure 22 The Installation application 

7.3. Create the editable files application 

A view of the Create the editable files application can be seen in Figure 23. The purposes of this 

application are to: 

• Create the essential files for visualizing or editing the input data from the graphical user 

interfaces (Cube GIS window, DBI editor) 

• For a new scenario, allow to copy all the parent scenario data to the new scenario 

The concept of this is that all the input data connected to a specific scenario is stored in the 

database as the differences between the current scenario and the base scenario (i.e., the 

reference scenario). The benefits of this are: 

• A smaller amount of data is stored, that is, only the differences between the base 

scenario and the alternative scenario(s). 

• It makes different alternative scenarios independent of each other, by letting the 

alternative scenarios having only the base scenario as a reference. The only redundancy 

of the system occurs when children are added to an alternative scenario since all 

scenarios (including child and parent scenarios) are independent of each other and only 

have the base scenario as a reference. 

• When changes are made to the base scenario, there is no need to change all the other 

scenarios. This facilitates the handling of the overall scenarios. Furthermore, the 
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changes and edits will be done only once, in the base scenario, avoiding risk of mistake 

when updating the correlated scenarios. 

 

 

Figure 23 The Create the editable files application  

To create the editable files for a specific scenario and the scenario specific tables (see Figure 

24), two applications work in conjunction:  

• The Create the editable files application, that merges the base scenario with the 

scenario specific tables to view and edit a scenario, and 

• The Edit the data application, that stores the scenario-specific tables into the database 

after any edits have been made. 

 

 

Figure 24 Database structure and scenario data of the Samgods GUI. 
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The main database is always present in the model, in the 05_Input_data folder (see Table 1 in 

Section 5.5). The temporary database (Scenario_data.mdb) is created in the scenario folder in 

each run of this application and is deleted on request by the user. The temporary database can 

also be viewed in the GUI. 

The catalogue keys available in the Create the editable files application are shown in Table 5 

below. 

Table 5 Create the editable files catalogue keys 

 Text field name in template Example of value Model User’s rights 

1 Which scenario do you want to copy as new scenario? Base2019 S/A user 

2 Location of Python program C:\Python27\ArcGIS10.8 Developer 

3 Scenario name for the BASE scenario Base2019 Developer 

4 
Wait time for prompt messages during execution (default 10 

minutes = 600 seconds) 
600 

Developer Advanced 

user 

The first key is relevant during the creation of a new scenario. When the scenario already exists, 

no action is needed. Keys number 2 and 3 are for installation purposes only. The last key 

represents a model run setting, specifying the wait time for prompt message during execution. 

For a normal user its value is set to 10 minutes, only for an expert user (advanced user right) it is 

possible to change the definition to a small value (for instance 10 secs). A different setting is 

required when several scenarios must be run since it is desirable to minimize the interaction with 

the user. 

To create a new scenario, the application copies the scenario-specific tables from the scenario 

(as indicated in the first catalogue key in Table 5) and stores them in the temporary database. 

The Edit the data application will then store them back to the main database. 

 

When the application has been executed, the output (i.e., the editable files) can be found in the 

folder Scenario Inputs\Editable data in the Data Section window. If the Create the editable files 

application has been executed before and the user after that has not selected to delete the 

temporary geodatabase, all the data will be available without the need to run the application 

again. If the temporary database has been deleted, it may always be reconstructed by running 

the Create the editable files application. 

The Create the editable files application is the only application that is necessary to run for each 

scenario - including the base scenario. For all other scenarios except the base scenario, it is also 

necessary to run the Edit the data application. 

 

Please note: This application must be run at least once for each scenario, including the 

base scenario. Otherwise, the necessary files for using the scenario will not be created. 
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7.4.  Edit the data application 

The Edit the data application is used to store the scenario-specific tables into the database after 

any edits have been made. 

A view of the application is shown in Figure 25 and the purpose of the application is to: 

• Enable editing of the scenario data by using the Scenario manager window or the Data 

Section window. All georeferenced data is visualised using the GIS Cube window and 

the other data is displayed in a database window. See the reference guide for Cube 

Base (RG_CubeBase.pdf under Citilabs\Cube folder) for further information on these 

tools. 

• Check the changes made are consistent with the calibration tables present under 

Input_data_calibration.mdb (Base2019 and MainSc2045). If elements belonging to the 

calibration tables are deleted in the input data2, the process will terminate and the 

changes amended. 

• Store the modified data (the scenario-specific tables) to the main database after editing. 

 

 
2 It is required that the calibration parameter values (factors and/or terms) actually exists in the original database, else 
calibration adjustments are not possible. For example, introduction of calibration taxes requires that original taxes exist in 
the main-database, this explains why elements of zeros are presents in main-database tables. 

Tip: The date and time of the last modification of the temporary and the main geodatabase are 

checked by the application to avoid inconsistencies between the two datasets. If any 

differences are found, the user is asked to choose whether the execution should be completed 

(the temporary geodatabase will then be overwritten) or cancelled, so that the temporary 

geodatabase could be saved to the main geodatabase by the user. 

  

Please also note: 

• The location of the main database is under 05_Input_data folder (Table 1 in Section 

5.5).  

• The location of the temporary database, Scenario_data.mdb, is under scenario folder, 

which can be found in the Scenario_Tree folder (see Table 1 in Section 5.5). It is 

available after each run. It can also be viewed from the GUI. 
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Figure 25 The Edit the data application  

 

The catalogue keys are ordered in two groups, the scenario parameters and editable data keys. 

The first group is shown under Table 6 below.  

 

Table 6 Scenario parameters and handling keys 

Nr 
Text field name in 

template 
Example of value and 

explanation of values 
Description 

Model 

User’s 

rights 

1 
Do you want to lock the 

scenario from further 

editing? 
Yes 

This key is introduced due to 

data security reasons, where 

the user can choose to lock 

the scenario from further 

editing. 

Further explanation is given 

below 

S/A user 

2 

Calibration parameters 

for reference scenario 

(Base2019 for year 

2019 and MainSc2045 

for year 2045) 

Base2019 

or 

MainSc2045 

This key is introduced since 

scenario specific calibration 

parameters are available. 

Scenarios for 2019 should use 

settings Base2019 in order to 

point out the right calibration 

parameters 

Developer 

3 
Select from which 

source you want to 

import your edits 

GIS Window (Use input files 

constructed by the Cube GUI) 

This key indicates if the edits 

are saved in a Voyager 

Network or in an EMME 

Network. 

If the option “GIS window” is 

selected, the next two 

catalogue keys (no. 3 and 4 

below) do not need to be 

specified 

S/A user 

4 Emme network file 
C:\Temp\EMME_NET_Emme20

19.211 

The network data can be 

edited by importing Emme 

data (format: .211). The file 

should be specified here. It is 

necessary that the network file 

exists in the specified folder, 

otherwise the system will 

S/A user 
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Nr 
Text field name in 

template 
Example of value and 

explanation of values 
Description 

Model 

User’s 

rights 
prompt the user with a 

message during the execution 

5 Emme speed table 
C:\EMME\NetworkBase2011\V1

01_1_02_SPEEDS.DAT 

See key no. 3, except for the 

format, which is .DAT for 

speed table file 
S/A user 

6 
General parameters 

[Table] 

C:\Samgods\Scenario_Tree\Ba

se2019\Scenario_Data.mdb\Ge

neral_Base2019 

This is the scenario data for 

the scenario, generated by the 

system 
Developer 

7 
Attribute name for extra 

cost on specific link 

(SEK) 
EC_V 

Please refer to Section 9.2 for 

further explanation 
S/A user 

8 
Attribute name for extra 

cost on specific link 

(SEK/km) 
EC_KM_V 

Please refer to Section 9.2 for 

further explanation 
S/A user 

9 

Number of operating 

days per year for all 

modes (except for Rail 

Mode) (days/year) 

250 

This key represents a value 

used to convert the annual 

flows into daily flows and is 

expected to be changed rarely 

Developer 

10 
Number of operating 

days per year for Rail 

Mode (days/year) 
250 

This key represents a value 

used to convert the annual 

flows into daily flows and is 

expected to be changed rarely 

Developer 

11 

Number of 

zones/terminals in 

network (see value in 

scenario network) 

1383  
Maximum number of zones 

plus terminals in the network  
S/A user 

12 
General parameters for 

Logistic Module [Table]  

C:\SamGods\Scenario_Tree\Ba

se2019\Scenario_Data.mdb\Lo

gMod_Base2019 

This is the Logistic Module 

data for the scenario, 

generated by the system 
Developer 

13 
Interest rate used in cost 

calculation (%/year)  
0.1 

Interest rate used in cost 

calculations (%/year) 
S/A user 

14 
Stuffing cost (SEK 

/tonne) 
60 Stuffing cost (SEK/ tonne) S/A user 

15 
Number of transport 

chain solutions for the 

Logistics Module 

1: the optimal solution 

2: the second-best solution 

… 

5: the fifth best solution 

The output is found in the Data 

Section window, in Scenario 

Inputs/Editable data/ General 

parameters table, in the field 

DATA. In the current 

implementation the optimal 

solution and up to the fifth 

solution are considered. [2] 

For the current RCM 

implementation, it is strongly 

recommended to leave the 

number of alternatives set to 

5. 

S/A user 

16 

Output variables for the 

optimal transport 

solution [e.g.,1,2,3, max 

is 8] 

1: direct access 

2: (un)loading costs 

3: wait time costs 

4: main utilization rate 

5: number of vehicles 

6: detailed information (total 

cost, total distance, total times, 

commodity, etc.) per f2f-solution 

7: detailed information 

(transport cost share, total 

distance, total times, mode, 

etc.) per OD-leg. This table is 

linked to table 6 

8: Statistics of the avail function 

Max is 8 

See [2]. The output files are 

found in the scenario folder 

(see Table 1), in 

LogMod\ChainChoi\ OUTPUT 

and could be consulted by the 

advanced user. To reduce the 

amount of output files and 

produce meaning full reports it 

has been suggested to use 

reports 6 and 7. 

S/A user 
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Nr 
Text field name in 

template 
Example of value and 

explanation of values 
Description 

Model 

User’s 

rights 

17 

Initial consolidation 

factor in BuildChain 

(First iteration - from 0 to 

1) 

0.75 

This key concerns which 

consolidation factor (for all 

modes) that should be used in 

BuildChain. 

S/A user 

18 
Allow consolidation for 

all lorry types 
Yes  

This key will enable the 

consolidation of all lorries if the 

value is Yes. With No 

unconsolidated lorry transports 

will be enabled  

S/A user 

19 
Evaluate transport 

chains one leg at a time 
Yes  

If Yes then each chain is 

evaluated one leg at a time, 

and the lowest cost vehicle is 

chosen. This can be done 

since the OD-legs are 

independent. The exception is 

OD-legs for vehicles rolling on 

and off a RoRo vessel, where 

a recursive optimization 

method is used for the three 

OD-legs (roll on vehicle – 

RoRo – roll off vehicle). 

S/A user 

20 

Lower bound for 

frequency optimization 

(Annual 

Tonnes/Shipment) 

1000 

If (Annual Demand / Nr 

Relations) < 

MINIMUM_ANNUAL_TONNE

_DEMAND_4_FREQ_OPTIMI

ZE ChainChoi will exit 20 step 

frequency optimization loops 

after the first iteration, where 

frequency corresponds to 

EOQ. 

S/A user 

21 

Lower bound for 

consolidation factor 

(applied to all 

commodities - from 0 to 

1) 

0.05 
Lower bound for the 

consolidation factors ranking 

output 
S/A user 

22 

Upper bound for 

consolidation factor 

(applied to all 

commodities from 0 to 

1) 

0.95 
Upper bound for the 

consolidation factors ranking 

output 
S/A user 

23 
Calculation for demand 

affecting shipment size 
DYNAMIC_AVERAGE 

Parameter to control how the 

demand shall be used in the 

calculation of the shipment 

sizes in BuildChain. The 

following values are allowed: 

DYNAMIC 

DYNAMIC_MAX 

DYNAMIC_AVERAGE 

DYNAMIC_GEOMEAN 

S/A user 

24 
Do you want to log 

parameters from control 

files? 
Yes  

If true, the parameters from 

control file are logged in a log 

file (under LOG folder). 
S/A user 

25 
Do you want to log 

reading of input data? 
Yes  

If true, the input data phase is 

logged in a log file (under LOG 

folder). 
S/A user 

26 
Do you want to log cost 

values from vehicles 

files? 
Yes  

If true, the cost values read 

from LOS files are logged in a 

log file (under LOG folder). 
S/A user 

27 

For which logistic 

solutions do you want to 

produce output data? 

(0=none, 1=Best 

Number: 

0 no output 

1 only for best solution 

This key limits the output files 

controlled by Key #16 for a 

subset of solutions (best one 

or suboptimal) 

S/A user 
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Nr 
Text field name in 

template 
Example of value and 

explanation of values 
Description 

Model 

User’s 

rights 
solution, 2=Best + 

Second) 

28 

Do you want to delete 

the temporary 

geodatabase? 

(Tick=yes) 

Tick =yes 

This key gives the user the 

possibility to save hard disk 

space by deleting the 

temporary geodatabase 

(Scenario_Data.mdb). 

However, by keeping the 

temporary files, there is no 

need to run the Create the 

editable files application again 

(for the current scenario) 

S/A user 

The first key (lock the scenario or not) is introduced due to data security reasons. The user can 

choose to lock the scenario from further editing. A new scenario is always editable, because it is 

expected that the user will make some changes to the scenario tables. To lock a scenario means 

that after the run, all the scenario data can be visualised in the interface, but if any edits are 

made, these edits will not be saved in the main geodatabase. The base scenario is locked by 

default and it should always be locked to enable comparison of the scenarios. In the database, 

only the relative differences between the base scenario and the scenarios alternatives are 

stored, this is why it is important not to change the base scenario when new scenario alternatives 

have been introduced. A prompt window gives information on whether the scenario has been 

locked or not during the execution of the following applications: Create the editable files, Edit the 

data, Samgods Model. 

The 11th key (Number of zones/terminals in network (see value in scenario network) must be 

updated accordingly the number of zones in the EMME or Voyager network. The Emme network, 

in conjunction with the speed table, could be provided as input network and converted by the 

application. In this case the number of zones has specified as the record number in the Emme 

node table for nodes starting with *. In Voyager the number could be identified and modified in 

the GIS window selecting the network in TOC and right clinking on that. For more details on the 

EMME network please refer to paragraph 9.1. 

The key (no.27) controls the number of report files specified by key 16, those reports can be 

produced for the best solution, second or third etc. Its number specifies which set of results that 

will be produced (only the best solution or the others as well, see [1] for further details). 

The last key no. 28 gives the user the possibility to delete temporary files. By deleting the 

temporary geodatabase, hard disk space could be saved. On the other hand, by keeping the 

files, run time can be saved since the Create the editable files application does not have to be 

run again for the specific scenario. The Create the editable files application needs about 5-10 

minutes to merge all scenario specific tables with the base scenario. 

To avoid inconsistencies between the temporary and the main geodatabase, it is recommended 

to always control whether the two data sets have the same date and time of last modification, 

before running the Samgods Model application. If they differ, there could be edits in the 

temporary geodatabase that have not been saved to the main geodatabase and those edits will 

not be included in the execution of the model. In order to save edits in the main geodatabase, it 

is necessary to run the Edit the data application. For the Create the editable files application, this 

check is done by the application, in order not to overwrite any non-saved edits in the temporary 

geodatabase by mistake (see Section 7.3). 

When “Next” is clicked in the Edit the data application in the Standard user Advanced user mode, 

a second set of catalogue keys is displayed, see Table 7. These keys give access from the 

interface to all the input data for the specific scenario. The model Standard user / Advanced user 
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does not need to do anything to define the key values. The tables and geodata can be edited by 

clicking on the “Edit…” button in Standard user Advanced user mode. All these files are also 

accessible from the Data Section window, under Scenario Inputs\Editable data. In Section 6.3 a 

brief explanation of all files in the Data Section window is given. 

 

Table 7 Editable data 

Text field name 

in template 
Example of value 

Model 

User’s 

rights 

Name of file in Data 

Section window 

ArcMap GIS 

Project File 
C:\Samgods\Scenario_Tree\Base2019\Input_Data.mxd S/A user  Input_Data.mxd 

Commodity data 

[Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Cargo_Base2019 
S/A user Cargo Table 

General 

parameters of 

Vehicle Classes 

[Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Vehicles_Parameters_Base2019_PartA 
S/A user 

General Vehicles 

Parameters (by vhcl 

class only) 

Specific 

parameters of 

Vehicle Classes 

by commodity 

group [Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Vehicles_Parameters_Base2019_PartB 
S/A user 

Specific Vehicles 

Parameters (by vhcl 

class and commodity 

group) 

Table with tax by 

country (SEK/km) 

[Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Tax_Country_Base2019 
S/A user  Tax by country Table 

Tax by Category 

(SEK) [Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Tax_Category_Base2019 
S/A user Tax by Link class 

Tax by Link (SEK) 

[Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Tax_Link_Base2019 
S/A user  Tax by link 

Toll for bridges 

(SEK) [Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Toll_Link_Base2019 
S/A user Toll bridges 

Network specific 

of scenario 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Network 
S/A user Scenario Network 

Port terminals 

pilot fees values 

(SEK/vehicle) 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Ports_Swe 
S/A user  Ports Sweden 

Zones and 

terminals 

attributes 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Nodes 
S/A user  Nodes 

Nodes 

commodities 

(interchanges 

allow) [Geodata] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Nodes_commodities 
S/A user Nodes commodities 

Frequency data (# 

transport /week) 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db\Frequency_network 
S/A user Frequency network 

Table with Rail 

Capacity [Table] 

C:\Samgods\Scenario_Tree\Base2019\Scenario_Data.m

db \Rail_Capacity_Base2019 
S/A user  RailCapacity Table 

The last three catalogue keys are only accessible in model’s developer mode with the exception 

for Wait time (that could be also specified by the Advanced user). They define the base scenario, 
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the folder for the Python program and the wait time for prompt message during execution, see 

Table 8. 

 

Table 8 Developer and advanced user keys 

Text field name in template Example of value 
Model User’s 

rights 

Location of Python Program C:\Python27\ArcGIS10.8 Developer 

Scenario name for the BASE scenario Base2019 Developer 

Wait time for prompt messages during execution (default 10 minutes 

= 600 seconds): 
600 

Developer 

Advanced user 

 

The output of the Edit the data application, which is a log report containing information on the 

execution of the application, can be found in the folder Scenario Outputs\Edit the data Report in 

the Data Section window. This file contains a list of numbered messages giving information on, 

e.g., whether any data is missing in the input data (e.g., a missing port in the ports_swe table). 

For a list of messages, see Chapter 11. 

7.5. Samgods Model application 

A schematic picture of the Samgods Model application is outlined in Figure 26. The Samgods 

Model application is the core of the system, since it has the purpose to: 

• run the Samgods model 

• make sure that all required input data exists (in the main geodatabase or created along 

the process) 

• save all the outputs in the right places (depending on the request of the user) 

 

 

Figure 26 The Samgods Model application 

The Samgods Model application provides three different processes integrated in a unique 

application: 

• The logistics module (in the document it could be referred to as Standard Logistics 

Module or STD - steps 4,5,6 and 7): the transport solutions are produced considering all 
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the available chains and the results are summarized in vehicle, tonne and empty vehicle 

matrices assigned to the transport network. The solution considered for each firm-to-firm 

relationship is one and only one in the deterministic method. Applying the variable VARI 

(lambda parameter) the stochastic approach will be invoked, in this case the probability 

of usage between Stochastic approach best choice and second/third/fourth and fifth 

choice will be estimated. VARI can specified by commodity group and F2F segment 

using a table in access database. 

• The RCM module (steps 8, 9 and 10): in an iterative process the transport chains 

solutions using rail infrastructure are modified with the goal to redistribute the flows and 

reduce the congestion on the rail network. In each iteration a new alternative per each 

firm-to-firm using rail links may be added. It may be added if it represents a new 

alternative since possibly existing alternatives are already in the list of alternatives, to the 

capacity problem manager (called LP since it involves the definition of a linear 

programming problem). The variables in the LP model are the usage split of the available 

solutions per f2f-relation. The initial step is denoted LP0 and considers the best solution 

from the logistic module and the second-best choice. In principle new alternatives are 

successively added in step LP1, LP2 etc. until the total LP model cost is minimized, i.e., 

when the solution has converged according to defined stopping criteria, or no new 

columns have been found. In the current setup the stopping criteria applied is when the 

maximum number of iterations is met (catalogue key Maximum number of loops for LP 

process has this purpose). Should any rail links still be overloaded after stopping, the 

best option to address the issue is to run yet one LP-iteration. In cases with severe 

overload / tight capacity it may be necessary to run RCM with a higher cost for 

acquisition of extra capacity (parameters CAPCOST and EXTRA_CAPCOST in the 

control file MPS_LP.ctl to force usable alternatives to appear). 

• The calibration module (steps 1,2,11 and 12): details will be provided in the documents 

listed in Section 13. It has been used to calibrate the current version. The standard and 

advanced user are not allowed to access to the catalogue keys that control this process. 

The steps related to the Logistics Module are: 

• LOS calculation (step 4) – the step where the Level Of Service matrices are calculated. 

There is one LOS matrix for each vehicle type providing transport time, transport 

distance, infrastructure fees/charges and the domestic distance for zone-to-zone 

relations. The LOS matrices are mandatory input to the Samgods model, see [1]. 

• Logistics module (step 5) – the step where the freight flows of the different commodities 

are assigned to transport chains. 

• Assignment (step 6) – the step where the freight flows are assigned to the infrastructure 

network. 

• Reports (step 7) – the step where all standard reports (also called summary reports) 

from the Samgods Model application are produced. 

The steps related to the RCM module are: 

• Rail Capacity Management (step 8): using the results from standard logistics module 

sets up the LP and provides a new revised set of vehicle and tonne OD matrices. 

• Assignment RCM (step 9) – the step where the freight flows are assigned to the 

infrastructure network. The empty rail assignment considers the congestion on rail links 

by applying a vehicle-delay function that depends on bidirectional link flows, the other 

modes maintain the standard all-of-nothing assignment. 
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• Reports RCM (step 10) – the step where all standard reports (also called summary 

reports) from the Samgods Model application are produced with results for RCM 

 

The user is referred to the documents listed in Section 13, for further information of the Samgods 

model. 

7.5.1. Standard Logistic Module 

The first four steps of the application represent the “standard” module where the capacity and 

congestion on rail links are not considered. This “standard logistic” module has different choice 

dimensions, depending on the results that the user wants to simulate (as showed in Figure 27). 

 

 

Figure 27 Different ways to run the Samgods Model application for the standard part 

All the possible dimensions are: 

• The model could be run as an uninterrupted process or step-by-step (illustrated in the 

Figure 27 by the blue arrows to the right). 

• It is possible to run all the commodities at once or one commodity at the time (illustrated 

by the yellow arrow at the top of Figure 27). 

• For the steps LOS Calculation and Assignment is it possible to run all the modes or only 

a specific mode (illustrated by the green boxes to the left in Figure 27). 

• It is possible to select which specific outputs to save from running the Samgods model. 
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Not all combinations of these choices are allowed. Details are given in the following paragraph. 

During the run, the user will be informed with a prompt window whether the selections made are 

coherent with each other. 

The option to run the model for one mode at a time is allowed only for the steps highlighted in 

green, i.e., LOS Calculation and Assignment. This is due to the fact that the Logistics module 

needs LOS matrices for all modes. A reason for running only a specific mode could be that the 

differences in the input data are related only to one mode. For instance, if no other changes have 

been made in the input data, there is no need to rerun the whole scenario in the LOS Calculation 

step. Regarding the Assignment step, the user may be interested in examining the assignment of 

the freight to the network for only one mode. 

The fourth step, Reports, produces summary reports from running the Samgods Model 

application. Since this step summarizes the three previous steps, a full run of all four modes 

needs to be done to obtain complete reports.  

It is allowed to run all steps related the standard logistic module in the Samgods Model 

application for only one specific commodity group (as illustrated by the blue arrows). With the 

new setting of empty add-on factors for empty rail flows, these will be correct at any level of 

disaggregation. For other vehicle types the empty flow distributions are not separable, i.e., the 

sum of individual commodity based empty flow generations will not sum to the empty flow 

generation from the combined set of commodities.  

If changes in the input data are detected after the LOS matrices have been created, the program 

will prompt the user with a message in the report file in the folder Scenario Outputs\Samgods 

report\Existing Outputs in the Data section window. During the execution, the user is provided 

with the option to cancel the run (by ticking the answer “Do you want to check data and skip the 

process?”). See Chapter 11 for further information on the log reports. 

The last step of the application represents the “Rail Capacity Management” module where 

capacity and congestion on rail links are taken into account. This module has several sub-steps: 

• Rail Capacity Management – the step where the freight flows of the different 

commodities are assigned to transport chains considering link congestion on rail. 

• RCM Assignment – the step where the freight flows are assigned to the infrastructure 

network considering link congestion on rail. 

• Results RCM – the step where all reports for the Rail Capacity Management module are 

produced. 

For the “rail capacity management”, it is not possible to select which commodity and mode to 

run. It is mandatory run all the commodities for all modes. In fact, the rail capacity management 

module considers the congestion on the rail links, and to do this properly it has to be considered 

all the commodities and modes, simultaneously. Like Standard Logmod, it can be selected which 

step to be run: 

• Rail Capacity Management (all below steps together).  

• RCM: only LP steps. 

• Assignment RCM: assign final matrices. 

• Reports RCM: produce RCM reports. 

For the Samgods Model application there are several groups of catalogue keys. 

The first group is “Scenario parameters” keys as summarized in Table 9. It contains two keys 

that specifies which calibration database to be used while also the number of zones\terminals in 

the network. 
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Table 9 “Scenario parameters” key 

Nr Text field name in template Example of value Description 

Model 

User’s 

rights 

1 

Calibration parameters for 

reference scenario 

(Base2019 for year 2019 and 

MainSc2045 for year 2045) 

Base2019 

or 

MainSc2045 

This key is introduced 

since scenario specific 

calibration parameters are 

available. Scenarios for 

2019 should use settings 

Base2019 in order to point 

out the right calibration 

parameters 

Developer 

2 

Number of zones/terminals in 

network (see value in 

scenario network) 

1383 
Number of zones plus 

terminals in the network 
S/A user 

The next group of catalogue keys (see Table 10) is only available in developer mode and it 

contains installation parameters. 

 

Table 10 “Installation Parameters” keys 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 Location of python program C:\Python27\ArcGIS10.8 
It specifies the installation 

directory for Python program 
Developer 

2 Location of Java folder 
C:\Program 

Files\Java\Java8\bin 

It specifies the installation 

directory for Java 
Developer 

3 Path to cmd.exe 
C:\ 

Windows\System32\cmd.exe 
Location of cmd.exe program Developer 

4 
Scenario name for the 

BASE scenario 
Base2019 

It specifies the name of the 

base scenario 
Developer 

5 
Hard Drive where the 

model resides 
C: 

Hard drive on which the 

model resides 
Developer 

The next group of catalogue keys, “Run Selections”, refers to the execution order specifying 

which steps to run (see Table 11). 

 

Table 11 “Run Selections” keys 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 
Run only one step, or run 

all steps 
All steps 

It specifies which step that is 

to be run for Standard 

Logistic Module; it is possible 

to specify only one 

application or all the steps 

S/A user 

2 Choose PWC matrices 2019 
It specifies the year for the 

PWC demand matrices 
S/A user 

3 

Select the mode for the 

LOS Calculation and the 

Assignment steps 

All 

It specifies which mode that 

is to be run; it is possible to 

specify only one or all the 

modes 

NOTE: if the user runs the 

RCM, all the modes need to 

be considered. 

S/A user 

4 

Select commodities for the 

Logistics Module (for all 

commodities, select 0) 

0 

It specifies which type of 

commodity that is to be run; 

it is possible to specify only 

one commodity type (value 

S/A user 
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from 1 to 16 or all the 

commodities (value 0) 

NOTE: if the user runs the 

RCM, all the modes need to 

be considered. 

Possible input values for the first key listed in Table 11 are: 

• STD LOS calculation: it indicates to run only “LOS calculation” step (#4) 

• STD Logistics module: it indicates to run only “Logistics Module” step (#5) 

• STD Assignment: it indicates to run only “Assignment” step (#6) 

• STD Report: it indicates to run only “Results” step (#7) 

• STD All steps: it indicates to run all the “Standard LogMod” steps (LOS calculation + 

Logistic module + Assignment + Reports) (#4+5+6+7) 

• RCM Rail Capacity Management Module: it indicates to run “Rail Capacity Management” 

step (#8) 

• RCM Assignment: it indicates to run “RCM Assignment” step (#9) 

• RCM Report: it indicates to run “Results RCM” step (#10) 

• RCM All steps: it indicates to run all the “Rail Capacity Management” steps (RCM + RCM 

Assignment + RCM Report) (#8+9+10) 

• All steps: it indicates to run all the steps 

 

Note that, when running Standard Logistic Module, the input for Rail Capacity Management 

procedure is created in the scenario folder. Therefore, the Rail Capacity Management procedure 

must be run after a full run of Standard Logistic Module.  

Output is produced from all steps in the Samgods Model application. Together with the Microsoft 

Office tools (such as Access and Excel) this output can be analysed in-depth in various ways. 

The purpose of the standard reports produced in the Report step is to give the user a quick 

overview of the results from running the Samgods Model application.  

Possible input values for the second key (Year of PWC matrices) in Table 11 are: 

• 2019: PWC matrices for year 2019 

• 2045: PWC matrices for year 2045 

• 2045_S0: PWC matrices for year 2045 

• Any other value inserted by the user. Follow the general rule to create a folder under 

01_Programs\LogMod\Input\PWC\, for instance “2045_XOre”, and give the same name 

to the catalogue key  

Possible input values for the third key listed in Table 11 are: 

• All 

• Road 

• Rail 

• Sea 

• Air 

The last (in Table 11) key has a more general function. It is used in all the applications where the 

output data is filtered by commodity. It is the most important catalogue key of these three keys. If 

the Samgods Model application first is run for commodity type 1 (for instance), then for all the 

commodity types (key set to zero), then both the results for commodity type 1 and for all the 

commodities will be saved. In the scenario folder (under Scenario_Tree, see Table 1), the name 
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of the specific output database is OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the 

commodity group. Switching from one set of output to another in the interface is easily made by 

changing the value of this catalogue key and click “Save”. The possible values for this key are 

the numbers representing different commodities or zero, representing all commodities. The 

possible commodities are the commodity types (1-16). See the Appendix or for instance the 

Program Documentation [2] for more information. 

The report “Existing Outputs” (in the folder Scenario Outputs\Samgods Report in the Data 

Section window) is updated during each run and it gives information on the output and the 

commodity class. 

The next set of catalogue keys, “Other options”, refers to the optional outputs which can be 

saved in the scenario folder, see Table 12. 

 

Table 12 Other options keys 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 
Do you want to produce 

buildchainxx.log files? 
None 

It indicates if the user wants 

to generate a log file 

containing any warning that 

can occur during the 

execution of the BuildChain 

program 

S/A user  

2 

Do you want to use 

exogenous consolidation 

rates?  

Yes 

It provides the ability to 

choose between the two 

cases: 

• Providing the 

consolidation rates from 

another run 

(exogenous) 

• Producing the 

consolidation rates 

during the run 

(endogenous) 

S/A user 

 

3 

If yes in previous catalogue 

key, provide location of 

consolidation rates folder 

C:\Samgods\Scenario_Tree\Y

ear_2019\Base2019\LogMod_

1\ChainChoi\output\ 

It works if they are provided 

exogenously, letting the user 

to define a folder where 

reside the consolidation files. 

S/A user 

The first key lets the user to select whether the BuildChain program will produce log files or not. 

The log files (*.log) contain any warnings that can occur during the execution. Please see the 

Program documentation for the logistics model [2] for more information.  

The second and third keys represent a specific enables the user to inherit consolidation rates 

from another scenario (exogenous). These settings have impact on Samgods Model and 

Elasticity Module scenario setup.  

 

Consolid Rate by Mode and endogenous consolidate rates by Mode  

Use 

The major development since version 1.2.2 focuses in providing stable solutions when assessing 

forecasting scenarios, where stable means sensible results when comparing costs across 

different alternatives. In the way the optimization problem was previously formulated, every 

scenario was creating its own alternative and solutions in relation to consolidation factors. This 

ended up in counterintuitive and difficult to interpret the results.  

In order to stabilise the consolidation process, the following functionalities are in place: 
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• An input table, which provides a Lower Bound Ratio for the consolidation level. 

• A list of exceptions on consolidation rates and maximum capacities for specific OD 

movement, MODE and commodity. 

• The option to start the optimisation from a set of consolidation rates produced exogenously 

(i.e., from another scenario). The process will evaluate this set-in conjunction with a new set 

of solutions rather start to generate a completely new set.  

The first two are tables present in the Input_Data.mdb (respectively LBD_Ratio and 

MaxCapAndConsolExcept), while the third is delivered through the use of the second and third 

key in Table 12.  

In absence, the user can select the option to provide external consolidation rates by mode using 

the catalogue key “Do you want to use exogenous consolidation rates?” sets to “Yes”, or 

alternatively to generate the consolidation rates by mode during the Samgods Model application 

run.  

The catalogue key “If yes in previous catalogue key, provide location of consolidation rates 

folder” is active, i.e., will affect the model run, only if the previously mentioned key set to “Yes”. In 

this event, the user must provide the location of the LogMod\ChainChoi\Output\ folder where the 

consolidation files are stored from a previous run.  

If the folder provided does not exist or the expected files are not present the user will receive the 

following warning (Figure 28): 

 

 

 

The program is expecting 64 (16 commodity groups per 4 modes) files under the folder provided 

via the third catalogue key (see Table 12) with the following names: 

• CONSOLX-ROAD.314 

• CONSOLX-RAIL.314 

Figure 28 Warning message 
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• CONSOLX-SEA.314 

• CONSOLX-AIR.314 

Where X is the commodity number.  

For all existing and new scenarios, the default setting is “No” for “Do you want to use 

exogenous consolidation rates?” . 

The second key has a default setting, i.e., refers to the specific reference scenario for each year, 

i.e.: 

• in model year 2019 to Base 2019: 

{CATALOG_DIR}\Scenario_Tree\Year_2019\Base2019\LogMod_1\ChainChoi\OUTPUT\ 

• in model year 2045 to MainSc2045: 

{CATALOG_DIR}\Scenario_Tree\Year_2045\MainSc2045\LogMod_1\ChainChoi\OUTPU

T\ 

 

“Samgods model” scenario setup 

The above rule has been reflected in the scenario setup providing by default the parent scenario 

for the consolidation rates. The user MUST remember to activate the functionality setting “Do 

you want to use exogenous consolidation rates?” to “Yes”. No other actions are required, 

since the folder location is provided by default.  

 

“Elasticity module” scenario setup 

In the “Elasticity module” the above stated rule, regarding exogenous consolidation rates, has an 

impact on the way the module should be run.  

The Elasticity Module application must have access to all the output files generated from the full 

run of Samgods Model application, where the choice to use exogenous or endogenous 

consolidation rate is made. All the sensitivity tests produced under the Elasticity Module 

application will have access to the exogenous consolidation rates from the parent scenario, i.e., 

what has been produced under Samgods Model application run. Further details on the operation 

of the module are provided in its dedicated section 7.12. It is recommended to read in 

conjunction with this section.  

The next group of keys allows the user to set the advanced options for the logistics module 

(heading “Logistics module settings – advanced”) and is made up by seven catalogue keys, see 

Table 13 below. 

 

Rule: The general rule is: any child scenario (i.e., alternative scenario in the specific model 

year) should derive its consolidation rates from the parent scenario. The user has still the 

option to provide a different set of consolidation rates from an unrelated scenario. Seek 

advice from Trafikverket if this option would be suitable for your specific study. 
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Table 13 “Logistics module settings – advanced” keys 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 

Stochastic approach: 

parameter for logit 

distribution (0=no 

stochastic approach used 

or actual value i.e. 0.1) by 

commodity and f2f type 

{CATALOG_DIR}\05_Input_D

ata\Input_Data.mdb\CSTVARI 

Table with lambda 

parameters by commodity 

group and f2f cells.  

Developer 

2 

Total number of 

commodities (excluding 

empty commodities): 

16 

Total number of product 

groups in the setup (16 in 

Samgods 1.2). N_Flows is 

always 16 – number of 

product groups listed in 

catalogue key 1 

S/A User 

3 

Do you want to run the 

Logistics Module on 

several processors? 

Yes 

It indicates if the user wants 

to run the model on several 

processors 

S/A user 

4 

How many processors 

would you like to run 

simultaneously? 

4 

It specifies the number of 

processes to run 

simultaneously for all 

programs except LP2CC 

S/A user 

5 

How many processors 

would you like to run 

simultaneously for LP2CC? 

4 

Specific limit for LP2CC 

since extremely RAM 

demanding. Each processor 

should, in average, have at 

least 2 GB of RAM available. 

S/A user 

6 Scaling factor for outputs Thousands 

It specifies the scaling factor 

for outputs – fixed at 

Thousands 

Developer  

7 

Do you want to produce 

rescaled LOS and MC 

matrices per commodity 

group? 

No 

Produces extra outputs with 

LOS and Marginal Cost 

matrices rescaled with 

scaling parameters used for 

calibration 

S/A user 

If the computer has more than one CPU available, it is possible to split up the processes 

between the CPUs to speed up the run time of the model, using the catalogue keys above. The 

seventh key enables the user to define the scale of the output that will be presented in the 

reports. If the value is thousands, the output value (for instance 2.000.000 vehicle kilometres) will 

be presented as the value divided by thousand (i.e., 2.000 vehicle kilometres).  

7.5.2. Rail Capacity Management 

Next group of catalogue keys, specifies several parameters for Rail Capacity Management (see 

Table 14). For a complete comprehension, the reader is referred to [3] and [7] . 

 

Table 14 “Rail Capacity Management - Settings” keys 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 

Cut off criteria for RCM 

process (will consider links 

with Number of vehicles 

over Capacity > XX% 

where XX is the value 

defined) 

30 

It specifies a percentage 

value for exclusion of link 

flows. According to 

experience, railway links with 

flow to capacity rates (V/C) 

at this or lower levels will not 

have any impact on the 

solution 

Advanced 

user 
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Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

2 

Maximum number of 

iterations in Rail 

assignment 

1 

It specifies the maximum 

number of iterations in the 

empty train rail assignment 

(considering link congestion)  

Advanced 

user 

3 
Delay function for Empty 

assignment (Derivate) 

2*10000*(MAX (0, 

VOLC[LI.ID_LINK]-C)) 

It specifies the delay function 

used for the assignment of 

empty vehicles 

Advanced 

user 

4 
Options to save output files 

from RCM process 
Yes, for all iterations 

It indicates the user wants to 

save output file from Rail 

Capacity Management 

process for all the iterations 

(for instance LP0, LP1, LP2 

etc.) or only in the last 

iteration.  

S/A user 

5 

Maximum number of loops 

for Linear Programming 

process (LP) 

1 

It specifies the maximum 

number of loops for the 

linear programming process 

(LP). The 0 value means that 

only LP0 will be perform. A 

different number between 1 

and 9 will iterate the process 

until that number (or earlier if 

convergence will be reach). 

S/A user 

6 
Table with list of locked 

solutions 
2019 

Table under 

Input_Data_Calibration.mdb\ 

Lock_2019 Refer to the year 

to select different tables 

(2019, 2045) 

Advanced 

user 

7 
Shipment size cut-off 

(tonnes) 
1 

Cut-off for shipment size in 

kg. For transports with 

shipment sizes below this 

level, alternative transport 

solution is not generated 

after iteration 0  

S/A user 

8 
Marginal cost limit in 

MPS.jar (SEK) 
998801 

Limit of marginal cost to 

include extra capacity  
S/A user 

9 
Acquisition of extra 

capacity (SEK)  
1000000000 

Cost to buy extra capacity. If 

set to 0, consistent with 1.1 

implementation 

S/A user 

10 

Link number to use in 

debug mode 

CheckLinkN_itXX.dat Max 

10 links (Comma s, ex. 

1,25,182,164) 

51,82,84,234,272,274 

Providing the ID_Link list an 

extra report will be produced 

under RCM folder. 

Advanced 

user 

11 List of rail modes in RCM: GHhIiTUDdEFf 

Switch between 35 to 40 

vehicle types. List of 

associated modes of rail 

(see Logistic module 

documentation) 

Current setup allows only the 

full set of vehicle types. 

(The user may alter the use 

of rail modes by either 

forbidding modes in the 

network or by raise costs 

until modes are not chosen.) 

Developer 

12 
List of vehicle types on Rail 

mode 

201,202,203,204,205,206,207,

208,209,210,211,212 

List of vehicle types in rail 

mode (12 or 9). Current 

setup allows only 12 vehicle 

types 

(The user may alter the use 

of vehicle types by either 

Developer 
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Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

forbidding modes in the 

network or by raise costs 

until modes are not chosen.) 

13 

List of chains for different 

numbers of vehicle 

classes: 

Chain_List_2019 

List of available chains 

(The user may select a 

different list of accepted 

chains) 

Advanced 

user 

The first key in the table above will filter the transport chain solutions for rail links where the ratio 

between total vehicle flows and capacity is greater, or equal, than the value specified in the 

catalogue key. Since the linear programming problem could be large (millions of records), this 

limit could cut down the dimension of the problem. It is recommended to keep the default value. 

Links with lower capacity utilization, than the defined threshold, will not be considered in the 

RCM-module. 

The second key specifies the maximum number of iterations for the rail assignment with capacity 

constraints. 

The third key specify the delay function used for the assignment of empty vehicles; possible 

values are: 

• 2*10000*(MAX(0,VOLC[LI.ID_LINK]-C)) 

• 4*10000*(MAX(0,VOLC[LI.ID_LINK]-C)^3) 

The fourth key indicates if the user wants to save output files from RCM process. The options 

are: 

• Yes, for all iteration 

• No, this option will save results only for the final iteration and the previous one 

The options for key five are: 

Run only LP0 

• Maximum number of loops for Linear Programming process (LP) = 0 

Run only LP1 

• Maximum number of loops for Linear Programming process (LP) = 1 

Run only LP2 

• Maximum number of loops for Linear Programming process (LP) = 2 

 

The Samgods model could be run in several different ways. The current setup allows the 

following choices (using catalogue keys 1 and 4 in Table 11: 

• All: an interrupted run from LOS to reports for RCM. The number of LP and Adjust LP will 

be specified by catalogue keys 5 and 6 in Table 14 

• Logistics Module or Assignment or Reports: a single step for standard log mod 

• Standard LogMod: all the steps related to Standard Logistic module (LOS +Logistic 

Module +Assignment +Reports) 

• RCM or RCM Assignment or Reports RCM: a single step for Rail Capacity Management 

• Rail Capacity Management: all RCM steps running the number of LP loops specified via 

key 5 in Table 14 

For instance, in a previous step LP1 has been run, and it is required to run LP2, it will be 

sufficient set the model in the following manner: 

• Run only one step, or run all steps=Rail Capacity Management 
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• Maximum number of loops for Linear Programming process (LP) = 2 

The last catalogue keys (in Table 14) allow a different setup regarding the available vehicle 

classes, their minimum shipment size, costs associated to purchase extra capacity and chain 

types. Samgods 1.2.3 provides 40 vehicle classes: 

• Vehicle classes 106 (heavy trucks), 210, 211, 212 (longer trains), 322 (inland waterway) 

are forbidden to be used in the network in the standard setup. To activate them it is 

sufficient to open in the input network the set of links that should use the specific vehicle 

class. Also, the user should make sure that the vehicles are included in the chain list. 

• Vehicle class 209 is not used in the model. All the input data and settings for it could be 

used to describe a new vehicle type. 

7.5.3. Calibration 

Next group of catalogue keys specifies parameters and tables for calibration and they are 

available for developer users only (see Table 15 and Table 16). The calibration procedure should 

not be used at all by a standard user. The following keys should not be changed, except 

catalogue key 7 (see Table 16). 

 

Table 15 “Parameters and tables for calibration” key 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 
Maximum number of loops 

in calibration process 
1 

It specifies the maximum 

number of loops to run in the 

process 

Developer 

2 Restart process from loop 1 

The calibration procedure 

could be run for a fix number 

of loops. If the run crashes at 

a specific loop or it is 

required to run an extra loop, 

this catalogue key sets the 

loop number to restart with. 

Developer 

3 Consolidation factors table 

C:\Samgods\05_Input_Data\In

put_Data.mdb\BuildChain_CO

NSOL 

Individual consolidation 

bounds for all sub modes 

[LB, HB] Default values and 

specific values by commodity 

group. 

Developer 

Advanced 

user 

 

In addition to the available keys within the graphical user interface, several settings for the 

calibration are available within the calibration database(see Table 16). 

 

Table 16 Settings for the calibration listed in the Calibration Database 

ID Location Description 

4 

C:\Samgods\05_Input_Data\Calibration\ 

Input_Data_Calibration_Base2019.mdb\ 

PortAreaParams_16_Comm_Base20193 

It specifies a text file containing the initial values of 

factors for port areas; these values are specific by 

port area and commodity group. These scaling 

factors are applied to time for sea vessels 301 – 

322. 

5 

C:\Samgods\05_Input_Data\Calibration\ 

Input_Data_Calibration_Base2019.mdb\ 

KielCanal_Parameter_Base20194 

It specifies the initial values of factor for Kiel canal. 

This scaling factor is applied to the canal toll 

 
3 Scenario specific and is also available for the forecast year 2045 
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6 

C:\Samgods\05_Input_Data\Calibration\ 

Input_Data_Calibration_Base2019.mdb\ 

Parameters_portcalibration 

Step length, minimum value, cat off value and 

default minimum value for calibration procedure on 

port areas 

7 

C:\Samgods\05_Input_Data\Calibration\ 

Input_Data_Calibration_Base2019.mdb\ 

Parameters_Kielcalibration 

Step length, minimum value, cat off value and 

default minimum value for calibration procedure on 

Kiel canal 

 

The calibration procedure uses a set of initial values specified via ID 4 and 5 in Table 16, and 

progressively changes those values comparing the results with statistics. It applies a revision to 

the values using a step length search specified in ID 6 and 7. For further details the reader can 

see [3]. 

Catalogue keys 1 and 2, in Table 15, are used to manage and control the calibration process. 

The first sets the maximum number of loops for the process, the second allows to run extra loops 

after a completed run. The catalogue key 3 (Table 15) allows specification of a different table 

containing consolidation factors and could be used in setting up sensitivity tests for the lower and 

upper bounds for each sub mode. The last catalogue key is only accessible in model developer 

or advanced user mode and it defines the wait time for prompt message during simulation 

running (see Table 17). 

 

Table 17 Settings key 

Text field name in template 
Example of 

value 

Model User’s 

rights 

Wait time for prompt messages during execution (default 10 minutes = 600 

seconds) 
600 

Developer 

Advanced user 

For a standard user the model will prompt window messages along the run and wait for the 

reaction from the user for 10 minutes. After this time passes, it will apply the first choice available 

in each message and the run will continue to the next prompt window. The advanced user could 

decide to reduce the wait time to a shorter value. This choice is suitable when several scenarios 

must be run in a sequence, since it will not require any action from the operator.  

7.5.4. Outputs 

Based on the selections made by the user, different outputs are created – one set of outputs for 

each specific setting of the catalogue key “Select commodities for the Logistics Module (…)” for 

Standard LogMod. The output files and their locations are listed in the file Scenario Outputs\ 

Existing Outputs in the Data Section window.  

Regarding empty vehicle calculations, the reader is referred to the appendix section 14.2 for 

further details. 

The available outputs from the respective steps in the Samgods Model application that can be 

accessed from the graphical user interface are: 

LOS Calculation step: 

• LOS matrices by mode showing distance, time, extra cost, domestic distance and 

generalized cost summarized link-by-link along the minimum cost path (if the LOS 

Calculation step or the whole run was selected). 

Logistics Module step: 

• The loaded vehicle matrices (number of vehicles) by vehicle type (if the Logistics module 

step or the whole run was selected). 

• Tonnes flow matrices – tonnes of freight by vehicle type (if the Logistics module step or 

the whole run was selected). 
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• The empty vehicle matrices (number of empty vehicles) by vehicle type (if the Logistics 

module step or the whole run was selected and the attribute “EMPTY_V” in the Vehicles 

Parameters table was set to 1 for the specific vehicle type, see Section 9.4).  

• OD covered – various output reports per vehicle type, chain type, zone, and commodity 

– all the output used to create summary reports no. 5-8,6b, 10,11,12 and 19 (see Table 

54). 

Assignment step: 

• All freight flows in tonnes, number of loaded vehicles and number of empty vehicles 

assigned to the network by vehicle type (if the Assignment step or the whole run was 

selected).  

Reports step: 

• The freight flows in tones, number of loaded and empty vehicles assigned to the network 

with all modes in the same network (if the Report step or the whole run was selected).  

• Summary report no. 1. Summary table of number of vehicle kilometres per vehicle type 

(domestic and in total) and per mode in the assigned network (if the Report step or the 

whole run was selected).  

• Summary report no. 3. Summary table of number of tonne kilometres per vehicle type 

(domestic and in total) and per mode in the assigned network (if the Report step or the 

whole run was selected).  

• Summary report no. 4. Summary table of tonne kms per vehicle type (domestic, 

international and total) and per mode (if the Report step or the whole run was selected) 

• Summary report no. 9. Summary table of vehicle kms, tonne kms, empty vehicle kms, 

and total vehicle kms per geographic region and mode (road and rail only) (if the Report 

step or the whole run was selected).  

• Summary report no. 13. Summary table of tons per port area and commodity group and 

comparison with statistics (if the Report step or the whole run was selected). 

• Summary report no. 14. Summary table of results on Oresund bridge, Kiel Canal and 

Jylland and comparison with statistics (if the Report step or the whole run was selected). 

• Network with bidirectional tonnes per rail vehicle type. 

• Summary report no. 16. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads (if the Report step or the whole run was selected). 

• Summary report no. 17. Summary table of vehicle kms per county and vehicle type and 

their distribution on E10 (category 11) (if the Report step or the whole run was selected). 

• Summary report no. 18. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads except E10 (if the Report step or the whole run was 

selected). 

• Report Tons per commodity groups and total (Ktons): GIS network with Ktons per 

commodity group and totals. For its visualization under Report\GIS maps is present a 

standard map (GIS map with Ktons by Commodity group). 

• Report Loaded and empty vehicles per commodity groups and total (Vhcl): GIS network 

with Loaded Vhcl per commodity group and totals, plus empty totals. For its visualization 

under Report\GIS maps is present a standard map (GIS map with vhcl by Commodity 

group). 

RCM Logistic Module step (if the Rail Capacity Management step, RCM step or the whole run 

was selected): 
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• The loaded vehicle matrices (number of vehicles) by mode and vehicle class.  

• Tonnes flow matrices – tonnes of freight by mode and vehicle type.  

• The empty vehicle matrices (number of empty vehicles) by mode and vehicle type.  

• OD covered – various output reports per vehicle type, chain type, zone, and commodity 

– all the output used to create summary reports no. 2, 5-8, 6b,10,11,12 and 19 (see 

Table 54). 

RCM Assignment step (if the Rail Capacity Management step, Assignment RCM step or the 

whole run was selected): 

• All freight flows in tones, number of loaded vehicles and number of empty vehicles 

assigned to the network by mode.  

RCM Reports step (if the Rail Capacity Management step, Report RCM step or the whole run 

was selected): 

• The freight flows in tones, number of loaded and empty vehicles assigned to the network 

with all modes in the same network. 

• Summary report no. 1. Summary table of number of vehicle kilometres per vehicle class 

(domestic and in total) and per mode in the assigned network. See appendix section 

14.2 for details. 

• Summary report no. 3. Summary table of number of tonne kilometres per vehicle type 

(domestic and in total) and per mode in the assigned network (if the Report step or the 

whole run was selected).  

• Summary report no. 4. Summary table of tonne kms per vehicle type (domestic, 

international and total) and per mode.  

• Summary report no. 9. Summary table of vehicle kms, tonne kms, empty vehicle kms, 

and total vehicle kms per geographic region and mode (road and rail only) See appendix 

section 14.2 for details. 

• Summary report no. 13. Summary table of tonnes per port area and commodity group 

and comparison with statistics.  

• Summary report no. 14. Summary table of results on Öresund bridge, Kiel canal and 

Jylland and comparison with statistics.  

• Summary report no. 15. Summary table of bidirectional number of trains and tonnes per 

day.  

• Summary report no. 15b. Summary table of bidirectional number of trains and tonnes per 

day indicating capacity and train flows above the capacity level.  

• Network with bidirectional tons per mode. 

• Summary report no. 16. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads.  

• Summary report no. 17. Summary table of vehicle kms per county and vehicle type and 

their distribution on E10 (category 11).  

• Summary report no. 18. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads except E10.  

• Comparison Ml Tons RCM vs Standard per mode: GIS network with differences between 

RCM and standard results in millions of tonnes per each mode. 

• Report Tons per commodity groups and total (Ktons): GIS network with Ktons per 

commodity group and totals. For its visualization under Report\GIS maps is present a 

standard map. 
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• Summary report no. 21. Domestic Total and International Tonskm and Vkm by 

commodity group RCM - Rail 

• Report Tons per commodity groups and total (Ktons): GIS network with Ktons per 

commodity group and totals. For its visualization under Report\GIS maps is present a 

standard map (GIS map with Ktons by Commodity group). 

• Report Loaded and empty vehicles per commodity groups and total (Vhcl): GIS network 

with Loaded Vhcl per commodity group and totals, plus empty totals. For its visualization 

under Report\GIS maps is present a standard map (GIS map with vhcl by Commodity 

group). 

7.6. Compare Scenarios application 

A view of the application can be seen in Figure 29. The purpose of this application is to compare 

model outputs between two scenarios. Each scenario can be compared with any other scenario 

present under the Scenario Tree structure. There are four catalogue keys (five for a model 

developer) to handle this application, see Table 18. 

 

 

Figure 29 The Compare Scenarios application 

 

Table 18 Compare Scenarios application catalogue keys 

Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

1 
Location of Python 

program 
C:\Python27\ArcGIS10.8 

It specifies the installation 

directory for Python program 
Developer 

2 

Select commodities for the 

Logistics Module (for all 

commodities, select 0) 

0 

It specifies which commodity 

type result must be 

compared; it is possible 

specify only one commodity 

type (value from 1 to 16), or 

all the commodities (value 0) 

S/A user 

3 
What do you want to 

compare? 
LOS Matrices 

It specifies which set of 

result to compare; it is 

possible to specify a single 

step or all the steps 

S/A user 
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Nr 
Text field name in 

template 
Example of value Description 

Model 

User’s 

rights 

4 
Scenario's name to use in 

comparison (ex. Test19) 
Base2019 

It specifies the name of the 

scenario to compare with the 

current scenario 

S/A user 

5 

Scenario folder for 

comparison (ex. 

C:\Samgods\Scenario_tree

\Year_2019\Test19\) 

C:\Samgods\Scenario_Tree\B

ase2019\ 

It specifies the directory of 

the scenario to compare 

with. It requires the full path 

(C:\....), not the relative path 

(Scenario folder) 

S/A user 

The user needs to: 

• select the scenario name to be compared with the current scenario using the fourth 

catalogue key; 

• identify the folder location for the scenario used for comparison (e.g., folder where the 

outputs for scenario selected with previous catalogue key are located, usually located 

under Scenario_Tree folder plus short scenario name) and to update accordingly the fifth 

catalogue key value; 

• select which commodity type results to compare (select the commodity number or 0 for 

all in the second catalogue key) between different scenarios. The user needs to verify 

that the same outputs exist for both scenarios. This could be done by looking in the 

Existing Outputs file for the respective scenario, found in the folder Scenario 

Outputs\Samgods Report in the Data section window. If the requested files do not exist 

for any of the scenarios, the process will be terminated with return code 2 from the Task 

Monitor program, see Section 6.6 

With the third catalogue key the user has the option to compare only a specific set of output 

(among the ones listed below) or all of the results. 

Three sets of output will be produced by this application: 

• The LOS matrix comparison: the difference values with sign between the base scenario 

and the selected scenario for each matrix by mode. 

• Logistics Module output comparison: The OD matrices with number of vehicles (totals 

and empties) and the tonnes are analysed as well as the margins of the matrices for the 

vehicle OD matrices (TRIPEND) (the margin is the sum of each row and column 

respectively, i.e., the totals of attraction and generation): the absolute differences 

between the base scenario and the selected scenario. 

 

• The Assignment comparison: the differences between the assigned network for the base 

scenario and the selected scenario in absolute values. 

• Under Compare\GIS Maps exists the standard GIS map with differences (Ktons) on 

totals and by commodity group. 

7.7. Handling scenario application 

Figure 30 shows an outline of the Handling scenario application. As described earlier, the 

scenario data is stored in the main geodatabase as a group of scenario specific tables. 

Managing this group of files requires dedicated tools to avoid creating any inconsistencies in the 

input data between the scenarios. This application allows the user to delete all no longer required 

data, to easily import or export scenarios from, or to other, catalogues, to set up a new structure 

with a new base scenario, etc. 
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This application has different subgroups with specific purposes, all of them related to handling 

the scenario data. The structure can be seen in the applications tree in the Applications window. 

  

Figure 30 Handling scenario application 

Each subgroup corresponds to a specific operation: 

• Delete: delete the scenario-specific tables completely in the main geodatabase. 

• Compact: compress the geodatabase files to save disk space (see Section 8.9 for 

further information). 

• Scenario Export: This subgroup has two main purposes:  

1. One is to enable the setup of a new catalogue, using the current scenario (i.e., 

the scenario that the application is executed for) as the base scenario in the new 

catalogue. One case where it may be appropriate to create a new catalogue with 

a new base scenario is if one of the scenarios in a catalogue is being used as 

the base scenario in a new project. Another reason could be that the database 

becomes too large (with too many alternative scenarios, for instance), since it 

has a limit for its size. Then it may be appropriate to create a new catalogue with 

a base scenario that is a copy of the original, where more alternative scenarios 

(belonging to the same overall project) may be stored.  

2. Another one is to enable exporting scenario-specific tables from one scenario 

into an already existing catalogue with a different base scenario. The exported 

scenario can never become the base scenario in the destination catalogue. If the 

user wants this, then alternative 1, Above, should be used. This function is 

useful when, for example, the user wants to set up a scenario in a new 

catalogue with a certain base scenario, and already has a similar scenario in 

another catalogue with another base scenario. Then the old scenario can be 

exported to the new catalogue and the user only has to change some of the 

input data, instead of starting all over again. 

• Scenario Import: When the scenario-specific tables have been exported to another 

catalogue using the previous subgroup (Scenario Export), the Scenario Import tool is 

used to control whether the scenario parameters in the new catalogue have the same 

values as those in the imported scenario. 
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As showed in the Table 19, the first two groups of catalogue keys specify scenario parameters 

and parameters for the logistics module. These keys are used only by the Scenario Import 

subgroup; no editing is required for these keys otherwise. 

 

Table 19 Catalogue keys for the Import subgroup 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 Attribute name for extra cost on specific link (SEK) EC_V S/A user 

2 Attribute name for extra cost on specific link (SEK/km) EC_KM_V S/A user 

3 
Number of operating days per year for all modes 

(except for Rail Mode) (days/year) 
250 A user 

4 
Number of operating days per year for Rail Mode 

(days/year) 
250 A user 

5 General parameters for Logistics Module [Table] 

C:\SamGods\Scenario_Tree\Base201

9\Scenario_Data.mdb\LogMod_Base2

019 

A user/ 

Developer 

6 Interest rate used in cost calculations (%/year) 0.1 S/A user 

7 Stuffing cost (SEK/tonne) 60 S/A user 

8 
Number of transport chain solutions for the Logistics 

Module 
5 S/A user 

9 
Output variables for the optimal transport solution 

[e.g.,1,2,3, max is 8] 
6,7 S/A user 

10 
Initial consolidation factor in BuildChain (First iteration 

– from 0 to 1) 
0.75 S/A user 

11 Allow consolidation for all lorry types Yes S/A user 

12 Evaluate transport chains one leg at a time Yes S/A user 

13 
Lower bound for frequency optimisation (Annual 

Tonnes/Shipment) 
1000 S/A user 

14 
Lower bound for consolidation factor (applied to all 

commodities – from 0 to 1) 
0.05 S/A user 

15 
Upper bound for consolidation factor (applied to all 

commodities – from 0 to 1) 
0.95 S/A user 

16 Calculation for demand affecting shipment size DYNAMIC_AVERAGE S/A user 

17 Do you want to log parameters from control files? Yes S/A user 

18 Do you want to log reading of input data? Yes S/A user 

19 Do you want to log cost values from vehicle files? Yes S/A user 

20 

For which logistic solutions do you want to produce 

output data? (0=none, 1=Best solution, 2=Best + 

Second) 

1 S/A user 

The second group of catalogue keys is “Installation parameters“, and it is only available in 

developer mode, see Table 20. It defines the location of the Python program and the name of the 

base scenario. 

 

Table 20 “Installation parameter” keys 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 Location of Python program C:\Python27\ArcGIS10.8 Developer 

2 Scenario name for the BASE Scenario Base2019 Developer 

The next group, “Run Selections”, contains only one key that is for defining the commodity 

type(s), see Table 21. It is only used when the user wants to compress the geodatabase files. 

 

Table 21 “Run Selections” key 

Nr Text field name in template Example of value 

Model 

User’s 

rights 



 

66 

 

1 
Select commodities for the Logistics Module (for all 

commodities, select 0) 
1 S/A user 

The fourth group of keys (which is actually listed as initial group in the graphical user interface) is 

related to which subgroup the user wants to use, and how to use it, see Table 22. 

 

Table 22 Catalogue keys for selecting actions 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 
Select how you want to use Handling scenario 

application 

(2) COMPACT the geodatabase files 

(Input_data.mdb, Scenario_data.mdb 

and Output.mdb) 

S/A user 

2 

For choice 3 or 4 provide an absolute path to the 

location of the destination model (ex. 

C:\Samgods_New_version\) 

C:\Samgods_V20191001\ S/A user 

3 
For choice 3 or 4 provide the name of the base 

scenario in the destination model 
Base2019 S/A user 

The first catalogue key in Table 22 enables the application to: 

• delete the scenario specific tables for the current scenario. During the execution, a prompt 

window will ask the user to confirm the selections made to avoid mistakes.  

• compact all the geodatabase files for the scenario, for both the input and output data. It is 

recommended to do this regularly, especially after tables, etc., have been deleted. Please 

refer to Section 8.9 for more information. 

• export the model or a specific scenario in another model. When using ”(3) EXPORT the 

model in a new folder using the current scenario as Base” a folder location must be provided 

in the second catalogue key. Moreover, a new name should be given to the new base 

scenario in the third catalogue key. If the user wants to export only the selected scenario to 

another catalogue (”(4) EXPORT the current scenario in another model” option for first 

catalogue key), the folder where the .cat file for this catalogue is located should be indicated 

in the second key. The name of the base scenario in the destination catalogue should be 

specified in key no. 3. 

• delete or compact a scenario (i.e., “ (1) DELETE the current scenario tables under 

Input_data.mdb (mandatory if you want to delete the scenario)” or ”(2) COMPACT the 

geodatabase files (Input_data.mdb , Scenario_data.mdb and Output.mdb)” for first key is 

selected). For this selection, the second and third keys are not used, thought they should not 

be left empty.. 

• to control the scenario parameters for an imported scenario, value ”(5) CHECK the imported 

scenario in terms of catalogue key definitions” is used. The scenario parameter values in the 

new catalogue must be identical to the ones in the imported scenario. The execution of this 

subgroup produces a report, named: Report for the import phase, which is accessible from 

the Data Section window in the GUI interface (under the folder Scenario Outputs\Import, 

function report). The report provides a list of the scenario parameters that need to be 

changed. The parameters are changed by editing the catalogue keys for the imported 

scenario according to the report, under “Scenario Parameters” in the Handling scenario 

application and then run the application again. 

Finally, there is a key for the consolidation factors, see Table 23. 

 

Table 23 “Parameters and tables for calibration” keys 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 Consolidation factors table 
{CATALOG_DIR}\05_Input_Data\Input

_Data.mdb\BuildChain_CONSOL 

A user/ 

Developer 
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Regarding output or reports from these functions: 

• No outputs are produced by the Delete and Compact choices, because they use tables inside 

the geodatabase, or on the geodatabase itself. 

• The Scenario Export function creates a new catalogue with a new base scenario, or a new 

scenario in an existing catalogue, depending on the selections made. 

• The Import Scenario subgroup will create a report, Report for the import phase, as described 

above. 

7.8. PWC_Matrices application 

Fel! Hittar inte referenskälla. shows an outline of the PWC_Matrices application. The purpose 

of the application is to create the PWC matrices in Voyager format 4in order to enable 

visualization in the interface. 

 

Figure 31 PWC matrices conversion format application

In Standard user mode there are only two catalogue keys to specify the number of zones in the 

network and the year of the PWC matrices. In Advanced user and developer mode there is also 

a key to identify the base scenario, and a key to set the total number of commodities. 

Table 24 Catalogue keys for the PWC_Matrices application 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 
Number of zones/terminals in network (see value in 

scenario network) 
1383 S/A user 

2 Scenario name for the BASE Scenario Base2019 
A User/ 

Developer 

 
4 The matrix files in Voyager format have .MAT extention and they can be visualised only in the GUI 
interface.  
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3 Choose PWC matrices 2019 S/A user 

4 
Total number of commodities (excluding empty 

commodities) 
16 

A User/ 

Developer 

 

Possible input values for the third key (Year of PWC matrices) in Table 24 are: 

• 2019: PWC matrices for year 2019 

• 2045: PWC matrices for year 2045 

It is necessary to run the PWC_Matrices application only once in order to create the matrices, 

since they are a fixed input for the model. PWC matrices for all commodities will be produced 

when running the application. The matrices, in Voyager format, are created in the folder 

01_Programs\LogMod\Input\PWC\{YEAR}\VY_F\, found in the Samgods folder (see Table 1 in 

Section 5.5). In order to access the matrices from the Data Section window (in Scenario 

Inputs\PWC_Matrices\PWC matrix for commodity), open the Samgods Model application in the 

Scenario Manager window and select a commodity using the catalogue key “Select commodities 

for the Logistics Module (…)”. In this step, the application should not be run, just save the 

settings by clicking “Save”. The matrices can be found in the Data Section window. The value 0 

(for all commodities) is not allowed for this application. This is because the PWC_Matrices 

application only allows showing one commodity at a time. 

 

7.9. Change matrix format application 

In Figure 32 below, the Change matrix format application is outlined. The purpose of the 

application is the following. All the data in a catalogue is accessible using Microsoft Office 

Access (2003 or later). However, all data except the geodatabases can also be accessed using 

Excel or Notepad. The only exception is the data related to the matrix structure, which has a 

binary Voyager format. These matrix files have a .mat extension. There are two ways to export 

these files in order to use them in Access, Excel or a text editor. The first way is to use the 

functions in the Cube Interface. For further details, see the reference guide RG_CubeBase.pdf in 

Chapter 10 – Exporting matrix cell values. In short, this is done by choosing “Export…” from 

“File” on the menu bar and selecting the appropriate file format. 

 

Figure 32 Change matrix format application 
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The second way is provided by this application, as follows. The catalogue keys in Table 25 

handle the export of Voyager format matrix files. 

 

Table 25 Change matrix format application catalogue keys 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 
Select commodities for the Logistic Module 

(for all commodities, select 0) 
0 S/A user 

2 
Do you want to export to CSV, DBF or GDB 

format? 
CSV S/A user 

3 
Do you want to create a new geodatabase or 

use an existing one? 
Existing S/A user  

4 
Define the GDB where the matrix should be 

exported.  

C:\Samgods\Scenario_Tree\ 

Base2019\Matrices_Base2019.mdb 
S/A user  

5 What kind of matrix do you want to export? COST S/A user 

6 
What vehicle class do you want for the LOS 

matrices? 
317 S/A user 

7 
What is the mode that you want for the 

matrices? 
ROAD S/A user 

8 
Do you want the distance, time, domestic 

distance or extra cost LOS matrix? 
Time S/A user 

9 

What type of vehicle class (or total) do you 

want for the VEHICLES and TONNES 

matrices? 

Road S/A user 

Regarding key no. 2, CSV, DBF and GDB refer to Comma Separated Values, Database Format 

and Geodatabase format respectively. If the matrix is exported to a geodatabase, it will be 

created as a table inside an existing geodatabase or a new geodatabase containing this table will 

be created, depending on the choices made by the user. 

To understand the usage of the keys 5-9, and how to export the correct values, an explanation of 

the size and the structure of the matrices is required. 

The following table (Table 26) presents how the LOS matrices are saved in the scenario folder, 

how many matrices that are saved in each matrix file and what their names are. For the OD 

matrices, see the next table (Table 27). 

 

Table 26 Matrix table: LOS matrices 

Folder 
Name of matrix file Name of matrix Description 

Total 

number 

of 

matrices 

{Scenario_Dir} 

COST_ROAD_{SCENA

RIO_SHORTNAME}.MA

T 

D101_{SCENARIO_SHORTNAME}, 

D102_{SCENARIO_SHORTNAME}, 

D103_{SCENARIO_SHORTNAME}, 

D104_{SCENARIO_SHORTNAME}, 

D105_{SCENARIO_SHORTNAME}, 

D106_{SCENARIO_SHORTNAME} 

Distance (km) 

for vehicle type 

101-106 

30 

 

T101_{SCENARIO_SHORTNAME}, 

…, T106_{SCENARIO_SHORTNAME} 

Time (hours) for 

vehicle type 

101-106 

 

X101_{SCENARIO_SHORTNAME}, 

…, 

X106_{SCENARIO_SHORTNAME} 

Extra costs for 

vehicle type 

101-106 
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Folder 
Name of matrix file Name of matrix Description 

Total 

number 

of 

matrices 

 

CG101_{SCENARIO_SHORTNAME}, 

…, 

CG106_{SCENARIO_SHORTNAME} 

Generalized cost 

for vehicle type 

101-106 

 

DD101_{SCENARIO_SHORTNAME}, 

…, 

DD106_{SCENARIO_SHORTNAME} 

Domestic 

distance (km) for 

vehicle type 

101-106 

{Scenario_Dir} 

COST_RAIL_{SCENARI

O_SHORTNAME}.MAT 

D201_{SCENARIO_SHORTNAME}, 

D202_{SCENARIO_SHORTNAME}, 

D204_{SCENARIO_SHORTNAME}, 

D205_{SCENARIO_SHORTNAME}, 

D206_{SCENARIO_SHORTNAME}, 

D207_{SCENARIO_SHORTNAME}, 

D208_{SCENARIO_SHORTNAME}, 

D212_{SCENARIO_SHORTNAME} 

Distance (km) 

for vehicle type 

201, 202, 204-

212 

55 

 

T201_{SCENARIO_SHORTNAME}, 

T202_{SCENARIO_SHORTNAME}, 

T204_{SCENARIO_SHORTNAME}, 

…, T212_{SCENARIO_SHORTNAME} 

Time (hours) for 

vehicle type 201, 

202, 204- 212 

 

X201_{SCENARIO_SHORTNAME}, 

X202_{SCENARIO_SHORTNAME}, 

X204_{SCENARIO_SHORTNAME}, 

…, 

X212_{SCENARIO_SHORTNAME} 

Extra costs for 

vehicle type 201, 

202, 204-212 

 

CG201_{SCENARIO_SHORTNAME}, 

CG202_{SCENARIO_SHORTNAME}, 

CG204_{SCENARIO_SHORTNAME}, 

…, 

CG212_{SCENARIO_SHORTNAME} 

Generalized cost 

for vehicle type 

201, 202, 204-

212 

 

DD201_{SCENARIO_SHORTNAME}, 

DD202_{SCENARIO_SHORTNAME}, 

DD204_{SCENARIO_SHORTNAME}, 

…, 

DD212_{SCENARIO_SHORTNAME} 

Domestic 

distance (km) for 

vehicle type 201, 

202, 204-212 

{Scenario_Dir} 

COST_SEA_{SCENARI

O_SHORTNAME}.MAT 

D301_{SCENARIO_SHORTNAME}, 

D302_{SCENARIO_SHORTNAME}, 

…, 

D322_{SCENARIO_SHORTNAME} 

Distance (km) 

for vehicle type 

301-322 

110 
 

T301_{SCENARIO_SHORTNAME}, 

T302_{SCENARIO_SHORTNAME}, 

…, T322_{SCENARIO_SHORTNAME} 

Time (hours) for 

vehicle type 

301-322 

 

X301_{SCENARIO_SHORTNAME}, 

X302_{SCENARIO_SHORTNAME}, 

…,  

X322_{SCENARIO_SHORTNAME} 

Extra costs for 

vehicle type 

301-322 



 

71 
  

Folder 
Name of matrix file Name of matrix Description 

Total 

number 

of 

matrices 

 

CG301_{SCENARIO_SHORTNAME}, 

CG302_{SCENARIO_SHORTNAME}, 

…, 

CG322_{SCENARIO_SHORTNAME} 

Generalized cost 

for vehicle type 

301-322 

 

DD301_{SCENARIO_SHORTNAME}, 

DD302_{SCENARIO_SHORTNAME}, 

…, 

DD322_{SCENARIO_SHORTNAME} 

Domestic 

distance (km) for 

vehicle type 

301-322 

{Scenario_Dir} 

COST_AIR_{SCENARI

O_SHORTNAME}.MAT 
D401_{SCENARIO_SHORTNAME} 

Distance (km) 

for vehicle type 

401  

5 

 T401_{SCENARIO_SHORTNAME} 

Time (hours) for 

vehicle type 401 

 X401_{SCENARIO_SHORTNAME} 

Extra costs for 

vehicle type 401 

 CG401_{SCENARIO_SHORTNAME} 

Generalized cost 

for vehicle type 

401 

 DD401_{SCENARIO_SHORTNAME} 

Domestic 

distance (km) for 

vehicle type 401 

 

Table 27 presents how the Vehicle, Tonne, and Empty Vehicle OD-matrices are saved in the 

scenario folder, how many matrices that are saved in each matrix file and their names. The 

matrices in Table 27 have an index (0 in the table) that represents the commodity class number 

(e.g., ROAD_VHCLFLOW0_{SCENARIO_SHORTNAME}.MAT). The value 0 refers to all 

commodities, and a specific number represents the respective commodity selection.  

 

Table 27 Matrix table with file structure for OD matrices for number of vehicles (loaded and empty) 

and tonnes 

Folder Name of matrix file Name of matrix Description 
Total of 

matrices 

{Scenario_

Dir} 

ROAD_VHCLFLOW0

_{SCENARIO_SHOR

TNAME}.MAT 

101_{SCENARIO_SHORTNAME}, … 

106_{SCENARIO_SHORTNAME}, 

Road_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 101-106 

and total for road 

mode 

7 

{Scenario_

Dir} 

RAIL_VHCLFLOW0_{

SCENARIO_SHORTN

AME}.MAT 

201_{SCENARIO_SHORTNAME}, 

202_{SCENARIO_SHORTNAME}, 

204_{SCENARIO_SHORTNAME},... 

212_{SCENARIO_SHORTNAME}, 

Rail_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 201, 

202, 204-212 and 

total for rail mode 

12 

{Scenario_

Dir} 

SEA_VHCLFLOW0_{

SCENARIO_SHORTN

AME}.MAT 

301_{SCENARIO_SHORTNAME}, … 

322_{SCENARIO_SHORTNAME}, 

Sea_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 301-

3212 and total for 

sea mode 

23 

{Scenario_

Dir} 

AIR_VHCLFLOW0_{S

CENARIO_SHORTNA

ME}.MAT 

AIR_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 401 and 

total for air mode 

1 
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Folder Name of matrix file Name of matrix Description 
Total of 

matrices 

{Scenario_

Dir} 

ROAD_TON0_{SCEN

ARIO_SHORTNAME}.

MAT 

101_{SCENARIO_SHORTNAME}, … 

106_{SCENARIO_SHORTNAME}, 

Road_{SCENARIO_SHORTNAME} 

OD tonnes by 

vehicle type 101-106 

and total for road 

mode 

7 

{Scenario_

Dir} 

RAIL_TON0_{SCENA

RIO_SHORTNAME}.

MAT 

201_{SCENARIO_SHORTNAME}, 

202_{SCENARIO_SHORTNAME}, 

204_{SCENARIO_SHORTNAME}, … 

212_{SCENARIO_SHORTNAME}, 

Rail_{SCENARIO_SHORTNAME} 

OD tonnes by 

vehicle type 201, 

202, 204-212 and 

total for mode rail 

12 

{Scenario_

Dir} 

SEA_TON0_{SCENA

RIO_SHORTNAME}.

MAT 

301_{SCENARIO_SHORTNAME}, … 

322_{SCENARIO_SHORTNAME}, 

Sea_{SCENARIO_SHORTNAME} 

OD tonnes by 

vehicle type 301-322 

and total for sea 

mode 

23 

{Scenario_

Dir} 

AIR_TON0_{SCENAR

IO_SHORTNAME}.M

AT 

AIR_{SCENARIO_SHORTNAME} 

OD tonnes by 

vehicle type 401 and 

total for air mode 

1 

{Scenario_

Dir} 

ROAD_EMP0_{SCEN

ARIO_SHORTNAME}.

MAT 

101_{SCENARIO_SHORTNAME}, … 

106_{SCENARIO_SHORTNAME}, 

Road_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 101-106 

and total for road 

mode 

7 

{Scenario_

Dir} 

RAIL_EMP0_{SCENA

RIO_SHORTNAME}.

MAT 

201_{SCENARIO_SHORTNAME}, 

202_{SCENARIO_SHORTNAME}, 

204_{SCENARIO_SHORTNAME}, … 

212_{SCENARIO_SHORTNAME}, 

Rail_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 201, 

202, 204-212 and 

total for mode rail 

12 

{Scenario_

Dir} 

SEA_EMP0_{SCENA

RIO_SHORTNAME}.

MAT 

301_{SCENARIO_SHORTNAME}, … 

322_{SCENARIO_SHORTNAME}, 

Sea_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 301-322 

and total for sea 

mode 

23 

{Scenario_

Dir} 

AIR_TON0_{SCENAR

IO_SHORTNAME}.M

AT 

AIR_{SCENARIO_SHORTNAME} 

OD vehicles by 

vehicle type 401 and 

total for air mode 

1 

Potentially, as many as 2759 matrices with different level of aggregation could exist in the 

scenario folder. See Table 28 for which values to set in the keys in order to print out a specific 

matrix.  

 

Table 28 Choice order 

Text field name in template  Choices available  Description 

Refer to 

matrix 

table 

Select commodities for the Logistics 

Module (for all commodities, select 0) 

0 All commodities  

1-16 Single commodity  

Do you want to export in CSV, DBF or 

GDB format? 

CSV Comma Separated Values  

DBF Database Format  

GBD Geodatabase table  

Do you want to create a new 

geodatabase or use an existing one? 

Create   

Existing   

Define the gdb where export matrix:  

An existing or new geodatabase, 

depending on choice for previous 

key 

Table 25 

What kind of matrix do you want to 

export? 

COST LOS matrix Table 26 

VHCLFLOW OD Vehicles matrix Table 27 

TON OD Tonnes matrix Table 27 

EMP OD Empty Vehicles matrix Table 27 

Which vehicle class do you want to 

select for the LOS matrices? 

101-106, 201, 202, 

204-212, 301-322, 401 

Vehicle type for the LOS 

matrices 
Table 26 

What is the mode that you want for the 

matrices? 

ROAD, RAIL, SEA, 

AIR 
Mode for the LOS matrices Table 26 
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Do you want the distance, time, 

domestic distance or extra cost LOS 

matrix? 

 Specification for the LOS matrix Table 26 

Distance D101-D106, D201, …  

Time T101-T106, T201, …  

Domestic Distance DD101-DD106, DD201, …  

Extra cost X101-X106, X201, …  

What type of vehicle class (or total) do 

you want for the VEHICLES and 

TONNES matrices? 

 Specification for the OD matrix Table 27 

101-105, 201, 202, 

204-209, 301-321 
Select a specific vehicle type  

Road, Rail, Sea, Air  Select a mode  

Based on the choices made in the catalogue keys described above, the Change matrix format 

application creates a CSV or DBF file, or a table inside an existing or a new geodatabase, with 

the structure Origin zone, Destination zone and matrix value. The matrix file is found in the 

scenario folder and will have a name that gives the specifications made in the catalogue keys, 

e.g.:{Scenario_DIR}\COST_RAIL_DD202_VOY.CSV  

Where the first part (COST) defines the type of matrix (COST, VHCLFLOW, TONNES or 

EMPTYVEHICLEFLOW), the second part (RAIL) the mode (RAIL, ROAD, SEA or AIR), the third 

part (DD) the type of matrix for the LOS matrices (DD, D, T or X), the fourth part (202) the vehicle 

type and the fifth part give whether the user is an Emme or a Voyager user.

7.10. Select Link Analysis 

Figure 33 shows an outline of the Select Link Analysis application. Due to the huge amount of 

output files produced by Standard Logmod and RCM and the level of their disaggregation, this 

application provides different tools to analyse and show the results with different aggregation 

levels and for specific movements. 

  

Figure 33 Select Link Analysis application 

The application produces the following outputs that depend on the choices made via the 

catalogue keys: 

• Network containing loaded vehicles and tons for specific commodity (and total) and the 

empty vehicles. 
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• Maps with loaded, empty vehicles and tons per commodity group when all the commodities 

option is chosen. 

• The loaded and empty vehicles and tons could be filtered based on a selection of: 

o Links in the network: the list provided will filter the chains in which the list of 

links is part of the path.  

o Nodes in the network: with the same criteria all the chains having one or 

more nodes in their path will be selected. 

• The OD Loaded, empty vehicles and tons that are derived by filtering the chains by the list of 

links or nodes. 

The catalogue keys could be classified in six different groups: 

• Output location  

• List of commodities to use in the analysis and rules in applying different selections 

• List of links for the selection 

• List of nodes for the selection 

• Traversal matrices 

• General parameters 

• Standard maps 

The output location by default is: 

• {Scenario_Dir}\SelectLink\{FolderSelectLink}: Since for the same scenario several select link 

analyses could occur, per each run the user should provide a name for the selection (e.g., 

Oresund, SL1, anything but without special or black characters). Each run will be saved in a 

subfolder in which the name is provided by \{ FolderSelectLink } 

The catalogue key designed for this purpose is represented in Table 29. 

 

Table 29 Select link run name 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 SelectLink analysis name (max 6 characters) Test1 S/A user 

The selection could be filtered by specific product groups or a list of them. The first catalogue key 

in Table 30 is designed for this purpose. The criterion can be also combined in different manner, 

based on the rule applied through the second catalogue key: 

• only node selection (regardless what is under link selection) 

• only link selection (regardless what is under node selection) 

• node OR link selection (one or the other) 

• node AND link selection (both met) 

Table 30 Selections 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 List of commodities for Select Link Analysis (0 for All) 1,5,9,12 S/A user 

2 
Select the method being applied for conditions on 

nodes and links 

only node selection (regardless what is 

under link selection) 
S/A user 

These catalogue keys are specific for this application. The link list for the selection is specified 

via the following catalogue keys in Table 31. 
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Table 31 Link selection options 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 Numbering system for link list 
Voyager (Example 1-2049,2-2083,3-

2039) 
S/A user 

2 List of links 1-2049 S/A user  

3 Selection criteria for links 
ANY ;any of the given links must be 

used 
S/A user 

The interface provides different ways to specify the link list in terms of numbering systems: 

• Using Voyager nodes (specifying “Voyager” under catalogue key 1, in Table 31) 

• Using Emme nodes (specifying “Emme” under catalogue key 1, Table 31) 

• Using the id of the link as specified in file Links_List.txt under 

{Scenario_Dir}\LogMod_{Loop}\RCM folder (Internal_Link_Nbr in the table) (specifying 

“ID_LINK” under catalogue key 1, Table 31) 

For “Voyager” a link must be represented with A-B notation, in which A is the starting node 

number and B is the ending node number for the link. For “Emme” a link must be represented 

with AORIG-BORIG notation, in which AORIG is the starting Emme node number and BORIG is 

the ending Emme node number for the link. 

The last catalogue keys control how the list of links will be interpreted during the selection. Four 

possible options are implemented: 

• SINGLE ;visit exactly one 

• ANY ;any of the given links must be used 

• ALL ;all of the given links must be used 

• ORDER ;all nodes and links must be used, and nodes must be visited in order they are listed 

under catalogue key 2 

The node list for the selection is specified via the following catalogue keys in Table 32. It is 

allowed maximum 40 nodes. 

 

Table 32 Node selection options 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 Numbering system for node list Voyager (Example 1,2049,2083,2039) S/A user 

2 List of nodes 2049,2039 S/A user 

3 Selection criteria for nodes 
ANY ;any of the given links must be 

used 
S/A user 

 

The interface provides different ways to specify the node list in terms of numbering systems: 

• Using Voyager nodes (catalogue key 1 set to Voyager, see Table 32) 

• Using Emme nodes (catalogue key 1 set to Emme, see Table 32) 

The last catalogue keys control how the list of nodes will be interpreted during the selection. Four 

possible options are implemented: 

• SINGLE ;visit exactly one 

• ANY ;any of the given links must be used 

• ALL ;all of the given links must be used 

• ORDER ;all nodes and links must be used, and nodes must be visited in order they are listed 

in catalogue key 2 in Table 32. 
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The Road traversal matrices can be produced using the following specific combination of 

catalogue keys, with the exact values shown in Table 33 only. The reason is to produce traversal 

matrices (e.g., trips crossing Swedish borders) for transfer that can be imported to the 

SAMPERS model. The matrices are fixed and the list of EMME nodes depends on the current 

Base2019/MainSc2045 coded networks.  

 

Table 33 Traversal matrices settings 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 List of nodes  

207904,207823,206989,205840,20659

3,187836,200680,197767,156054,181

993,178637,188705,181993,190612,2

05895,207871,206724,196653,199640

,193196,158978,171090,155434,1032

88 

S/A user 

2 Numbering system for node list 
Emme (Example 

711400,171695,711401) 
S/A user 

3 Selection criteria for nodes 
ANY ;any of the given links must be 

used 
S/A user 

4 
Do you want to produce traversal matrices? 

(Untick=no Tick=yes) 
Tick (yes) S/A user 

 

• The standard location for the output matrices (in Emme format *.314) is specified under 

ScenarioOutput\DataPanel\Select Link\TraversalMatrices: 

• STD: {SCENARIO_DIR}\SelectLink\{FolderSL}\STD\*.314 

• RCM: {SCENARIO_DIR}\SelectLink\{FolderSL}\RCM\*.314 

To produce standard maps with results classified by commodity group the following catalogue 

key in Table 34 should be checked. 

 

Table 34 GIS Maps option 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 
Do you want to produce GIS Maps by Commodity 

group? 
Yes S/A user 

 

The last group of catalogue keys is related to general settings and parameters used in the 

creation of empty path files (see Table 35). 

The empty vehicles do not belong to any specific chain, therefore the select link analysis is 

based on the used paths produced during the assignment. The first run will, by default, produce 

the full set of path files (estimated running time: 30 minutes). In the subsequent runs the process 

will be skipped since the required path files are already present. No selections are possible for 

the user since they are produced by default. 

 

Table 35 “Scenario parameters” and “Installation parameter” keys 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 
Number of zones/terminals in network (see value in 

scenario network) 
1383 Developer 

2 Location of Python Program C:\Python27\ArcGIS10.8 Developer 

3 Location of Java folder C:\Program Files\Java\Java8\bin Developer 

4 Path to cmd.exe C:\ Windows\System32 \cmd.exe Developer 
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5 Scenario name for the BASE Scenario Base2019 Developer 

6 Choose PWC matrices 2019 S/A user 

7 List of rail modes in RCM GHhIiTUDdEFf Developer 

8 Maximum number of loops in calibration process 1 Developer 

 

 

 

Tip: For a normal select link or node analysis, it is advised the following selection: 

• all the commodities under “List of commodities for Select Link Analysis (0 for All):0” (or 

just keeping the default value).  

• the production of GIS maps, ticking the catalogue key “Do you want to produce GIS 

Maps by commodity group? Yes” (or just keeping the default value). 

The results will be already produced with commodity disaggregation for loaded vehicles and tons.  

In the event of a deeper analysis for specific commodity groups (or just one), the default of the 

above catalogue keys should be revised with the appropriate commodity number. For instance, 

for the selection of commodity 8 the two catalogue keys will take the following values: 

•  “List of commodities for Select Link Analysis (0 for All):8”  

• “Do you want to produce GIS Maps by commodity group? No”  

In fact, the maps will be produced with several empty fields (for all commodities that are not 

chosen in the analysis) and with values for commodity 8 only. 
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7.11. Cost Benefit Analysis – ASEK Values 

The existing standard transport and cost data derived from the model are based on calibrated 

cost data and system performance parameters (such as: loading times, transport times, link toll 

values, country toll values, etc.). The split of data into domestic and international transports are 

based on domestic distances as a fraction of total distances for the OD-legs. This is valid for 

distance related items on links (travel costs and times), but not for times or costs related to 

link/node usage (such as: loading times and costs, holding costs, interest costs, transfer times, 

etc.)  

The Cost Benefit Analysis – ASEK Values application is specifically designed to calculate socio-

economic values from the Samgods model, primarily related to ASEK-valued data for transports 

taking place on Swedish territory (including coastal waters along the coast). 

The main differences between Samgods Model and Cost Benefit Analysis-ASEK Values 

applications are related to the cost and time values, in which: 

• All the calibration parameters such as port area commodity parameters, transoceanic 

values, technological factors on time and cost per ports, rescaled values of vehicle 

costs, Tax_category, Tax_country, Tax_link and Toll_link are excluded in order to get 

the actual cost and time values. 

• Total domestic and international costs and times are produced. The different 

components of costs and time (loading and unloading, transfer, transfer) have the same 

characterization. This implies that the application must provide LOS total domestic 

matrices also for time and cost and not only for time as in the main model. 

The application has the following simplified structure presented in Figure 34. 

 

 

Figure 34 Cost Benefit Analysis – ASEK Values application 

To use the application the following catalogue keys in Table 36 must be used: 
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Table 36 Main catalogue key for the cost benefit analysis module 

Nr Text field name in template Example of value 

Model 

User’s 

rights 

1 
Number of zones/terminals in the network (see value 

in scenario network) 
1383 S/A user 

2 
Include the cost of empty transports in the calculation 

of system costs 
No S/A user 

3 Weighting factor Domestic 1 S/A user 

4 Weighting factor Import 0.5 S/A user 

5 Weighting factor Export 0.5 S/A user 

6 Weighting factor Transit 0 S/A user 

7 

Full scenario folder for comparison (JA- reference 

scenario - before investment) (Base2019 folder if 

Year_2019, MainSc2045 folder if Year_2045) 

C:\Models\Samgods_V12D_20190531

\Scenario_Tree\Year_2019\Base2019\ 
S/A user 

8 

Scenario's name to use in comparison (JA- reference 

scenario – before investment) (Base2019 if 

Year_2019, MainSc2045 if Year_2045) 

Base2019 S/A user 

The user needs: 

• to select current scenario in which CBA analysis must be run under scenario window. 

• set the number of terminals/zones within the network.  

• the second key, under Table 36, lets the user select the combination of costs included 

in step 3 and 4 in the CBA calculation (See Figure 35) – basically the ratio calculated in 

Step 4: Ratio_SYS_UA_JA = SYS_K_UA / SYS_K_JA can use: all costs (Transport 

Cost (Loaded vehicles, empty vehicles) + Inventory Cost (storage cost, capital cost, 

order cost) or Transport Cost (Loaded vehicles) + Inventory Cost (storage cost, capital 

cost, order cost). When No is selected empty vehicle costs are excluded, vice versa 

when it is selected Yes. 

• the third to sixth key, under Table 36, should not be modified based on the methodology 

specify by Trafikverket. Each cost (Domestic, Import, Export and Transit) will be 

weighted by this factor in accordance to Trafikverket’s methodology. The users have the 

option to change them for their own analysis and testing (values are between 0 and 1 

with decimals).  

• to change the eighth catalogue key, under table 36, with the name of scenario the user 

wants to use as JA (reference scenario – before investment): 

• if current scenario is in Y_2019, the catalogue key “Scenario's name to use in 

comparison (JA- reference scenario – before investment) (Base2019 if Year_2019, 

MainSc2045 if Year_2045):” will be set to Base2019.  

• if current scenario is in Y_2045, the catalogue key “Scenario's name to use in 

comparison (JA- reference scenario – before investment) (Base2019 if Year_2019, 

MainSc2045 if Year_2045):” will be set to MainSc2045.  

• to identify the folder location for the scenario used for comparison (e.g., the folder 

where the outputs for scenario selected with previous catalogue key are usually found 

in Scenario_Tree folder plus short scenario name) in the eighth catalogue key value 

and update accordingly the seventh catalogue key, both under table 36: 

• if current scenario is in Year_2019, the catalogue key “Full scenario folder for 

comparison (JA- reference scenario – before investment) (Base2019 folder if 

Year_2019, MainSc2045 folder if Year_2045):” will be for example: 

C:\Samgods\Year_2019\Base2019\,  

• if current scenario is in Year_2045, the catalogue key “Full scenario folder for 

comparison (JA- reference scenario – before investment) (Base2019 folder if 
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Year_2019, MainSc2045 folder if Year_2045):” will be for example: 

C:\Samgods\Year_2045\MainSc2045\,  

All the other catalogue keys are derived from Samgods Model application run and they should 

not be modified for the specific run. Notice that the structural change of calibration parameters 

with separate databases, excludes the need of separate ASEK-scenarios. All listed costs within 

the Input_Data.mdb are now ASEK-related and are used when running the CBA-analysis 

application within Samgods 1.2.3.  

All the outputs are then stored and saved under the main scenario, with suffix CBA on the folder 

and file names. The outputs are identical to those produced under Samgods Model application. 

All the costs and times are recalculated without the scaling factors, and therefore they represent 

the actual values that can be used in CBA. 

The following reports are present in the data panel for Cost Benefit Analysis – ASEK Values 

application output: 

• Vehicles, loaded and empty, within Swedish territory: first table used for CBA analysis in 

evaluating the externalities (emissions, noise, accidents, infrastructural damage, etc.). It 

contains VhclKm and tonkm by vehicle type within the Sweden territory divided by 

loaded and empty, while also the distinction between vehicles on ferry and ferry 

vehicles. For definition and name of each attribute please refer to Technical Manual 

(section 3.4.3.26). 

• Logistic Cost Changes used for CBA: the report contains, step by step, the calculation 

defined under “Samhällsekonomisk kalkyl baserad på Samgods Bilaga 1”. An example 

is presented in Figure 35. 

 

Figure 35 General report on cost benefit analysis 

For a detailed description on how to setup and run a CBA with the Samgods model, please see 

[10]. Below a stepwise summary of the description is given: 

1) Run the reference scenario JA, e.g., Base2019, with the Samgods Model application 

2) Create and run the child with investigation scenario, UA, with the Samgods Model 

application. 
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3) Analyse and compare the outputs from the two scenarios JA and UA. 

4) Create the first dataset for the CBA analysis by running the application Cost Benefit 

Analysis - ASEK Values from the reference scenario (JA). This means that the scenario 

will point at itself, for example scenario: Base2019 and reference scenario JA: 

Scenario_Tree\Year_2019\Base2019. 

5) Create the second dataset for the CBA analysis by running the application Cost Benefit 

Analysis - ASEK Values from the child/investigation scenario (UA). Make sure to set the 

same reference scenario as in step 4 JA, i.e., Scenario_Tree\Year_2019\Base2019. 

6) Collect the output data. For transport costs, used for estimating the benefit, please see 

the report “Logistic Cost Changes used for CBA” under CBA Report > Main Reports in 

the data window of the child scenario UA5. For traffic and transport work, used for 

estimating externalities and financial effects, use the file “Vehicles, loaded and empty, 

within Swedish territory” under CBA Report > Main Reports in the reference and child 

scenario, respectively. The user may find this data in the access database table 

“Vehicles_loaded_and_empty_witin_swedish_territory_CBA” as well. 

 

 
5 The reference scenario JA also produce this file. The purpose of this is to prepare data for the second run of the CBA 
application. For the reference scenario the “cost differences” should sum to 0 since the comparison is made with the 
same scenario. 
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7.12. Elasticity Module 

Samgods model is used in setting up different scenarios (through changes in the input network, 

vehicle costs and PWC matrices) and analysing the results at various levels of aggregation. 

(such as: assignment level, OD level, etc.).  

To perform a sensitivity analysis, i.e., variation of fixed percentage of some input variables and 

deriving the arc elasticity on the costs, the standard setup would require: 

• the setup of several scenarios changing minor components of the inputs (vehicle 

parameters and tolls). 

• to run in sequence Samgods producing a significative number of results, most of which 

will be useless for the sensitivity analysis. In fact, it focuses on vehicle and ton 

performance indicators (vehiclekm, tonkm, vehicles, tons, etc) only.  

• to spend runtime not required in producing the not desired outputs (see point above). 

• to assemble the results in a meaningful manner, calculating the arc elasticity of the cost 

differences for each vehicle class.  

The Samgods Elasticity Module application has been developed specifically to overcome all 

these limitations and has the following features: 

• to run several scenarios modifying specific attributes against the reference scenario 

(initial scenario with neutral values) without user intervention. 

• to skip the irrelevant modules to produce just the required outputs, cutting the runtimes. 

• to consolidate the results in a unique database for an easy access and create the 

elasticity report that contains the final values. 

7.12.1. Cube implementation 

The Samgods model includes the application Elasticity Module, located in Application Panel 

(see Figure 36 and Figure 37). 

 

Figure 36 Application window 

The Elasticity Module differs in terms of structure from the standard one having excluded all the 

assignment and reporting steps, except the following ones (where {Select_commodity} 

represents catalogue key “Select commodities for the Logistics Module (for all commodities, 

select 0)” which by default is 0, i.e., all commodities)6: 

 
6Both {Scenario_ShortName} and {Select_commodity} are catalogue keys, please see Technical documentation [4] for 
more information. 
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• Output by vehicle class – Table 

VHCL_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}_X 

• Output by chain – Table 

CHAIN_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}_X 

• Loaded Demand – table 

COM_L_D_{SCENARIO_SHORTNAME}_{Select_commodity}_X 

• Output by vehicle class – Table 

VHCL_OD_COV_{SCENARIO_SHORTNAME}_RCM_X 

• Output by chain – Table CHAIN_OD_COV_{SCENARIO_SHORTNAME}_RCM_X 

• Loaded Demand – table COM_L_D_{SCENARIO_SHORTNAME}_RCM_X 

Where X is the ID_SCENARIO for the specific elasticity test (see details in the next section). 

That implies that only those tables are present under data panel. 

 

 

Figure 37 Elasticity Module application flow chart structure 

7.12.2. Scenario preparation 

Prior the Elasticity Module application run, a scenario must be already present with all the 

results from a successful Samgods Model application run.  

7.12.3. Scenarios 

As mentioned, the elasticity module facilitates the setup of several runs using a unique scenario 

modifying specific parameters. The list of scenarios is available in the Scenario_List table within 

the Input_Data.mdb. It is also accessible from the GUI interface through the catalogue key 

“Table with scenarios want to run for the elasticity calculation:”, see Figure 38, or under the Data 

Panel, Scenario Inputs > List of scenarios, see Figure 39. 
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Figure 38 The Scenario list catalogue key 

 

 

Figure 39 Data panel and list of scenarios location 

A subset of the variables in scenario list can be seen in Figure 40. The module produces results 

modifying the base KM_COST and HOURS_COST (plus related attributes NC_LTI, NC_LTIT, 

CONT_LTI, CONT_LTI_T) in each mode (or subset of vehicle types in rail).  

A second set of modified parameters refers to: 

• TOLL: for road tolls on bridges and rail fees on bridges; 

• TRACK_F: track fees in Sweden (base table COUNTRY_TAX and ID_Country=1); 

• F_DUES_VH and F_DUES_TON: Fairway Dues per Vehicle and tonnes for the sea 

mode. 

Each scenario is denoted with ID_SCENARIO. This code will identify the specific set of outputs 

produced for the specific run and the values should be used under catalogue keys (as explained 

later in the document).  

 

 

Figure 40 Elasticity scenario definition 
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ID_VEHICLES represents the list of vehicle types where rescaling factors will be applied. 

KM_COST, HOURS_COST and the others attributes express the increase/decrease of the base 

costs as percentage. 

For instance, considering ID_SCENARIO=97 ID_VEHICLES=102,205 KM_COST=1,1, this will 

affect vehicle types 102 and 205, KM_COST for the respective vehicle type will be increased by 

10%, since KM_COST=1,1.  

While ID_SCENARIO controls the outputs and which test must be run from the interface, 

ID_VEHICLES gives the full list of vehicle types in which modification will occur. The list follows 

the Voyager syntax: 

• “-“ symbol is used for range of values. For instance, 101-106 represents 

101,102,103,104,105 and 106. Basically, all road vehicle types. 

• “,” symbol is used to provide a list of values one by one: 102,205 represent vehicles 102 

and 205 

• Symbols above can be combined to produce a full list. Some examples are:  

o 207-209,212 

o 101-105,201,211-212,311 

The changes can be applied within the same mode (207-209,212) or across different modes 

(102,205). There is no limitation in that sense.  

The other attributes are: 

• ID: record identifier (row number). Not connected to any function or purpose in the 

model. When records are deleted or added, ID keeps always a unique number (primary 

key) within the table. 

• Mode: for description purposes, on the type of vehicles included in the test. Not used in 

the model, but useful as a reference to the type of scenario run. 

• Scenario: Each scenario can alter one cost component at the time. In the scenario 

attribute, the first two characters indicate which cost is being altered and must be 

selected from Table 37 The remaining part of the name can be any descriptive text (for 

example, KM_TO_ANALYSE_THIS). The first two characters of the scenario are 

carried through the run and printed out in the final results to help users identify the 

scenario type. They also affect the elasticity calculations in the table 

Elasticities_{SCENARIO_SHORTNAME}_{ID_SCENARIO} located in Output.mdb. It 

will NOT influence the results from the LogMod and RCM runs, i.e., how costs are 

altered is derived from the combination of KM_COST, other attribute values, and the 

ID_Vehicle list.  

 

Table 37 Abbreviations for cost changes in the elasticity module 

 

 

FIRST TWO LETTERS for SCENARIO 

attribute 
Attribute 

KM KM_COST 

HR 
HOURS_COST (plus related attributes NC_LTI_DRY, NC_LTI_LIQ, 

NC_LTI_GC, CONT_LTI)  

TO TOLL; 

TF TRACK_F 

FD F_DUES_VH 

FT F_DUES_TON 

Tip. The Scenario_List table covers standard sensitivity tests. If the user needs to specify 

different elasticity tests, advice is required in setting them up under the Scenario_List. 
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The same ID_SCENARIO code is appended to the six output tables saved during the run of 

each scenario ones (where {Select_commodity} represents the catalogue key “Select 

commodities for the Logistics Module (for all commodities, select 0)” which by default is 0, i.e., 

all commodities) : 

• Output by vehicle class STD – Table 

VHCL_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity} _{ID_SCENARIO} 

• Output by chain STD – Table 

CHAIN_OD_COV_{SCENARIO_SHORTNAME}_{Select_commodity}_{ID_SCENARIO} 

• Loaded Demand STD – table 

COM_L_D_{SCENARIO_SHORTNAME}_{Select_commodity}_{ID_SCENARIO} 

• Output by vehicle class RCM – Table 

VHCL_OD_COV_{SCENARIO_SHORTNAME}_0_RCM_{ID_SCENARIO} 

• Output by chain RCM – Table 

CHAIN_OD_COV_{SCENARIO_SHORTNAME}_0_RCM_{ID_SCENARIO} 

• Loaded Demand RCM – table 

COM_L_D_{SCENARIO_SHORTNAME}_0_RCM_{ID_SCENARIO}. 

These tables are NOT accessible via Cube GUI and can only be accessed using MS Office 

Access. 

7.12.4. Usage 

Catalogue keys 

The three catalogue keys in Figure 41 control the process in the elasticity module. The first key 

“Table with want to run for the elasticity calculation” points to the table with the list of default 

sensitivity tests. See Figure 40.  

 

 

Figure 41 Catalogue keys for scenario setup in the elasticity module 

In theFigure 40 the first entry (ID_SCENARIO=1) represent the “Reference scenario” that has 

been run under Samgods Model application. All costs and times will be altered from the inputs 

present in this scenario. The table has a fixed number of default sensitivity tests (100). If the 

user needs to alter, by adding a new element please contact Trafikverket for advice.  

“Lowest scenario in sensitivity run:” and “Highest scenario in sensitivity run:” work in pair and 

represent the lower and upper scenario ID_SCENARIO that the user wants to run in sequence. 

Usages are: 

• Run a single scenario: both keys will be set to the same value (for example, 15 and 15). 

• Run a range of scenarios: lowest value will be the first scenario (15) and the second 

one the highest scenario (20). All the scenarios from 15 to 20 will be run without any 

manual action from the user. 

• It is not allowed to run a list of scenarios that is not sequential, for instance if the user 

wishes to run 1, 8 and 15, they must be set up as single runs. 
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Please note that there is no catalogue key to set if the model should use endogenous or 

exogenous consolidation rates. By default, the elasticity module uses exogenous consolidation 

rates inherited from the reference scenario. 

 

IMPORTANT NOTE 1: Scenario denoted as 1 is the reference scenario. All the other scenarios 

will derive the definition of, for example control files, batch files, etc., from the reference 

scenario.  

To run any sensitivity test, the reference scenario MUST be in place. 

The reference scenario is produced running Samgods Model application first with the 

unaltered costs and times. 

 

IMPORTANT NOTE 2: In relation to the functionality for exogenous/endogenous consolidation 

rates, all the sensitivity tests will use the consolidation rates from the reference scenario. This 

is due to the following general rule: any child scenario (i.e., alternative scenario in the specific 

model year) should derive its consolidation rates from the parent scenario. In the context of 

the elasticity module, parent is the reference scenario, and child is the sensitivity test.  

If the user has to provide a distinct set of consolidation rates from an unrelated scenario, the 

rule above is applied and the user should seek advice from Trafikverket. 

 

IMPORTANT NOTE 3: The calibration factors in Input_Data_Calibration_Base2019.mdb and 

Input_Data_Calibration_MainSc2045.mdb use multiplicative factors but not additive terms for 

the various tables yet. If the user wishes to use ADDITIVE terms (TE) for the following 

attributes: 

NC_LTI, NC_LTIT, CONT_LTI and CONT_LTI_T in the Vehicles_parameters_PartB table 

And wants to run the elasticity module, should seek advice from Trafikverket. 

Any run – LogMod_1 produced by “Samgods model” application MUST be present 

In order to run the “Samgods Elasticity” application: 

• Define the “Lowest scenario in sensitivity run” = the ID_SCENARIO for the first scenario 

that needs to be run (>1) and 

• “Highest scenario in sensitivity run” to the ID_SCENARIO of last scenario the user wishes 

to run in one-go (>1) 

 

IMPORTANT NOTE: under some unforeseen circumstances, writing from/to mdb files leads to 

run failure since mdb can be locked. To avoid such failure, it is recommended to run NO MORE 
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than four scenarios in a row. When completed, close down Cube catalogue and Cube software, 

and restart it. 

7.12.5. Output 

Output tables will be produced under same output mdb file as Samgods Model standard run. In 

detail under Output0_{SCENARIO_SHORTNAME}.mdb will be present the following tables 

demarked by ID_SCENARIO. In Figure 42 five elasticity scenarios have been evaluated (5, 6, 7, 

8 and 9). 

 

Figure 42 Output examples within Output0_{Scenario_Name}.mdb 

Under scenario folder the user can find the rep files from STD and RCM procedures. The files 

are illustrated in Figure 43. 

 

 

Figure 43 Listed output files from the elasticity module in the main folder of the reference scenario 

Same applies for the DBF tables with vehicle parameters from each run. In the example 

Vh_base_BS12.DBF is the initial table with original values and it is to the same as 

VH_Par_Loop_A_1.DBF. Vh_Par_loop_PartA.DBF is a working table related to the last run. 

VH_Par_Loop_A_{ID_SCENARIO}.DBF is the specific table for the scenario. 

Vh_Par_Loop_A_2.dbf is the vehicle table used in ID_SCENARIO = 2. See example of listed 

files in Figure 44. 
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Figure 44 Vehicle parameters database file generated in the main folder of the reference scenario 

when running the elasticity module 

7.12.6. Specific elasticity output 

Two output tables summarizing the elasticities for each scenario are available: 

• Elasticities_{SCENARIO_SHORTNAME}_{ID_SCENARIO} table under 

Output0_Base2019.mdb 

• Elasticities_{ID_SCENARIO}.CSV under scenario folder. 

They have the following content as listed in Table 38. The attributes have the following 

meaning: 

• PART: Which part of the model produced the output (Standard Logistic Module (STD) 

or RCM) 

• LABEL: describes the unit for the values present in the line under V101-V401 

• RATIO TDOM VHKM: Ratio between vehicle km total domestic of current scenario vs 

scenario 1 

• RATIO TDOM TONKM: Ratio between total domestic ton km of current scenario vs 

scenario 1 

• RATIO TOT VHKM: Ratio between vehicle km total where total = total domestic plus 

international, current scenario vs scenario 1 

• RATIO TOT TONKM: Ratio between ton km total (international plus total domestic) 

current scenario vs scenario 1 

• TF RATIO: First part denoted in bold is defined by the Scenario_List Scenario attribute 

and list of values are shown in  

• Table 37. 

As per the scenario list: 

• TF ELAS VHkm TDOM: elasticity values for vehicle km TDOM7 

• TF ELAS Tonkm TDOM: elasticity values for ton km TDOM 

 
7 The definition of TDOM is found in the MERGEREP/OUTPUT/-files, where TDOM is connected to Dtotal 
and TOT is connected to DTonneKm + ITonneKm. This is also seen in the script. 

FIRST TWO LETTERS for SCENARIO 

attribute 

Attribute 

KM KM_COST 

HR 
HOURS_COST (plus related attributes NC_LTI_DRY, NC_LTI_LIQ, 

NC_LTI_GC, CONT_LTI)  

TO TOLL; 

TF TRACK_F 

FD F_DUES_VH 

FT F_DUES_TON 
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• TF ELAS VHkm TOT: elasticity values for vehicle km TOT 

• TF ELAS Tonkm TOT: elasticity values for ton km TOT 

• ID_SCENARIO: scenario id listed in scenario list table; 

• V101,V102,….V401 : values for a specific output, defined under LABEL attribute. 

 

 

 

Table 38 Example of Elasticities_{SCENARIO_SHORTNAME}_{ID_SCENARIO} table 

PART LABEL ID_SCENARIO V101 V102  … V201 V202 V204 

STD RATIO TDOM VHKM      66 1 1.00053  0 0.99416 0.9911 1 

STD RATIO TDOM TONKM     66 1 1.00069  0 0.99405 0.99088 1 

STD RATIO TOT VHKM       66 1 1.00023  0 0.99407 0.9911 1 

STD RATIO TOT TONKM      66 1 1.00031  0 0.99398 0.99088 1 

STD TF RATIO             66 1 1  1 1.1 1.1 1.1 

STD TF ELAS VHkm TDOM    66 0 0.00053  -1 -0.09622 -0.099 -0.09091 

STD TF ELAS Tonkm TDOM   66 0 0.00069  -1 -0.09632 -0.0992 -0.09091 

STD TF ELAS VHkm TOT     66 0 0.00023  -1 -0.0963 -0.099 -0.09091 

STD TF ELAS Tonkm TOT    66 0 0.00031  -1 -0.09638 -0.0992 -0.09091 

RCM RATIO TDOM VHKM      66 1 0.99901  0 0.98978 0.99749 0.98123 

RCM RATIO TDOM TONKM     66 1 0.9989  0 0.99161 0.99754 0.98406 

RCM RATIO TOT VHKM       66 1 0.99952  0 0.99387 0.99749 0.98125 

RCM RATIO TOT TONKM      66 1 0.99943  0 0.99534 0.99754 0.98408 

RCM TF RATIO             66 1 1  1 1.1 1.1 1.1 

RCM TF ELAS VHkm TDOM    66 0 -0.00099  -1 -0.1002 -0.09319 -0.10797 

RCM TF ELAS Tonkm TDOM   66 0 -0.0011  -1 -0.09854 -0.09315 -0.1054 

RCM TF ELAS VHkm TOT     66 0 -0.00048  -1 -0.09648 -0.09319 -0.10796 

RCM TF ELAS Tonkm TOT    66 0 -0.00057  -1 -0.09515 -0.09315 -0.10539 

7.12.7. Elasticity formulation 

The elasticity formulation refers to the approach outlined in UK TAG Unit 2.1 Variable Demand 

Modelling [11]8 and has the form of: 

𝑒 =
log(𝑇1) − log(𝑇0)

𝑙𝑜𝑔(𝐶1) − log(𝐶0)
=
log (

𝑇1
𝑇0)

log (
𝐶1
𝐶0)

 

Where: 

o T1 and T0 are respective values of tonkm, VhclKm, etc in each scenario 

o C1 and C0 the specific costs modified in the two scenarios 

 

7.13. Create Maps 

 
8 Paragraph 6.4.5 pg. 45 
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The Create Maps application generates empty GIS files that follow the same structure as the 

GIS files generated by the Samgods Model application (see Section 7.5.4). These files can be 

used to visualise results from previous runs that are not included in the users’ current setup.  

 

After running the Create Maps application, the following empty GIS networks are generated: 

• Report Tons per commodity groups and total (Ktons): GIS network with Ktons per 

commodity group and totals. For its visualization under Report\GIS maps is present a 

standard map (GIS map with Ktons by Commodity group). 

• Report Loaded and empty vehicles per commodity groups and total (Vhcl): GIS network 

with Loaded Vhcl per commodity group and totals, plus empty totals. For its 

visualization under Report\GIS maps is present a standard map (GIS map with vhcl by 

Commodity group). 



Description of the applications – General instructions 

 

92 

 

8. General instructions 

This chapter gives instructions on how to start using the Samgods GUI. Please note that the 

procedure is described for Standard or Advanced user modes as the available parameter 

settings differ when Developer mode is used.  

8.1. Open the model 

• Open Cube by clicking on the icon on the desktop9 

• On the Welcome Screen select “Open catalog” 

• Browse to Samgods catalogue (file name: Samgods.cat – default folder C:\Samgods) 

• Click on “Open” 

8.2. Set the model to Standard user or Advanced user mode 

• Select “Properties” on the menu bar under section “Scenario” (see Figure 45) 

• In the “Catalog Properties” window, select the “Model User” tab (see Figure 46) 

• In “Model user" select the "Model Applier" mode 

• In "Current Applier Group" select among "Developer", "Standard User" or "Advanced 

User" 

 

Figure 45 How to access “Catalog Properties” 

 

 

 
9 Alternatively, double click on the Samgods catalog file. 
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Figure 46 How to set the Model Applier to Standard User mode 

 

Figure 47 How to save catalogue file using icon 

Tip: Each time changes have been made to the catalogue, such as creating a new scenario, 

creating new output data by running the model or deleting data, the catalogue must be saved. 

This is done by clicking the “save catalog” icon (see Figure 47) or going to “File” menu and 

choosing “Save” -> “Catalog” (see Figure 48). It is recommended to do this often when working 

with the model. 
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Figure 48 How to save the catalogue file using the menu bar 

8.3. General guidelines on how to work with the model 

After opening the model and setting it to Standard User mode, the user can start working with it. 

Instructions for each specific action can be found in Chapter 9. However, it is also necessary to 

know which actions that should be taken and what to look for in the manual. This section 

provides guidelines for the order in which different tasks should be performed. 

Working with the model is done by using the different applications and via the Data Section 

window. In order to use an application for a specific scenario: 

• Double-click on the scenario name in the Scenarios window and select the application in 

the window that opens. 

• When using the Data Section window, select the scenario the user wants to work within 

the Scenarios window by clicking on it and then open the file the user wants to use from 

the Data Section window. 

In order to work with the input data, i.e., to set up a scenario, the input data must be made 

editable. This is done by: 

• Running the Create the editable files application (see Section 8.5 for instructions). This 

must be done even if the user just wants to view the input data and the application must 

be run at least once for each scenario. 

• When the editable data has been created, it can be edited according to the instructions 

in Chapter 9. This is done by using the Edit the data application. Via this application, the 

editable data can be accessed (see Section 8.5 for instructions). An alternative to use 

Edit the data application in order to access the editable data, is to use the Data Section 

window. 

• When all edits to the input data have been made, the edits must be saved before running 

the Samgods Model application. This is done by running the Edit the data application 

(until this point the application has only been used to access the editable data, but it has 

not been run). For a locked scenario, such as the base scenario, no edits can be saved. 

However, the application can still be used to view the data. 
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At this point the Samgods model can be executed, by running the Samgods Model application 

(see Section 8.6). By doing that, the output data is produced and can be compared or exported 

according to the instructions in the following chapters. 

Different sets of output can be produced for different runs for the same scenario. For example, if 

the model runs for two different commodity groups for the Standard Logistics module. In order to 

run the same scenario for different commodities, the user first run the Create the editable files 

application and then Edit the data application as described above (the Edit the data application 

does not have to be run for a locked scenario, such as the Base2019 scenario). Then the user 

selects the commodity group and run the Samgods Model application. After this step, another 

commodity can be selected and the Samgods Model can run again. The different sets of outputs 

will be saved separately. 

In the scenario folder (under Scenario_Tree, see Table 1), the name of the specific output 

database is OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group. In the 

interface, just one set of output for one scenario can be accessible at the time. In order to access 

a specific set of output, double-click on the specific scenario, select the Samgods Model 

application and select the specific commodity group in the catalogue key “Select commodities for 

the Logistics Module (…)”. Click “Save” (not “Run”). In this way the correct set of output is 

activated and can be accessed from the Data Section window. The scenario selected under 

scenario window always filter the data shown under data panel. This is a specific characteristic of 

Cube and catalogue file. All the logical relations are maintained in a coherent frame. The 

selection of a particular scenario will specify the values of the catalogue keys, the folder where 

results will be saved, and the data will be shown under data panel. 

Whenever a scenario has been deleted or several runs have been made, the geodatabase files 

should be compressed in order to save disk space – see Section 8.9 for instructions. When 

working with the model and making changes to the catalogue, such as adding a scenario or 

making changes to the geodatabase, it is recommended to regularly save the catalogue. This is 

done by clicking the save button (the black floppy disk icon above the Scenarios window). 

An exception is the output for Rail Capacity Management, since it can be run only with all the 

commodities (X=0) and its results are always produced in 

Output0_{SCENARIO_SHORTNAME}.mdb. 

8.4. Create a new scenario 

To create a new scenario, it is necessary to copy the scenario specific tables from another 

scenario, then merge the scenario specific tables with the base tables and finally visualize them 

in the graphical interface. These are the steps to create a new scenario:  

1) In the first step, create the scenario name in the catalogue: 

a) In the Scenarios window, right-click on “Year_2019” or “Year_2045” and select 

“Add Child”. 

b) Enter the scenario name. The name must not be blank, must not begin with a 

number, and must not begin with the letters n f t. Press “Enter”. 

c) In the Scenario Properties window, which is opened, set a scenario code (or use 

the default one) and click “OK”. It is recommended to use a short code that can 

be associated with the scenario name. 

d) The Scenario manager window opens automatically. 

2) In the second step, run the Create the editable files application as described below: 

a) Select Create the editable files in the Application window. 
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b) Open the scenario that needs to be run by double clicking on it. 

c) Define from which scenario to copy the scenario specific tables from (e.g., 

Base2019) by typing the scenario name in the catalogue key ”Which scenario do 

you want to use? (Default is Base2019)”. 

d) Click “Run”. 

e) At the end of the run, click “OK”. 

The temporary geodatabase is now available in the scenario folder (located in the Scenario_Tree 

folder, see Table 1 in Section 5.5) with all the scenario data. To visualize the tables and the 

layers of the scenario, change the application from Create the editable files to Edit the data in the 

Scenario manager window. In Figure 49 and Figure 38 the default values of the catalogue keys 

are displayed. The first set of catalogue keys (Figure 51) lists the scenario parameters and each 

catalogue key has an editing box (a box where a numerical value or label is expected), a scroll 

down menu, or a check box. 

 

Figure 49 Catalogue keys in first window for Edit the data application 

The second set of catalogue keys (Figure 50), accessed by clicking “”Next…” in the window in 

Figure 49, consists of tables and layers of scenario data. By clicking the “Edit...” button on the 

right, the data is opened in the correct format (i.e., a table in a database window or a layer in a 

GIS window). Descriptions of the keys and of how to use them for editing and displaying the data 

are given in Section 7.4. 
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Figure 50 Catalogue keys in second window for Edit the data application 

 

Figure 51 Catalogue keys in third window for Edit the data application 

 

3) Set the catalogue keys according to the instructions in Section 7.4 and edit the data. For 

instructions on how to edit the scenario data, see Chapter 9. 

4) To save the edits that have been made in the temporary geodatabase, the Edit the data 

application must be run. During this phase the scenario specific tables will be created 

and saved into the main geodatabase. Also, the report file “Report for the edit phase” 

Tip: To visualize all the layers in a map, click the “Edit...” button, next to the ArcMap GIS Project 

File catalogue, key shown in Figure 51 pointing at the file Input_Data.mxd. All the geographical 

data will be loaded with a few default legends. The same file is available via Scenario 

Inputs\Editable Data\ Input_Data.mxd in the Data Section window. 
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with information or errors from running the Edit the data application will be created in 

Scenario Outputs\Edit the data Report in the Data Section window. 

a) Click “Run”. 

b) During the execution, the program will prompt with the question: “Do you really 

want to save the scenario {SCENARIO_SHORTNAME}?”. If “No” is selected, the 

temporary geodatabase will be deleted. No changes will then be made to the 

main geodatabase. If “Yes” is selected, the scenario specific tables will be saved 

into the main geodatabase. Whether the temporary geodatabase is deleted or 

not depends on the choice made for the catalogue key “Do you want delete the 

temporary geodatabase?”. 

c) At the end of the run, click “OK”. 

d) Close the Scenario Manager window. To the question “Do you want to create the 

scenario {SCENARIO_SHORTNAME}?”, click “Yes”. 

When changes have been made to the catalogue, such as adding a new scenario, the catalogue 

file should be saved. This is done by clicking the black floppy disk icon to the left above the 

catalogue in the interface.

8.5. Visualize and/or edit an existing scenario 

In terms of the general structure and terminology of the Samgods GUI, an existing scenario 

means that the scenario specific tables are already included in the main geodatabase. To 

visualize the data, the scenario-specific tables must be merged with the base scenario tables, 

and the appropriate layer (or feature class) for the data that is graphically represented in a map 

needs to be created. A layer can be described as the visual representation of a geographic 

dataset in any digital map environment. More information on the layers is given in Section 10. It 

has been presented how the applications Create the editable files and Edit the data work 

together to guarantee consistence and coherence in the input data (see Sections 7.3 and 7.4). 

Please note that it is not allowed to rename a scenario, due to the way input and output data are 

handled in the model. 

There are two possible statuses of a scenario (see Section 7.4 for further explanation): 

• The scenario is still editable (the key “Do you want to lock the scenario from further 

editing?” in Edit the data was set to “No” when Edit the data was run and the scenario 

was saved). 

• The scenario is locked, either because it is the base scenario or because the user has 

locked it (the key “Do you want to lock the scenario from further editing?” was set to 

“Yes” when the scenario was saved by the Edit the data application). 

Editable Scenario 

To visualize and edit an existing scenario, two steps must be performed.  

 
10 The information is also available in the text file REPORT_ED_{SCENARIO_CODE}.txt located in the folder of the 
actual scenario. 

Tip: Information on errors or results from running the Edit the data application are available in 

Scenario Outputs\Edit the data Report\Report10 for the edit phase in the Data Section 

window. For information on this and other log reports, please refer to Chapter 11. It is 

recommended to consult the reports to make sure no errors have occurred in the input data. 
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First, the Create the editable files application should be run: 

1) Select Create the editable files in the Application window. 

2) Double-click on the scenario name in the Scenarios window. 

3) Click “Run”. 

4) Click “OK” at the end of the run. 

After the run, the temporary geodatabase is available in the scenario folder (located in the 

Scenario_Tree folder, see Table 1 in Section 5.5) containing all scenario data. To visualize the 

tables and the layers of the scenario, switch the application from Create the editable files to Edit 

the data in the Application scroll down menu in the Scenario manager window.  

The first set of catalogue keys (Figure 49) lists the scenario parameters. Each catalogue key has 

an editing box (where a numerical value or label is expected), a scroll down menu, or a check 

box. The second set of catalogue keys (Figure 50) accessed by clicking “Next…” in the window 

in Figure 49 consists of tables and layers of scenario data. By clicking the “Edit...” button on the 

right, the data is opened in the correct format (i.e., a table in a database window or a layer in a 

GIS window). Another way to access the data is to use the Data Section window, where the 

scenario data can be found in the folder Scenario Inputs\Editable data. 

 

The second step to edit an existing scenario is to save the scenario data into the main 

geodatabase. This is done by running the Edit the data application. During this phase, the 

scenario specific tables are created and saved into the main geodatabase. Also, the report file 

“Report for the edit phase” is created in the folder Scenario Outputs\Edit the data, which is found 

in the Data Section window. 

5) If the scenario should remain editable, select “No” in the first catalogue key (see first 

group of catalogue keys; Figure 49). In order to lock the scenario, select “Yes. 

6) Select whether the temporary geodatabase should be deleted (or not) in the scenario 

folder. 

7) Make any edits in the scenario data (see Chapter 9 for instructions). 

8) Click “Run”. 

During the execution, the program will prompt with the question: “Do you really want to save the 

scenario {SCENARIO_SHORTNAME}?”. If “No” is selected, the temporary geodatabase will be 

deleted. No edits will then be saved into the main geodatabase. If “Yes” is selected, the scenario 

specific tables will be saved into the main geodatabase. Whether the temporary geodatabase is 

deleted or not depends on the choice made for the catalogue key “Do you want delete the 

temporary geodatabase?”. 

9) At the end of the run, click “OK” and close the Scenario Manager window.  

 

Tip: To visualize all the layers in a map, use the first catalogue key (“ArcMap GIS Project 

File”) shown in Figure 51, pointing at the Input_Data.mxd file. Click the “Edit…” button and all 

the geographical data will be loaded with only a few default legends. The same file is also 

available via the Data Section window, in Scenario Inputs\Editable Data\Input_Data.mxd. 

Tip: In the log report in Scenario Outputs\Edit the data Report\Report for the edit phase in the 

Data Section window, information is given on any errors or on the results of the process during 

the execution of the Edit the data application. This report also includes inconsistences, that 

might exist, with the calibration parameters listed in the separate calibration databases. 
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Locked Scenario 

For a locked scenario, the first step (i.e., running the Create the editable files application and 

visualizing the data using the Edit the data application) is the same as for an editable scenario. It 

is sufficient to run the Create the editable files application once and leave the temporary 

geodatabase in the scenario folder, so that it is accessible each time the user wants to display 

the input data. It is only necessary to run the Edit the data application if the temporary 

geodatabase should be deleted. 

8.6. Run the Samgods model 

The different ways to run the Samgods model are described in Sections 7.5 and Section 10. The 

following paragraph describes the procedure to run the Samgods model as a Standard user. 

Please note that it is required to run the applications Create the editable files and Edit the data 

before running the Samgods model, otherwise the error message ReturnCode=2 will be 

displayed. Please refer to Section 7.5 for an explanation regarding the aforementioned 

applications, as preparation to the run of the Samgods model. The next steps are: 

1) Select the Samgods Model application in the Application window. 

2) Open the scenario that needs to be run by double clicking on it in the Scenarios window. 

3) Make sure that the correct calibration database11 is selected and that the number of 

zones/terminals are consistent with the input network. The number of zone/terminals as 

a value should be modified in Edit the data. 

4) Under “Run Selections”, make appropriate selections for the keys below:  

a) “Run only one step, or run all steps”; choices: All (full run), LOS Calculation, 

Logistics Module, Assignment, Reports, Standard LogMod, Rail Capacity 

Management. 

b) "Year of PWC matrices", choices: 2019, 2045 or any user-defined set of 

matrices. 

c) “Select the mode for the LOS Calculation and Assignment steps”; choices: All, 

Road, Rail, Sea, Air (Choice available only for LOS Calculation, Assignment, 

Reports). 

d) “Select commodities for the Logistics Module”; choices: 0 for all the commodities 

or the commodity number for a specific commodity (1-16) (Choice available only 

for Logistics Module, Assignment, Reports). 

5) Under “Other options”, make appropriate selections for the keys below: 

a) For the key “Do you want to produce buildchainxx.log files?”, choose whether to 

produce the log files from the Buildchain program, containing any warnings from 

the execution. 

b) Select if exogenous consolidation rates will be used. Tick the box and add the 

path in the next catalogue key. The default setting is to not choose exogenous 

consolidation rates (especially in the run of base scenarios, Base2019 and 

 
11 Base2019 for all scenarios related to year 2019 and MainSc2045 for scenarios related to year 2045. 

For information on this, while also other log reports, please see chapter 11. It is recommended 

to the user to consult these reports in order to make sure no input data errors have occurred. 
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MainSc2045). Trafikverket’s instruction is to use exogenous consolidation rates 

(inherited from the reference scenario) when running analysis/investigations. 

6) Under “Logistics Module settings – advanced”, make appropriate selections for the keys 

below: 

a) “Do you want to run the Logistics Module on several processors?”; tick “Yes” or 

“No”. 

b) “How many processors would you like to run simultaneously?”; indicate 1-16 

processors. 

7) Under “Rail Capacity Management – settings”, make appropriate selections for the keys 

below: 

a) “Cut off criteria for RCM process (will consider links with capacity utilisation > 

XX% where XX is the value defined)". In setting up the linear programming 

problem all links with capacity utilisation equal to or above this threshold will be 

enter in the problem. 

b) “Options to save output files from RCM process:”, each LP produces a full set of 

files (see [3]) that could be saved in specific folders under LogMod. This 

catalogue key will control the option to save all the performed loops, or just the 

last one. 

c) "Maximum number of loops for Linear Programming process (LP)": number of 

LP loops the user would like to perform. Provide an integer value between 0 and 

9. 0 will perform only LP0. The LogMod process will produce the best solutions 

and the suboptimal solutions (in terms of transport chains), the number of 

suboptimal solutions is controlled by the catalogue key " Number of transport 

chain solutions for the Logistics Module". It is recommended to not change these 

the default settings. 

8) Click “Run”. 

9) A message window appears that informs whether the scenario is locked or still editable –

click “OK”. 

10) A message window appears with working on Java installation if the path is wrong. 

Process will terminate and user needs to revise “Location of Java folder:” catalogue key 

accordingly to settings on the computer. Example of pop-up message window is in 

Figure 52. 

11) At the end of the run, the message window ”Task Run Result” indicates that “VOYAGER 

Run of Samgods Model application, 01 is complete” (or a corresponding message for the 

Emme user). Click “OK”. 

Tip: The run time for the Samgods Model application varies depending on the selected 

options. If a full run with all commodities and modes is selected together the RCM, it may be 

proper to use multiple processors to reduce the run time.  

In the current model version, the program used to solve the Linear Programming Problem 

can use only a single processor. Therefore, this is the only part that will not have any 

benefit, by the use of multiple processors.  
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8.7. Compare scenarios 

The comparison of scenarios’ outputs is always made between the current selected scenario and 

an alternative scenario. The comparison encompasses the following results, in the form of 

differences in: 

1. LOS matrices (dist, ddist, time and extracost) for all modes and vehicle types. 

2. OD tonnes, empty and loaded vehicles for all modes and vehicle types for STD. 

3. Tonne flows per mode rail, road and sea for STD and RCM. 

4. Vehicle flows in terms per mode rail, road and sea for STD and RCM. 

5. Tonne flows per commodity group for RCM. 

 

The Samgods Model application must be run for the specific commodity for both the current 

scenario and the scenario selected for comparison before it is possible to compare the outputs. 

To run the Compare Scenarios application, do the following: 

Figure 52 Warning message on Java installation 

 

Tip: Each time changes have been made to the catalogue, such as creating a new 

scenario, creating new output data by running the model or deleting data, the catalogue 

should be saved. This is done by clicking the save icon (the black floppy disk above the 

Scenarios window). It is recommended to do this often when working with the model. 
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1) Select the Compare Scenarios application in the Applications window. 

2) In the Scenarios window, open the current scenario that the user wants to use by double 

clicking on it. 

3) Select the commodity class that the user wants to compare. It is mandatory to select a 

commodity class (0 for all commodities or the commodity number (1-16) for a specific 

commodity). 

4) Select what the user wants to compare. The alternatives are LOS matrices, Logistics 

Module, Assignment or all of them. 

5) Update "Scenario's name to use in comparison (ex. Test19)" catalogue key with the 

name the user wants to use in the comparison against the current scenario. 

6) Update "Scenario folder for comparison (ex. 

C:\Samgods\Scenario_tree\Year_2019\Test19\" catalogue key which gives information 

of the folder and the geodatabase name containing the scenario the user wants to 

compare. 

7) Click “Run”. At the end of the run, click “OK”. 

The results from the comparison between scenarios are saved in their corresponding scenario 

folders, with the commodity class number indicated in the file name. The .MAT files for the OD 

matrices from the Logistics Module and LOS matrices will be saved directly in the scenario 

folder, while the networks from the Assignment step will be saved inside the output 

geodatabases. All output can be visualised from the Data section window, in Scenario 

Outputs\Compare (Table 54). An example of values for the different catalogue keys is shown in 

Figure 53. 

 

 

Figure 53 Catalogue key values example 

8.8. Delete a scenario 

Deleting a scenario requires two steps in different windows. 

1) First step: Scenario manager window: 

a) Select the Handling scenario in the Applications window 

b) Select the scenario, to be deleted, in the Scenarios window by double click on 

the scenario name. 

c) Select option “(1) DELETE the current scenario tables under Input_data.mdb 

(mandatory if the user wants to delete the scenario)” 

Because of software settings, all catalogue keys must be set. However, the key “For choice 3 or 

4 provide an absolute path to the location of the destination model (ex. 

C:\Samgods_New_version\)” will not be used in this case. A random character could be typed in. 

d) Click “Run”. 
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e) During the execution, a warning window will prompt: ”Do you really want to 

delete the scenario {SCENARIO_SHORTNAME}?”. Selecting “No” means that 

the scenario will not be deleted. If “Yes” is selected, the scenario will be deleted. 

f) At the end of the run, click “OK”. 

g) Close the Scenario manager window by clicking “Close”. 

2) Second step: Scenarios’ window: 

a) Right-click on the scenario name in the Scenarios window and select ”Delete”. 

b) To the question “Ok to delete the data directories for this scenario and its 

children?”, click “Yes”. 

c) Run the Compact function, see Section 8.9 below. 

3) Save the catalogue by clicking on the saving icon (black floppy disk, above the 

Scenarios window). 

 

Please note: If the scenario is in read-only mode (i.e., the scenario is locked), the deletion 

selection will have no effect on the scenario-specific tables. The scenario-specific tables will 

remain in the main geodatabase. 

8.9. Compress the geodatabase files 

The Compact function, under the Handling scenario application, compresses the files and 

deletes all the temporary edits stored in the geodatabase. Data that has been deleted previously 

are permanently deleted when the Compact function is run. This reduces the size of the 

geodatabase and cleans the files that are stored in the geodatabase by only keeping the 

necessary data. Running the Compact function is required every time that a scenario is deleted 

or when several runs have been made, and it will influence: 

• The main geodatabase containing all the input data (i.e., Input_data.mdb). 

• The geodatabase containing all the outputs of a specific scenario in the scenario folder 

(i.e., OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group – 0, 

1-16). 

The choice to compact a specific output geodatabase is only related to the selected scenario. 

However, when the Compact function is employed, the input data (main geodatabase, 

Input_data.mdb) will also be compacted. Run the Compact function in the following way: 

1) Select the Handling scenario in the Applications window. 

2) In the Scenarios window, double click on the scenario needs to compacted or any 

scenario the user wants to compact its input data. 
3) Under the “Handling scenario” catalogue key group, on catalogue key “Select how you 

want to use Handling Scenario application” select “(2) COMPACT the geodatabase files 

(Input_data.mdb, Scenario_data.mdb and Output.mdb)” option. 

4) Because of software settings, all catalogue keys must be set. However, the key “For 

choice 3 or 4 provide an absolute path to the location of the destination model (ex. 

C:\Samgods_New_version\)” will not be used in this case. A random character could be 

typed in. 

5) Click “Run”, at the end of the run, click “OK”. 

 

 Tip: Run the Compact function every time a scenario is removed, or several runs have been 

made, to reduce the amount of data stored in the geodatabase. Just choose any scenario under 

scenario tree. 
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8.10. Export and import a catalogue 

The Scenario Export function can be used to export a catalogue into a new catalogue, including 

a scenario that will be the base scenario in the new catalogue. It can also be used to export a 

single scenario into an existing catalogue – see the next chapter. 

To export the entire catalogue into a new catalogue directory and create a new base scenario, 

the following is required: 

1) Select the Handling scenario in the Applications window. 

2) In the Scenarios window, double click on the scenario that the user wants to use 

as the base scenario in the new catalogue. 
3) Under the “Handling scenario” catalogue key group, on catalogue key “Select 

how you want to use Handling Scenario application” select “(3) EXPORT the 

model in a new folder using the current scenario as Base” option. 

4) To set the value for the catalogue key “For choice 3 or 4 provide an absolute 

path to the location of the destination model (ex. C:\Samgods_New_version\)”, 

type in the destination folder in the editing box (for instance 

C:\Models\Samgods_New_Version\). 

5) To set the value for the catalogue key “For choice 3 or 4 provide the name of the 

base scenario in the destination model”, type in the new name for the current 

scenario, when it has been exported as the base scenario in the new catalogue, 

in the editing box (for instance Base2019Corr). 
6) Click “Run”. 

7) At the end of the run, click “OK”. 

 

Please note: A new folder must be defined for the Scenario export function. If the destination 

catalogue already exists, the user will be informed by a prompt saying, “The model already 

exists”; “This might be an error. The process will be terminated. Check the folder”. In the 

Samgods GUI, it is never possible to overwrite an existing catalogue. 

To complete the export of a catalogue properly, by controlling that the scenario parameters in the 

new catalogue correspond to the imported ones, the Scenario Import function must be run. The 

required actions are: 

1) Close the old catalogue. 

2) Open the new catalogue created during the export. 

3) Update the paths for the applications as described in Section 5.5 and run the Installation 

application (type in the new base scenario name according to the name specified in the 

Scenario Export function in the corresponding catalogue key (please refer to Section 5.5 

for further instructions). 

4) The Scenario_Tree in the Scenarios window in the new catalogue only contains seven 

scenarios, which have the original structure when model is installed. If the new scenario 

requires renaming, please right-clicking on the scenario name and rename it accordingly. 

The code should also be updated, which is done by right-clicking and selecting 

“Properties”. Define a short code that is similar to the scenario name 
5) Under the Handling scenario catalogue key group, on catalogue key “Select how you 

want to use Handling Scenario application” select “(5) CHECK the imported scenario in 

terms of catalog key definitions” option . 
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6) Because of software settings, all catalogue keys must be set. However, the key “For 

choice 3 or 4 provide an absolute path to the location of the destination model (ex. 

C:\Samgods_New_version\)” will not be used in this case. A random character could be 

typed in. 

7) Click “Run”. 

8) At the end of the run, click “OK”. 

9) Check the report in Scenario Outputs\Scenario_Import_function_Report\Report for 

the Import Phase in the Data Section window. 

10) If any scenario parameters need to be changed according to the report, change those 

catalogue key values for the imported scenario, under “Scenario Parameters” in the 

Handling scenario application and run the application again. Check the report again and 

repeat if necessary. 

8.11. Export and import a scenario 

To export a scenario into an existing catalogue already containing a base scenario, the following 

actions are required: 

1) Select the Handling scenario in the Applications window. 

2) In the Scenarios window, double click on the scenario needs to be exported. 
3) Under the Handling scenario catalogue key group, on catalogue key “Select how you 

want to use Handling Scenario application” select (4) EXPORT the current scenario in 

another model” option.  

4) To set the value for the catalogue key “For choice 3 or 4 provide an absolute path to the 

location of the destination model (ex. C:\Samgods_New_version\)”, type in the 

destination folder in the editing box (for instance C:\Models\Samgods_New_Version\) 

5) To set the value for the catalogue key “For choice 3 or 4 provide the name of the base 

scenario in the destination model”, type in the new name for the current scenario, when it 

has been exported as scenario in the new catalogue, in the editing box (for instance 

MainSc2045Corr). 

6) Click “Run”. 

7) At the end of the run, click “OK”. 

 

Please note: The exported scenario will have the same scenario name in the new catalogue 

as in the catalogue from which it was exported. 

 

To complete the export of a scenario properly by controlling that the imported catalogue key 

values correspond to the ones in the new catalogue, the Scenario Import function must be run. 

The required actions are: 

1) Close the catalogue from where the scenario was exported (i.e., the one that is open). 

2) Open the catalogue to where the scenario has been exported. 

Tip: Each time changes have been made to the catalogue, such as, creating a new scenario, 

creating new output data by running the model or deleting data, the catalogue should be 

saved. This is done by clicking the save icon (the black floppy disk above the Scenarios 

window). It is recommended to do this often when working with the model. 
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3) Create a new scenario, with the same name as set in the export phase, in the catalogue 

(right-click on Scenario_Tree in the Scenarios window and select “Add child”, type in the 

name and press Enter. Define the scenario code and click “OK”). 
4) Under the Handling scenario catalogue key group, on catalogue key “Select how you 

want to use Handling Scenario application” select “(5) CHECK the imported scenario in 

terms of catalogue key definitions” option.  

5) Because of software settings, all catalogue keys must be set. However, the key “For 

choice 3 or 4 provide an absolute path to the location of the destination model (ex. 

C:\Samgods_New_version\)” will not be used in this case. A random character could be 

typed in. 

6) Click “Run”. 

7) At the end of the run, click “OK”. 

8) Control the report Scenario Outputs\Scenario_Import_function_Report\Report for 

the Import Phase in the Data Section window to see if any edits are necessary. 

9) Change any catalogue key values listed in the report for the imported scenario, under 

“Scenario Parameters” in the Handling scenario application and run the application 

again. Check the report again and repeat if necessary. 

8.12. Produce PWC Matrices in Voyager format 

To produce the PWC matrices in Voyager format, do the following: 

1) Select the PWC_Matrices application in the Applications window. 

2) Double click on a scenario (it does not matter which scenario) in the Scenarios window. 

3) Select the year the user wants to convert in Voyager format among 2019 or 2045 using 

"Year of PWC matrices" catalogue key. 

4) Click ”Run”. 

5) At the end of the run, click “OK”. 

The matrices are now available in the folder 01_Programs\LogMod\Input\PWC\{Year}\VY_F\, 

found in the Samgods folder (see Table 1 in Section 5.5). In order to display the matrices for a 

commodity via the Data Section window, do the following: 

1) Select the Samgods Model application in the Application window and double click on a 

scenario (it does not matter which scenario) in the Scenarios window. 

2) Select a commodity using the catalogue key “Select commodities for the Logistics 

Module (…)”. Only the numbers 1-16 are allowed here (not 0 for all commodities). 

3) Click “Save” to save the settings. 

4) The matrices for the selected commodity are now available in the Data Section window, 

in Scenario Inputs\PWC_Matrices\PWC matrix for commodity.

8.13. Change matrix format 

To export a matrix in CSV or DBF format, or as a table in a geodatabase (GDB format): 

Tip: Each time changes have been made to the catalogue, such as creating a new scenario, 

creating new output data by running the model or deleting data, the catalogue should be 

saved. This is done by clicking the save icon (the black floppy disk above the Scenarios 

window). It is recommended to do this often when working with the model. 
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1) In the Scenarios window, double click on the scenario corresponding to the matrix needs 

to be exported. 

2) In the Scenario manager window, select the Change matrix format application and make 

appropriate selections for the desired matrix. 

3) Click “Run”. 

4) At the end of the run, click “OK”. 

The output is found in the scenario folder with a CSV or DBF extension or as a table inside a 

geodatabase, depending on the selections made. 

8.14. Visualize the outputs 

In the Data Section window, the results that are produced in all steps are available. Please refer 

to Section 6.3 for details. 

8.15. General information on the GIS Window 

The ArcMap GIS Project file (Input_data.mxd) is opened from the Data Section window by 

opening the folder Scenario Inputs\Editable data and double-clicking on the Input_Data.mxd file. 

The .mxd file can also be visualised from the Edit the data application, by opening the scenario, 

clicking the “Next…” button to reach the second set of catalogue keys and finally clicking the 

“Edit…” button for the ArcMap GIS Project File key. The map document (.mxd) contains the 

following information: 

1) Details of all input data that can be visualised in a map (data with [Geodata] label) with 

the following layers (where the default values are indicated in parenthesis): 

a) Frequency_network (i.e., frequencies of services between terminals, for more 

information on this network, see the appendix section 14.3). 

b) Nodes_commodities (i.e., which commodities that can be handled at the 

terminals). 

c) Nodes. 

d) Ports_swe. 

e) Network – Link and Node layer. 

f) Samgods_zones. 

A set of default legends () for the node and the link attributes for the layers: 

a) Nodes_commodities: Type of terminal.  

b) Nodes: Type of terminal.  

c) Ports_swe: Swedish Ports.  

d) Network:  

a. Network_Node: Terminal type (shown in Figure 54).  

i. Node type – Road.  

ii. Node type – Rail.  

iii. Node type – Sea.  

iv. Node type – Ferry.  

v. Node type – Air. 

b. Network_Link: Modes. 
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e) Samgods zones. 

 

 

 

Figure 54 Enable the layer and select the set of legends as in the figure. Example of default legends, for 

the Network_Node layer 

 

 

Figure 55 Table of contents (TOC) 

 

2) For the network node and link layers, a set of filter conditions to switch on/off specific 

modes are also available. To enable/disable the filters, right-click on the node/link layer 

in the Table Of Content (TOC) and select “Properties”. In the scroll down menu 

Click here to enable/disable legends 

Table of contents 



 

110 

 

“Selection Group”, select the desired group and then tick the “Active” check box to 

activate the option. The filters are by default set as in the last session, which means that 

a filter can be active even if no check boxes are ticked. To be sure to turn all filters off, 

tick and then un-tick an “Active” check box. The available groups for the network node 

layer are:  

a) Road Network. 

b) Rail Network. 

c) Sea Network. 

d) Ferry Network. 

e) Air Network. 

f) Zones. 

The same groups are available for the link layer, except the last one. The advantages of enabling 

a filter are the possibilities to: 

• Visualise only the selected entities. 

• Select and edit only the visualised entities (and thereby avoid selecting the 

wrong links). 

The best way of using these filters is in conjunction with the default legends: First activate the 

desired filter(s) for the layer(s) the user wants to work with and then enable and/or edit the 

corresponding set(s) of default legends using the icons shown in Figure 54. The layers ticked in 

the TOC in Figure 55. These are the ones that are visualised in the GIS window. A layer is 

selected by clicking on it in the TOC. By selecting “Datasets -> Set Selectable Layers” it is 

possible to set which layers that allow selecting elements. E.g., if the Samgods_zones layer is 

selected in the TOC but not set as selectable, the zones are shown in the GIS map but cannot 

be selected with the Select features tool (see below). The default is that all layers are selectable. 

When editing the GIS data, the layer containing the data that is edited must be selected in the 

“Layers” drop down menu in the Editor toolbar (see below).  

Each layer has an attribute table, which is accessed by right-clicking on the specific layer in the 

TOC. In the attribute table it is possible to view the attributes of each layer, but not to edit any 

values. Any edits must be made in the Feature Explorer window (or using the Compute function) 

and in Edit mode (see below for explanations). 

More information on the GIS window can be found in the help section, accessed from the main 

toolbar: Help -> Cube Help -> Cube Base -> GIS Window. 

Tools in the GIS window 

To select/edit/modify the layers, the following tools are available from the interface: 

• Select elements, (fixed) zoom in/out in the map, pan, full extent, refresh view, select 

features, see Figure 56. 

 

Figure 56 Tool in GIS window 

• Select/view elements via SQL queries based on the attributes in the layers: On the menu 

bar, select Datasets -> Select by Attributes… and type an SQL syntax, for example all 

railway nodes in the Stockholm region, in a node layer, see Figure 57. 
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Figure 57 Select/view elements via SQL 

• The Editor toolbar, which is used when editing the network, see Figure 58. 

 

Figure 58 Editor toolbar 

• Add/remove attributes in the layer’s table (node or link table) by selecting Node (or Link) 

-> Attribute -> Add/Delete on the menu bar; 

• Visualize the attributes for a specific selected element – after an element has been 

selected using the “Select Features” tool (see first bullet above), the attributes will be 

displayed in the Feature Explorer window, see Figure 59. In the Edit mode, it is also 

possible to edit and save the new values directly in the Feature Explorer window. To 

change to Edit mode, click on Editor -> Start Editing on the Editor toolbar. 

 

Figure 59 Feature Explorer window 

• Modify values based on a condition. Under Link or Node (depends on the type of layer) 

on the menu bar, the “Compute” option is available when the session is in Edit mode. By 

selecting “Compute”, access is given to the Feature Class Attribute Calculation window, 

shown in Figure 60. In this window, it is possible to edit the values and apply a condition 

(in the example in Figure 60, the capacities for all ports in the Lysekil region are updated, 

more details on this specific example can be found in Section 9.6).  
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Figure 60 The Feature Class Attribute Calculation window 

Specific elements of the link and node layers can be selected via their attributes For the node 

layer the user can use the following attributes: 

• ID_COUNTRY. 

• ID_REGION (primary key if used in combination with ID_COUNTRY). A list of the 

country and region codes can be found in the Data Section window, under Scenario 

Inputs\General tables\Zoning System. 

• MODE_N (1 – Road terminal, 2 – Rail terminal, 3 – Port, 4 – Ferry terminal, 5 – Airport). 
For example, to select all the nodes in a region, the user only needs to select the layer in the 

TOC and then specify the ID_REGION attribute using Select -> Select by attribute… on the main 

toolbar in Figure 61. 
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Figure 61 Select by attribute tool 

To view all available attributes, right-click in the blank field in the Select Specification window.  

For the network link layer, the attribute corresponding to MODE_N is MODE_L. To select all the 

links in a region, do the following: 

1) Select the desired region in the map using the Select Features tool (as a suggestion, the 

Samgods_zones layer should be ticked in the TOC so that the regions are visible). 

2) Activate the layer where the user wants to select elements, in this case the 

“Network_Link” layer, by clicking on it in the TOC. 

3) On the menu bar, Select -> Select by Location… 

4) In the Select by Location window, set the values indicated in Figure 62. 

5) Click “Apply”, and then “Cancel” when all specifications have been made. 

 

 

Figure 62 The Select by Location tool 
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9.  Scenario setup 

This chapter describes how to use the Samgods GUI in Voyager Standard user mode. The 

described parameter settings are visible in Standard user mode. In Developer mode all 

catalogue can be set, while in Advance mode some additional catalogue keys are available, but 

not all those available in Developer mode.  

After edits have been made to the scenario according to the instructions below, the changes 

must be saved to the main geodatabase before running the model. This should be done 

according to the instructions in Section 8.5, i.e., by running the Edit the data application. 

For instructions on how to use the GIS window, layers, filters and legends, see Chapter 8. 

9.1. Import EMME network 

An option to make edits on the network in Emme environment is available in the GUI interface. In 

this paragraph the actions that must be performed are outlined and general suggestions on how 

to avoid inconsistencies in the model are provided. 

In order to import an Emme network together with the speed definition for links, do the following: 

1) Select Edit the data in the Application window and double click on scenario under 

Scenario Window. 

2) Set the values for the following catalogue keys, see Figure 63. 

a) Change "Select from which interface you want to import your edits:" to "EMME 

(importing Emme network and speed table). 

b) Specify the location for Emme network using "Use Emme network file:" catalogue 

key. The file must have *.211 extension to be recognized by the system. 

c) Specify the location for link speed file using "Use Emme speed table:" catalogue key. 

The file must have *.DAT extension to be recognized by the system. 

d) From Emme network *.211 identify the number of zones present in the table (see 

below for details on this) and set the catalogue key "Number of zones in network 

(see value in scenario network):" to that value. 

3) Click on "Run". 

The main elements in this import are the number of zones and the file structure for the Emme 

network and the speed link table.  

Figure 63 Catalogue keys to import Emme network 
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The Emme network in *.211 has two distinct parts, “t nodes init” and “t links init”. The records 

between those two strings represent the node table. An example has shown in Figure 64. 

The values present in each record have a similar meaning to the attributes present in a Voyager 

network: 

• a: just a label used in Emme program, not relevant for the system. 

• *: if present the record refers to a zone, if not present it is a regular node. 

• 711400: Emme number. 

• 1620.00: x coordinate. 

• 6601.00: y coordinate. 

• 1: ID_COUNTRY. 

• 114: ID_REGION. 

• 0: MODE_N. 

• 0000 : user field not relevant for the model. 

During the import, the ID_COUNTRY, ID_REGION, and MODE_N attributes will be verified for 

consistency with the base scenario. If one or all of the above attributes is missing, the errors will 

be listed in report file {SCENARIO_DIR}\REPORT_ED_{SCENARIO_CODE}.TXT (see Chapter 

11 for list of messages and possible actions). The errors must be corrected in the *.211 and the 

process must be rerun until no messages will be displayed in the report.  

To identify the maximum number of zones in the Emme network browse along the node table 

until a first record without "*" in the second position has identified. For example, see Figure 65. 

Since the text window in Cube gives the row number (number on the left-hand side, with grey 

colour), the number of zones will be simply identified as the difference of the current row number 

and 5 (first record in the table containing a node record) plus 1. In the example 1381-5+1 =1377. 

This is the value that must be provided to the catalogue key "Number of zones in network (see 

value in scenario network)". 

The system will not perform checks on the link table, but it will perform checks on consistency 

with the node table. Therefore, before using the network in Samgods the categories associated 

to the links must be checked and errors should be corrected. The CATEGORY attribute (the 6th 

field in the Emme link table, denotes link type) must be consistent to the list of allowed categories 

in A_LinkGategories. 

Figure 64 Example of node table 

Figure 65 Example of last zone in node table 
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The UL3 attribute (user link data number 3) in the link table (the 11th field in the Emme link table) 

has been used to specify a capacity constraint for sea mode. Therefore, those sea links for which 

the user wants to apply a constraint, a number must be coded.  

The UL2 attribute (user link data number 2 – 10th field in the Emme link table) is no longer 

required. Originally, it stored distance information, but this has been replaced by the DIST 

attribute (the 4th field in the Emme link table). The DIST attribute supports a maximum precision 

of three decimal digits. Any additional decimals will not be imported into the Cube interface. The 

same rule is applied when exporting the network from Voyager format to Emme: only up to three 

decimals digits are exported in the DIST field. 

It is worth noting that the nodes and links are not sorted in the standard Emme output order from 

a Cube/Voyager export. 

9.1.1. Edit EMME network after importing in GIS Network window 

When the run of Edit the data application, with the provided EMME files, the tables under 

Scenario_Data.mdb and Input_Data.mdb are updated accordingly. The network under 

Scenario_Data.mdb is not used within the import process and keeps the original definition from 

the parent scenario. 

To edit the revised EMME network the following steps are required: 

1) Select Create the editable files application and double click on scenario under Scenario 

Window. 

2) Click on "Run". 

3) When the run finishes the Input_data.mxd and the network under Scenario_Data.mdb is 

updated to Emme network. 

4) Proceed with edits in Cube GIS window. 

5) When made the intended changes, select Edit the data application and double click on 

scenario under Scenario Window. 

6) Amend the catalogue key in the following manner. 

7) Set the values for the following catalogue keys in Figure 54.  

8) Change "Select from which interface you want to import your edits:" to "GIS Window 

(Use input files constructed by the Cube GUI)” (as seen in Figure 66).  

9) Click on "Run". 

9.2. Introducing a link-based cost 

There are different ways to add taxes, tolls and extra costs to one or several links. All these costs 

are added for each vehicle class, separately. Six attributes with different purposes are defined: 

• Extra fixed cost per link or set of links (SEK). 

• Extra kilometres-based cost per link or set of links (SEK/km). 

Figure 66 Catalogue keys to edit after import of Emme network 
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• Country tax: kilometres-based tax per country (SEK/km). 

• Link class tax: fixed tax per link, per link category (SEK). 

• Link tax: fixed tax per link (SEK). 

• Toll for bridges, fixed tax per link (SEK). 

The following paragraphs describe how to edit each of these attributes. The three types of taxes 

(country tax, link class tax and link tax) are combined in a way that only one of them can be 

applied to a specific link at once. The taxation priorities are as follows: 

COUNTRY TAX < LINK CLASS TAX < LINK TAX 

The way the different taxes are prioritized is described in detail below. The toll for bridges is 

added to the tax on the link. It can also be applied to road and rail links that are not defined as 

bridges. All these four attributes (the three taxes together with the toll for bridges) are edited via 

data tables. 

Then there are the two extra cost attributes. They can represent any fee, tax or other cost, and 

are added to any other taxes or tolls for the links where they are defined. They are edited via a 

GIS layer. 

9.2.1.  Extra cost on a specific link or set of links 

In order to add a specific cost to a specific link in the network for a specific vehicle class, do the 

following: 

1) Open the GIS file (Input_Data.mxd), in one of the two possible ways: 

a) Open the Scenario manager window by double clicking on the scenario name in the 

Scenarios window. In the Scenario manager window, select the Edit the data 

application. Click the “Next…” button and then “Edit…” for the catalogue key 

“ArcMap GIS Project File”. 

b) Select the scenario by clicking on it in the Scenarios window and open the file from 

the Data Section window, under Scenario Inputs\Editable data\Input_Data.mxd. 

2) Select the Network_Link Layer in the TOC window. 

3) On the menu bar, select Link -> Attribute -> Add. 

4) In the first popup window, enter the name for the new attribute by considering the 

following: 

a) If the user wants to add an attribute as a fixed cost (independent of distance), the 

label name EC_VXXX, where XXX represents the vehicle type, should be used (in 

the network all the attributes depend on the vehicle type). 

b) If the user wants to add an attribute as a parametric cost depending on the distance, 

the label name EC_KM_VXXX should be used. 

5) In the second popup window, fill in the variable type (numerical (N) or text (T)). 

6) Enter the specification for the next new attribute as in steps 5) and 6). When all attributes 

have been added, continue to step 8). 

7) Leave the attribute name blank (without typing anything) and click “OK”. 

 

Please note: The label names for the two attributes are managed by two catalogue keys in 

the Edit the data application: 

• “Attribute name for the extra cost to a specific link (SEK)” – default: EC_V. 
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• “Attribute name for the extra cost to a specific link (SEK/km)” – default: EC_KM_V. 

To change the defaults the user only needs to type the new label names in these catalogue 

keys. If the defaults are changed, the new label names must be used when setting the 

attributes as described above, the vehicle type code must be placed at the end of the attribute 

name, e.g.  

• COST_KM101. 

• FEES_201. 

So, if the user, for example, wants to use the attribute name “COST_KM101” for vehicle type 

101, the catalogue key should be set to “COST_KM”. 

Examples of wrong definitions (beginning with a number or containing blank entries) are: 

• 105COST. 

• 204 test. 

• 204test. 

Each link in the network will now have the structure displayed in Figure 67 below. The user can 

see this in the Feature Explorer window by selecting a link using the “Select Features” tool. 

 

 

Figure 67 Feature Explorer window. 

8) In the Editor toolbar, select Editor -> Start editing. In the “Layers” drop down menu select 

the “Network_Link” layer. 

• To edit a single link, do the following: 

1) Use the “Select features” tool  to select the specific link. 

2) In the Feature Explorer window, type in the value of the tax or cost in the new 

attribute cell. 

3) Save the edit by clicking the green icon on the top left. 

New attributes for 

extra costs on links 
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4) Close the Feature Explorer window. 

5) In the Editor toolbar select Editor -> Stop Editing. 

6) To the question “Do you want to save your edits?”, click “Yes”. 

7) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, 

the map could be saved, otherwise this is not necessary). 

• To edit a list of links based on attribute conditions, do the following: 

1) Under the main toolbar, select Datasets -> Select by Attributes… 

2) In the Select Specification window, right click in the blank field to see the 

attribute list (note: it only shows attributes from the active layer – to access other 

attributes, select another layer in the TOC), select the attribute for applying the 

condition (in the example in Figure 68, select all the links on mode 5 – air). 

 

Figure 68 The Select Specification window. 

3) Click “Create New Set”. 

4) Select Link -> Compute... in the menu bar to access the Link Attribute 

Calculation window, see Figure 69. 

 

 

Figure 69 The Link Attribute Calculation window. 
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5) Fill in the fields, see Figure 69. To insert edits in the main field in the middle, 

right click and select “Insert”. A window, “Insert Equation”, pops up – right-click in 

the blank field and select the attribute the user wants to edit, e.g., EC_KM_V401 

as in Figure 69, and type in “=” followed by the value. More attributes can be 

edited by repeating the procedure. In the “Applies To:” drop down menu, select 

“Selected items”. 

6) Click ”Apply”. An information window shows the total number of links updated. 

Click “OK” and then “Close”. 

7) Under the Editor toolbar, select Editor -> Stop Editing. 

8) To the question “Do you want to save your edits?”, click “Yes”. 

9) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, 

the map could be saved, otherwise this is not necessary). 

To edit a list of links based on a geographical selection, do the following: 

1) Select the “Samgods_zones” layer in the TOC. 

2) In the main toolbar, select Datasets -> Select by Attributes… 

3) In the Select Specification window, right click in the blank field to see the 

attribute list (note: it only shows attributes from the active layer – to access other 

attributes, select another layer in the TOC), and select the attribute for applying 

the condition (in the example in Figure 70, select the Stockholm region). For a 

list of the region and country codes, open the table Scenario Inputs\General 

tables\Zoning Systems in the Data Section window. 

 

 

Figure 70 The Select Specification window. 

4) Click “Create New Set”. 

5) Select the “Network_link” layer in the TOC. 

6) On the main toolbar, select Datasets -> Select by Location... to access the 

window in Figure 71 where appropriate changes can be done. 
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Figure 71 The Select by Location window. 

7) Click “Apply”. An information window shows the total number of links selected. 

Click “OK” and then close the window by clicking “Cancel”. 

8) Select Link -> Compute on the main toolbar to access the Link Attribute 

Calculation window, see Figure 72. 

 

Figure 72 The Link Attribute Calculation window. 
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9) Fill in the fields. To insert edits in the main field in the middle, right click and 

select “Insert”. A window, “Insert Equation”, pops up – right-click in the blank 

field and select the attribute the user wants to edit, e.g., EC_V101 as in Figure 

72, and type in “=” followed by the value. More attributes can be edited by 

repeating the procedure. In the “Applies To:” drop down menu, select “Selected 

items”. 

10) Click “Apply”. An information window shows the total number of links updated. 

Click “OK” and then “Close”. 

11) On the Editor toolbar, select Editor -> Stop Editing. 

12) To the question “Do you want to save your edits?”, click “Yes”. 

13) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, 

the map could be saved, otherwise this is not necessary). 

9.2.2.  Country tax – kilometre-based 

The user can apply a country tax for road and rail modes, differentiated by vehicle type. For the 

other modes (sea, ferry and air), the tax can only be differentiated between inside and outside of 

Sweden, since the links for these modes are not divided between other countries in the Samgods 

model. To edit the country tax, do the following: 

1) Click the “Edit…“ button for the “Table with tax by country (SEK/km) [Table]” catalogue 

key in the Edit the data application, or open the Scenario Inputs\Editable data\Tax by 

country Table from the Data section window, for the selected scenario. 

2) To modify existing values, just type a new value in the SEK_KM attribute and press 

Enter. 

3) To add a new tax, the user must know the country code (ID_COUNTRY). To access the 

country codes, please refer to the table Scenario Inputs\General tables\Zoning system in 

the Data section window. 

a) Add a new row in the Tax by Country table by clicking the “+” icon. 

b) Type in the country code, the vehicle type and the SEK_KM value (the country name 

is not required). 

4) Close the Tax by Country table by clicking on the X icon in the top right corner and click 

“Yes” to the question, see Figure 73. 

  

Figure 73 Country tax modification 

 

Please note: For sea, ferry and air modes (vehicles class numbers greater than 212) the user 

can only apply two country codes: 

• ID_COUNTRY=1 for Sweden (as above). 
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• ID_COUNTRY=-1 for all countries outside Sweden. 

For road and rail (vehicles class numbers less than 301) if a specific country is not listed in the 

input table, the default value will be derived from the entries with ID_COUNTRY=-1. 

9.2.3.  Link class tax 

The user can apply a tax per link for a specific category of links in the network. This is done in 

the following way: 

1) Click “Edit“ for the “Tax by Category (SEK) [Table]” catalogue key in the Edit the data 

application or open Scenario Inputs\Editable data\Tax by Link class from the Data 

Section window for the specific scenario. 

2) To modify existing values, just type in a new value in the SEK attribute and press Enter. 

3) To add a new tax, the user must know the category (LINKTYPE). To access the category 

codes, open Scenario Inputs\General tables\LinkCategories values from the Data 

section window. 

a) Add a new row in the Tax by Link class table by clicking the “+” icon. 

b) Type in the LINKTYPE value, the vehicle type and the SEK value. 

4) Close the Tax by Link class table by clicking on the “X” icon in the top right corner and 

click “Yes” to the question, see Figure 74. 

  

Figure 74 Link class tax modification 

9.2.4.  Link tax 

The user can apply a tax for a specific link in the network. This is done by following the steps: 

1) Click “Edit…“ for the “Tax by Link (SEK) [Table]” catalogue key in the Edit the data 

application, or open Scenario Inputs\Editable data\Tax by Link from the Data section 

window for the specific scenario. 

2) To modify an existing value, just type in a new value in the SEK attribute and press 

Enter. 

3) To add a new tax, the user must know the start (A) and end (B) node for the link in the 

network. To visualize the network, open the Input_Data.mxd file, e.g., from the Data 

Section window. The A and B node numbers can be accessed e.g., by selecting the link 

with the Select Features tool and looking in the Feature Explorer window. 

a) Add a new row in the Tax by Link table by clicking the “+” icon. 

b) Type in the A and B values (start and end node for the link), the vehicle class 

and the SEK value. In order to have the tax in both directions of the link, the link 

must be added twice, one row for each direction (where the A and B nodes are 

exchanged in the second row). 
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4) Close the Tax by Link table by clicking the “X” icon in the top right corner and click “Yes” 

to the question, see Figure 75. 

 

Figure 75 Link tax modification 

 

Please note: Introducing a link with a zero-tax value for a specific vehicle type has the effect 

that all the extra costs (in term of taxes) are set to zero on that link. The same principle applies 

to the Tax by Link class table regarding the Country tax value. 

The general rule applied in the model follows the prioritised order according to: 

1. TAX_LINK (overrides TAX_LINKCLASS and TAX_COUNTRY). 

2. TAX_LINKCLASS (overrides TAX_COUNTRY). 

3. TAX_COUNTRY. 

If several tax values are assigned to a specific link, e.g., one from the country table, another 

one from the link class table and a third one from the link table, each value will be overwritten 

by the subsequent value in the order above, i.e., the smaller scale always overrides the larger 

(disregarding the actual value of the tax). 

Please observe that this rule does not apply to the Toll bridges table or the extra cost values in 

the network – they are added to any other taxes. 

9.2.5.  Toll bridges 

In the network, there are a few bridges with fixed tolls. The Toll bridges table contains the values 

of the tolls. The user can modify them, or add new bridge tolls, in the following manner: 

1) Click “Edit…“ for the “Toll for bridges (SEK) [Table]” catalogue key in the Edit the data 

application, or open Scenario Inputs\Editable data\Toll bridges from the Data section 

window for the specific scenario. 

2) To modify an existing value, just type in a new value in SEK attribute and press Enter. 

3) To add a new toll, the user must know the start (A) and end (B) node for the link in the 

network. To visualize the network, open the Input_Data.mxd file, e.g., from the Data 

Section window. The A and B node numbers can be accessed e.g., by selecting the link 

with the Select Features tool and looking in the Feature Explorer window. 

a) Add a new row in the Toll bridges table by clicking the “+” icon. 

b) Type in the A and B values (start and end node for the link), the vehicle class 

and the SEK value. In order to have the tax in both directions of the link, the link 

must be added twice, one row for each direction (where the A and B nodes are 

exchanged in the second row). 

4) Close the Toll bridges table by clicking the “X” icon in the top right corner and click “Yes” 

to the question, see Figure 76. 
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Figure 76 Toll bridges modification 

9.3. Change the loading costs and times in terminals 

The costs and times for loading cargo inside the terminals are specified for different types of 

cargo – containers and non-containers by commodity group. 

1) Open the vehicle parameters table by clicking “Edit…” for the “Specific parameters of 

vehicle classes by commodity group [Table]” catalogue key in the Edit the data 

application, or open “Specific Vehicles Parameters (by vhcl class and commodity group)” 

from the Data section window for the specific scenario. 

2) For each vehicle class and commodity group, edit the values for the attributes listed 

below by typing in the new value and the press Enter: 

• load time containers in hours/vehicle (not divided by type of commodity) – attribute 

CONT_LTI. 

• load cost containers in SEK/tonne (not divided by type of commodity) – attribute 

CONT_LCO. 

• load time non containers in hours/vehicle – attribute NC_LTI. 

• load cost non containers in SEK/tonne – attribute NC_LCO. 

• transfer load time containers in hours/vehicle (not divided by type of commodity) – 

attribute CONT_LTI_T. 

• transfer load cost containers in SEK/tonne (not divided by type of commodity) – 

attribute CONT_LCO_T. 

• transfer load time non containers in hours/vehicle – attribute NC_LTIT. 

• transfer load cost non containers in SEK/tonne – attribute NC_LCOT. 

3) Close the table by clicking the “X” icon in the top right corner. 

4) On request, click “Yes” to save the edits. 

9.4. Change vehicle data 

Change vehicle parameters (e.g., cost per km and hour, capacity, etc.) in the Vehicles 

Parameters table in the following way: 

1) Open the Vehicles Parameters table by clicking the “Edit” button on the “General 

parameters of Vehicle classes [Table]” catalogue key using the Edit the data application, 

or open “General Vehicles Parameters (by vhcl class only)” from the Data section 

window for the specific scenario (same table as in Section 9.3). 

2) Edit the values for any attribute(s) by vehicle class. 

3) Close the table by clicking the “X” icon in the top right corner. 

4) On request, click “Yes” to save the edits. 
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The vehicles Parameters table contains also the parameter that governs whether the empty 

vehicle matrices will be produced. For each vehicle class it is possible to set the parameter 

“EMPTY_V” to 1 (i.e., produce empty vehicle matrices) or 0 (i.e., do not produce empty vehicle 

matrices). If the user chooses not to produce the empty vehicle matrices, the matrices will 

instead be filled out with zero values. For more information on the computation of empty 

vehicles, see appendix section.14.2. 

9.5. Change the average value (SEK) of the commodities  

Change the average value (SEK) of the commodities in the following way: 

1) Open the commodity table by clicking on “Edit” on the “Commodity data [Table]” 

catalogue key using the Edit the data application, or open Scenario Inputs\Editable 

data\Cargo Table from the Data section window, for the specific scenario. 

2) Edit the values by commodity class for: VALUE_SEKT (SEK/Tonne). 

3) Close the table by clicking the “X” icon in the top right corner. 

4) On request, click “Yes” to save the edits. 

9.6. Change capacity in ports 

The user can change the values for the following port parameters: 

• MaxDwtCont (maximum deadweight tonnage, container vessel). 

• MaxDwtRoRo (maximum deadweight tonnage, ro/ro vessel). 

• MaxDwtOthe (maximum deadweight tonnage, other vessels). 

This is done in the following way: 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Select the “Nodes” layer in the TOC window and tick the check box, if it is not already 

ticked. 

3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar). 

4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar. 

5) Select the terminal(s) by using the Select Features tool, or by setting a selection 

condition (e.g., rail terminals: MODE_N=2 in Sweden). For instructions on how make a 

selection based on attributes, please refer to Section 8.15. 

6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in 

the middle) and select “Insert” (e.g., MAXDWTRORO=100000, see Figure 77. To see 

the available parameters, right-click in the blank field in the Insert Equation window) and 

select which items the edits should apply to (all or selected). Click “Apply”. When 

finished, click “Close”. 
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Figure 77 The Feature Class Attribute Calculation window under process to change capacity in ports 

7) On the Editor toolbar, select Editor -> Stop Editing. 

8) To the question “Do you want to save your edits?”, click “Yes”. 

9) Close the GIS window by clicking the “X” icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map can be 

saved, otherwise this is not necessary). 

9.7. Change capacity in Trollhätte canal (also denoted Vänern canal) 

The user can change the values for the following port parameters specifically for Vänern canal: 

• MaxDwtCont (maximum deadweight tonnage, container vessel). 

• MaxDwtRoRo (maximum deadweight tonnage, ro/ro vessel). 

• MaxDwtOther (maximum deadweight tonnage, other vessels). 

This is done in the following way: 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Select the “Nodes” layer in the TOC window and tick the check box, if it is not already 

ticked. 

3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar). 

4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar. 

5) Select the terminal(s) by using the Select Features tool, or by setting a selection 

condition (e.g., Varner ports: PORTAREANR=14). For instructions on how make a 

selection based on attributes, please refer to Section 8.15. 

6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in 

the middle) and select “Insert” (e.g., VANERNCAN=4001 (see Figure 78). To see the 

available parameters, right-click in the blank field in the Insert Equation window) and 
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select which items the edits should apply to (selected). Click “Apply”. When finished, 

click “Close”. 

7) On the Editor toolbar, select Editor -> Stop Editing. 

8) To the question “Do you want to save your edits?”, click “Yes”. 

9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map can be 

saved, otherwise this is not necessary). 

Figure 78 The Feature Class Attribute Calculation window under process to change capacity in 

Trollhätte canal 

9.8. Transoceanic impedances for small ports 

The model provides a tool to avoid transhipments between small domestic ports and 

international ports. The nodes table has an attribute called TRANOCEFAC that has a value 10 

for domestic ports. This represents an impedance applied to the movements between the small 

ports and a transoceanic ports. For details on the implementation the user is referred to [4]. To 

modify the set of ports or the default value (10) the following steps can be performed: 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already 

ticked. 

3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar). 

4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar. 

5) Select the terminal(s) by using the Select Features tool, or by setting a selection 

condition (e.g., MODE_N=3&ID_COUNTRY=1 will select all the domestic ports). For 

instructions on how make a selection based on attributes, please refer to Section 8.15. 
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6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in 

the middle) and select “Insert” (e.g., TRANOCEFAC=10, see Figure 79. To see the 

available parameters, right-click in the blank field in the Insert Equation window) and 

select which items the edits should apply to (selected). Click “Apply”. When finished, 

click “Close”.  

7) On the Editor toolbar, select Editor -> Stop Editing. 

8) To the question “Do you want to save your edits?”, click “Yes”. 

9) Close the GIS window by clicking the “X” icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map can be 

saved, otherwise this is not necessary). 

9.9. Close links 

When links need to be closed, they can be retained within the network rather than being 

permanently deleted. It is sufficient to set to 0 all the following attributes: 

• LORRY_40T 

• LORRY_60T 

• LORRY_74T 

• CAR 

• COMBI 

• FEEDER1 

Figure 79 The Feature Class Attribute Calculation window 
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• FEEDER2 

• WAGONLOAD 

• STAX225 

• STAX25 

• STAX30 

• KOMXL 

• SYSXL 

• WGEXL 

• SHIP_SMALL 

• SHIP_LARGE 

• FERRY_ROAD 

• FERRY_RAIL 

• INW 

• PLANE 

9.10. Introduce new infrastructure 

When adding new infrastructure, it is recommended to use the filter function, as described below. 

Then only links and nodes with specific modes and/or categories are shown in the GIS window. 

However, a new link has category = 0. When a new link is created, the attributes, including the 

link category, can be edited directly, as described below. However, if the editing of the link is 

interrupted, e.g., by selecting another element, or closing the Feature Explorer window before 

the edits are finished, the new link can become invisible in the map, because of the activated 

filter. In order to be able to select it again and continue the edits, the filter must be disabled. 

 

The edits made are not always visible at once in the Feature Explorer. In order to see exactly 

which edits that have been made for a selected link, close the Feature Explorer and open it 

again. 

9.10.1. New roads 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Activate the filter for the road mode, both in the network node and the link layers by right-

clicking on the respective layer in the TOC, selecting “Properties” and tick the “Active” check 

box for road mode. 

3) Select the Network_Link layer in the TOC. 

4) Select the node default legend “2:Node type – Road” in the menu accessed by clicking on 

the left downwards-pointing arrow: . 

5) Start an edit session (click Editor -> Start editing). 

6) Select the Network_Link layer in the “Layers” drop down menu. 

 

 



 

131 
  

 

 

 

 

 

 

 

7) Select the pencil icon. 

8) Draw the new link. This is done by clicking where the new link should start and for each new 

click on the map, a new vertex is created. At the end of the link, double-click. 

9) The following window in Figure 80 will appear if a new node is added (i.e., if the link does not 

start and end in existing nodes).  

 

Figure 80 Add new node 

10) Click “Yes” and then select a node value greater than 2000 (values up to 1999 are only for 

terminals and zones), see Figure 81. 

11) Click “OK”. 

 

 

Tip: Instead of specifying the new link from the beginning, as described in this 

paragraph, it is possible to select an existing nearby link, with attributes like the new link, 

and in the Feature Explorer window use the copy function. Click , and then create 

the new link as described below and change only the attributes that differ from the other 

link. In this way, it is easier to avoid making mistakes when specifying the attributes. 

 

Figure 81 The Add New Node window 
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12) In the Feature Explorer window (see Figure 82), can be specified the following attributes. In 

order to assign the same values to both directions (i.e., A to B and B to A), make sure that 

both ways are selected in the Feature Explorer window. 

 

 

a) ALL_M=1 (always equal to 1, which means that it is an open link). 

b) LORRY_40T=1 (1 if open for vehicle types 102, 103 and 104, 0 otherwise). 

c) LORRY_60T=1 (1 if open for vehicle type 105, 0 otherwise). 

d) LORRY_74T=0 (1 if open for vehicle type 106, 0 otherwise). 

e) CAR=1 (1 if open for vehicle type 101, 0 otherwise). 

f) Leave all the other modes as zero. 

g) CATEGORY: type the category number – see available numbers and descriptions in the 

Data Section window, under Scenario Inputs\General tables\Link Categories. 

h) NLANES: number of lanes in each direction. 

i) FUNCTION: speed flow curve – see V101/102 tables in the Data Section window under 

Scenario Input/General tables (values between 1 and 50, 61 only for connectors and 

other modes). 

j) SPEED_1: speed in km per hour for vehicle class 101. 

k) SPEED_2: speed in km per hour for vehicle classes 102, 103, 104, 105 and 106. 

l) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool as 

displayed Figure 83 (note that “Selected items” must be selected in the “Applies To:” 

field). 

Figure 82 Feature explorer window 
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m) MODE_L=1, because it is a road link. 

 

Figure 83 The Link Attribute Calculation window 

 

Please note: It is recommended to round the distance values to limit the number 

of decimal places. 

13) Select in the Feature Explorer window the node or nodes created (they can be found to the 

left of the table of attributes). Answer “Yes” to the question whether the edits should be 

saved. Edit the following attributes: 

a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning system 

feature class. Select the zone, and it will be visualised in the Feature Explorer window 

with the attributes for the zone (this is preferably done before starting to edit the new 

link/node, since selecting the zone will unselect the new link and node). As an 

alternative, the table “Zoning System”, found in Scenario Inputs\General tables in the 

Data Section window, can be consulted. 

b) MODE_N=1 because it is a road node. 

c) All the other attributes will be filled in automatically by the model. 

14) On the Editor toolbar, select Editor -> Stop Editing. 

15) To the question “Do you want to save your edits?”, click “Yes”. 

16) Close the GIS window by clicking the “X” icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map can be 

saved, otherwise this is not necessary). 
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9.10.2. New railroad 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Activate the filter for the rail mode, both in the network node and the link layer by right-

clicking on the respective layer in the TOC, selecting “Properties” and tick the “Active” 

check box for rail mode. 

3) Select the Network_Link layer in the TOC. 

4) Select the node default legend “3:Node type-Rail”, in the menu accessed by clicking the 

left downwards pointing arrow: . 

5) Start an edit session (select Editor -> Start Editing). 

6) In the “Layers” drop down menu, select the Network_Link layer. 

 

 

 

 

 

 

 

7) Select the pencil icon. 

8) Draw the new link. This is done by clicking where the new link should start and for each 

new click on the map, a new vertex is created. At the end of the link, double-click 

9) The window in Figure 84 will appear if a new node is added (i.e., if the link does not start 

and end in existing nodes). 

 

Figure 84 New railroad 

10) Click on “Yes” and then select a node value greater than 2000 (values up to 1999 are 

only for terminals and zones), see Figure 85. 

 

Tip: Instead of specifying the new link from the beginning, as described in this 

paragraph, it is possible to select an existing nearby link, with attributes like the new 

link, and in the Feature Explorer window use the copy function. Click , and then 

create the new link as described below and change only the attributes that differ from 

the other link. In this way, it is easier to avoid making mistakes when specifying the 

attributes. 
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Figure 85 The Add New Node window 

11) Click “OK”. 

12) In the Feature Explorer window, specify the following values. In order to assign the same 

values to both directions (i.e., A to B and B to A), make sure that both ways are selected 

in the Feature Explorer window. 

a) ALL_M=1 (always equal to 1, which means that it is an open link). 

b) COMBI=1 (1 if open for vehicle type 201, 0 otherwise). 

c) FEEDER1=1 & FEEDER2=1 (1 if open for vehicle type 202, 0 otherwise). 

d) STAX225=1 (1 if open for vehicle type 204, 0 otherwise). 

e) STAX25=1 (1 if open for vehicle type 205, 0 otherwise). 

f) STAX30=1 (1 if open for vehicle type 206, 0 otherwise). 

g) WAGONLOAD=1 (1 if open for vehicle type 207,208,209, 0 otherwise). 

h) KOMXL=1 (1 if open for vehicle type 210, 0 otherwise). 

i) SYSXL=1 (1 if open for vehicle type 211, otherwise). 

j) WGEXL=1 (1 if open for vehicle type 212, 0 otherwise). 

k) CATEGORY: type the category number – see available numbers and 

descriptions in the Data Section window, under Scenario Inputs\General 

tables\Link Categories. 

l) NLANES: number of lanes in each direction. 

m) FUNCTION=61 (always this value except for road mode). 

n) SPEED1: Speed in km/h. 

o) SPEED2=0. 

p) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool 

as displayed in Figure 86 (note that “Selected items” must be selected in the 

“Applies To:” field).  

q) MODE_L=2, because it is a rail link. 
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Figure 86 The Link Attribute Calculation window 

 

Please note: it is recommended to round the distance values to limit the number of 

decimal places. 

 

13) Select in the Feature Explorer window the created node or nodes (they can be found to 

the left of the table of attributes). Answer “Yes” to the question whether the edits should 

be saved. Edit the following attributes: 

a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning 

system feature class. Select the zone, and it will be visualised in the Feature 

Explorer window with the attributes for the zone (this is preferably done before 

starting to edit the new link/node, since selecting the zone will unselect the new 

link and node). As an alternative, the table “Zoning System”, found in Scenario 

Inputs\General tables in the Data Section window, can be consulted. 

b) MODE_N=2 because it is a rail node. 

c) All the other attributes will be automatically filled by the model. 

14) On the Editor toolbar, select Editor -> Stop Editing. 

15) To the question “Do you want to save your edits?”, click “Yes”. 

16) Close the GIS window by clicking the “X” icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map can be 

saved, otherwise this is not necessary). 
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9.10.3. New sea, ferry and air links 

New links for sea, ferry and air modes can also be added, in a similar way as for the road and rail 

links. An important exception is about the UL3 link attribute for sea and ferry links. UL3 

represents the maximum vessel capacity allowed on a sea or ferry link. The value coded in this 

attribute will ban vessel types where the capacity of the vessel exceeds the value UL3. The 

vessel capacity is recorded in the general parameters for vehicles (attribute CAPACITY) and it 

will compare with UL3 prior the LOS calculation. Two cases are possible: 

• If UL3 > CAPACITY: the specific vessel type will be able to use the link. 

• if UL3 < CAPACITY the specific vessel type will not use the particular link. 

9.10.4. New terminals 

In the network, terminals are represented as zones12. They are distinguished from 'actual' zones 

(Production, Attraction, or Warehouse points) by their node numbers, which do not end in '00'. 

While actual zones—identified by NORIG numbers ending in '00'—typically serve as trip ends, 

they may also function as terminals in cases of Direct Access. These values are imported directly 

from the Emme network. 

To add a new terminal, different actions are required depending on the mode of the terminal. The 

new terminal needs to be added in three layers: the Network layer, the Nodes_commodities 

layer, and the Nodes layer. 

Road terminal 

Network layer: 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Activate the filter for road mode both in the network node and link layer (please refer to 

Section 8.15 for instructions on how to perform this). 

3) Select the node default legend “2:Node type – road” (see Section 8.15). 

4) Select the Network_Node layer in the TOC. 

5) Start an edit session (on the Editor toolbar, select Editor -> Start Editing). 

6) In the “Layers” drop down menu, select the Network_Node layer. 

7) Select the pencil icon. 

8) Add the new node by clicking on the location and selecting a node number between the 

highest zone number and 2000 (select a number less than 2000 in the range specified in 

the window “Current Unused Numbers”). 

9) Click “OK”. 

10) In the node table in the Feature Explorer window, type in the following information: 

a) ID_COUNTRY and ID_REGION: the values are identified using the zoning 

system feature class. Select the zone, and it will be visualised in the Feature 

Explorer window with the attributes for the zone (this is preferably done before 

 
12 The zone numbering referred to are Swedish zone number system used in Emme networks and in the logistics model. 
For a conversion to Cube/Voyager node number a node-to-node map is required. All zone numbers in Emme format 
starts with node numbers above 700000, whereas all corresponding node numbers in Cube/Voyager are less than 2000. 
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starting to edit the new node, since selecting the zone will unselect the new 

node). As an alternative, the table “Zoning System”, found in Scenario 

Inputs\General tables in the Data Section window, can be consulted. 

b) MODE_N=1, because it is a road terminal. 

11) In order to change the number of zones for the entire network, right-click on the Network 

layer in the TOC and select “Properties”. Change the Highest Zone No. to the number of 

the just added terminal and click “OK”, see Figure 87. 

  

Figure 87 How to change the number of zones for the entire network 

12) Select the Network_Link Layer in the “Layers” drop down menu. To the question whether 

the changes should be saved, answer “Yes”. Use the new node as a starting node, draw 

a link connector from the node to the road network, as described in the New roads 

section above. Then type in the following information in the Feature Explorer window. In 

order to assign the same values to both directions (i.e., A to B and B to A), make sure 

that both ways are selected in the Feature Explorer window: 

a) ALL_M=1 (always equal to 1, which means that it is an open link). 

b) LORRY_40T=1 (1 if open for vehicle types 102, 103 and 104, 0 otherwise). 

c) LORRY_60T=1 (1 if open for vehicle type 105, 0 otherwise). 

d) LORRY_74T=0 (1 if open for vehicle type 106, 0 otherwise). 

e) CAR=1 (1 if open for vehicle type 101, 0 otherwise). 

f) Leave all the other modes as zero. 
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g) CATEGORY=110 or 20113 (see available numbers and descriptions in the Data 

Section window, under Scenario Inputs\General tables\Link Categories); See [5] 

for details about the different link categories used in the model. 

h) NLANES=1. 

i) FUNCTION=61. 

j) SPEED_1=50. 

k) SPEED_2=0. 

l) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool 

as displayed in Figure 88. 

m) MODE_L=1 because it is a road link. 

 

 

Figure 88 The Link Attribute Calculation window 

 

Please note: it is recommended to round the distance values to limit the number of 

decimal places. 

Nodes_commodities layer: 

1) In the “Layers” drop down menu, select the Nodes_commodities layer. Answer “Yes” to 

the question whether to save the changes to the selected feature. 

2) Tick and select the Nodes_commodities layer in the TOC. 

 
13 Only valid link categories for domestic road terminals in Sweden 
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3) Add a new node by clicking in the map and give it exactly the same node number as the 

terminal (it doesn’t matter if it is located in another position; it is only the node number 

that is important). The node number is specified by assigning it to the attribute “N”. 

4) Type in the TRANSF_TYPE value – for a terminal with transfer road to road, 

TRANSF_TYPE=1 (a list of the transfer types is located in the Data section window in 

Scenario Input\General tables\Transfer type of terminal). See [5] for details about 

different transfer types used in the model. 

5) For each commodity, disable (0) or enable (1) transfer at the terminal. 

6) If there is another transfer type (e.g., transfer road-train – for road mode, possible values 

for transfer type are 1 to 6) to edit, add the same node again in the same way as for the 

previous transfer type, by setting the same node number and change all the other values 

for the specific case. 

Nodes layer: 

1) In the “Layers” drop down menu, select the Nodes layer. On request, answer “Yes” to 

save the changes made. 

2) Tick and select the Nodes layer in the TOC. 

3) Add a new node with exactly the same node number as the terminal, in the same 

manner as in the Nodes_commodities layer. 

4) Define the following attributes: 

• If a zone has direct access to the terminal, ZONET=the number of zone. If no zone 

has direct access, define ZONET=0. 

• If a zone belongs to an aggregation group for consolidation set CONAGGR= the 

zone number in which the zone in included. 

• DOMESTIC=1 if the terminal is Swedish, 0 otherwise. 

• Set technology factors C_TECH_FAC and T_TECH_FAC=1. 

5) On the Editor toolbar, select Editor -> Stop Editing. Answer “Yes” to the question(s) 

whether to save the changes made. 

All the three node layers will now have the new terminal. Figure 89 below shows the Feature 

Explorer window for the three layers, displaying terminal attributes. 
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Figure 89 Feature Explorer windows for the Nodes_commodities layer, the Network_Node layer and 

the Nodes layer, all displaying the attributes of the new terminal 

Rail terminal 

The required actions for adding a rail terminal are similar to the ones for a road terminal. The 

attributes, which are specific to the mode, should be set to rail and railway vehicles. The 

attributes that differ from the case of a road terminal are: 

• MODE_N = 2. 

• Possible values for TRANSF_TYPE .See [5] for details about different transfer types 

used in the model. 

• CATEGORY=211 for the rail link connection. See [5] for details about link categories 

used in the model. 

The terminal must have a rail link to connect it to the rail network and a road link to connect it to 

the road network, see Figure 90 (if there is direct access from a zone to the terminal, the road 

connector is not mandatory). Please refer to the instructions on how to add a new road terminal 

and new railroad. 

 

 

 

 

 

 

 

 

 

Nodes_commodities layer 

Network node layer Nodes layer 
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Figure 90 Nodes layer illustration for rail terminal, connected to the rail network by a rail link and to 

the road network by a road link 

Sea terminal 

A new sea terminal is added in the same way as a rail terminal (except for the mode specific 

attributes), except that the Ports_swe layer should be edited, by adding the new terminal to it in a 

similar way as in the Nodes_commodities layer. The attributes necessary to edit in the 

Ports_swe layer are: 

• N = the same number as in the other three layers. 

• MODE_N = 3. 

• The pilot fees for each one of the vehicle types. 

Ferry terminal 

A new ferry terminal is added in the same way as a rail terminal (except for the mode specific 

attributes). 

Air terminal 

A new air terminal is added in the same way as a rail terminal (except for the mode specific 

attributes). 

9.11. Change speed on different links 

To change speeds on individual links, follow these steps to open and edit the scenario data. Note 

that speed management varies by transport mode. 

1) Click “Edit” on the “ArcMap GIS Project File” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario. 

2) Select the Network Link Layer in the TOC. 

3) Start an edit session (Editor -> Start editing). 
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4) Select the Network Link layer in the “Layers” drop down menu on the Editor toolbar. 

5) Make a selection (one or several links) and change the speed values in the Feature 

Explorer window based on the selection made. For each mode, the speed is managed in 

a different way, see below. 

9.11.1. Road Mode 

1) Activate the filter for Road Mode (see Section 8.15 for instructions). 

2) If SPEED_1 and SPEED_2 for a link/links inside Sweden are equal to 0, the default 

values in the general tables will be applied. The default values for the base speed are in 

the delay tables in the Data Section window, Scenario Inputs\General tables\V101/V102 

speed flow curves (V101 – applied to class 101, V102 – applied to classes 102-106). 

3) The SPEED_1 field is defined as km per hour for vehicle class 101. 

4) SPEED_2 defines the speed for all other road vehicle classes (102-106). 

5) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 8.15 for 

instructions). Edit the values directly in the Feature Explorer window or using Link -> 

Compute. 

6) When all edits have been made, select Editor -> Stop Editing on the Editor toolbar. 

7) On the request “Do you want to save your edits?”, click “Yes”. 

8) Close the GIS window by clicking on the “X” icon at the top right corner, without saving 

the ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have 

been made, the map can be saved, otherwise this is not necessary). 

9.11.2. Rail Mode 

1) Activate the filter for Rail Mode see Section 8.15 for instructions). 

2) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 8.15 for 

instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the 

Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used 

for road mode and should be set to 0 for all other modes). 

3) On the Editor toolbar, select Editor -> Stop Editing. 

4) On the request “Do you want to save your edits?”, click “Yes”. 

5) Close the GIS window by clicking on the “X” icon at the top right corner without saving 

the ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have 

been made, the map can be saved, otherwise this is not necessary). 

9.11.3. Sea Mode – enclosed waterways 

1) Activate the filter for Sea Mode (see Section 8.15 for instructions). 

2) Select a link or set of links with CATEGORY=80 or 540, using the Select Features tool or 

Datasets -> Select by attributes… or Select by location… (see Section 8.15 for 

instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the 

Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used 

for road mode and should be set to 0 for all other modes). For the other sea categories, 

the default values in the Vehicles Parameters table are applied (see the next section). 
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3) On the Editor toolbar, select Editor -> Stop Editing. 

4) On the request “Do you want to save your edits?”, click “Yes”. 

5) Close the GIS window by clicking on the “X” icon at the top right corner without saving 

the ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have 

been made, the map can be saved, otherwise this is not necessary). 

9.11.4. Sea Mode – All the other categories 

1) Open the Vehicles Parameters table by clicking “Edit…” for the “General parameters of 

Vehicle Classes [Table]” catalogue key using the Edit the data application or open 

Scenario Inputs\Editable data\Vehicles Parameters from the Data Section window for the 

specific scenario. 

2) Edit the speed values in the SPEED attribute for the vehicle types 301-317. 

3) Close the table by clicking on the “X” icon at the top right corner. 

4) On request, click “Yes” to save the edits. 

9.11.5. Ferry Mode 

1) Activate the filter for Ferry Mode (see Section 8.15 for instructions). 

2) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 8.15 for 

instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the 

Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used 

for road mode and should be set to 0 for all other modes). 

3) On the Editor toolbar, select Editor -> Stop Editing. 

4) On the request “Do you want to save your edits?”, click “Yes”. 

5) Close the GIS window by clicking on the “X” icon at the top right corner without saving 

the ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have 

been made, the map can be saved, otherwise this is not necessary). 

9.11.6. Air Mode 

1) Activate the filter for Air Mode (see Section 8.15 for instructions). 

2) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 8.15 for 

instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the 

Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used 

for road mode and should be set to 0 for all other modes). 

3) On the Editor toolbar, select Editor -> Stop Editing. 

4) On the request “Do you want to save your edits?”, click “Yes”. 

5) Close the GIS window by clicking on the “X” icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, the 

map can be saved, otherwise this is not necessary).

9.12. Speed limits on road network by user class 
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A feature controlling the speed limit for road vehicle classes is available in the model, allowing 

the user to define a maximum allowed speed by road vehicle type.  

To set speed limits: 

1) Select General Vehicles Parameters (by vh class only) under Data Panel. 

2) Under Max_Speed input the maximum allowed speed (km/h) for each road vehicle class 

(from 101 to 106). 

3) Close the table saving the changes (at pop-up window click yes). 

4) Run Edit the data application. 

 

Please note: this feature is implemented only for road mode. Any value entered in 

the other modes (rail, sea and air) will not affect the current speeds coded within the 

network. 

9.13. Edit the capacities for rail links 

The Rail Capacity Management process requires input in terms of the number of trains per day 

allowed on each domestic link (i.e., a link flow capacity). This information is provided via the 

capacity link table. This section describes the steps on how to update this table: 

1) Click “Edit” on the “Table with rail capacity [Table]” catalogue key using the Edit the data 

application, or open Scenario Inputs\Editable data\RailCapacity table from the Data 

section window for the specific scenario. 

2) Sort the table on the attribute ID_LINK clicking on the attribute name. 

3) Browse to the end of the table. 

4) Add a new empty record clicking on the button . 

5) Edit the A and B numbers for the new link in Voyager format. 

6) Edit the ID_LINK value as the first available from the list (e.g., if the last record has 388, 

use 389); Note, gaps in the indexing of ID_LINK list is not allowed. 

7) Edit the ORIGCAP as number of trains per day bidirectionally (e.g., total number of trains 

in both directions). 

8) Add the other direction (B-A) by adding another new empty record clicking on the button 

. 

9) Edit the A and B numbers where A is the B value introduced in the previous record and 

B is the A value introduced in the previous record (basically each time two records must 

be introduced, one with A->B and one with B->A). 

10) Edit the ID_LINK using the same value as in the previous record (e.g., 389). Note that it 

is required to have the same LINK_ID in both directions since the capacity restriction is 

given as the bidirectional flow. 

11) Edit the ORIGCAP value using the same value as previous record. 

12) Close the table by clicking the “X” icon in the top right corner. 

13) On request, click “Yes” to save the edits. 

 

The links present in the capacity table must be consistent with the links present in the network. 

This consistency is related to: 

• a rail link in the capacity table must be present in the network. 
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• a domestic rail link in the network must have a capacity value in the rail capacity table, 

else the capacity in the network will be assigned 0 for that specific link (exceptions are 

made for centroid and terminal connectors). 

• the links must be always bidirectional. Therefore, two records must always be present. 

• the ID_LINK must be sequential and no gaps, in the indexing, are allowed. 

• two links with same node numbers (A to B and B to A) must have the same ID_LINK 

The user has all these checks already available in the "Edit the data" application. During the run 

report #8 the results for the checks will be presented under 

Report_ED_{SCENARIO_SHORTNAME}.txt. It is strongly recommended to check this file prior 

the run of Samgods model.

9.14. Lorry HGV 74-ton setup 

The current model setup includes 40 vehicle types in the definition of chain types used in the 

logistic process. The scenario MainSc2045 and sensitivity tests already include the larger train 

(vehicle types 210-212) and the barge inland water way (vehicle type 322), while HGV74 lorry 

(vehicle type 106) is not active. To activate this last vehicle type there are two options: 

 
1. When editing the network, in the Network window, update the attribute ” LORRY_74T” to 1. 

2. When providing the network as Emme file, update MODESTR value adding B (for instance ” 

a 711400 171695   0.26 xabcB         110 1.0  81      50    0.26        0”). 

In the chain list sub modes “c” and “X” are included. They represent specific sub modes for 

vehicle type 106.  
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10. Advanced user options 

The advanced user rights have been specified for users demanding a more complex setup in 

terms of functionalities. In this chapter, each functionality is described in detail. 

10.1. Consolidation factors 

The consolidation factors can be specified using two different levels: 

• First level: using catalogue keys 21 and 22 in Table 6: 

o Lower bound for consolidation factor (applied to all commodities) 

o Upper bound for consolidation factor (applied to all commodities) 

• Second level: CONSOL<Mode> table under Input_data.mdb which contains the lower and 

upper bound for consolidation factor by sub-mode and per specific commodity groups, using 

catalogue key 3 in Table 15. 

Values provided at the first level will be overridden by those at the second level. Additionally, the 

current model includes special consolidation factors for commodity groups 2, 8 and 9. Figure 91 

presents the aforementioned values. 

 

Figure 91 Default CONSOL_L and CONSOL_U values and by commodity group. 

If an advanced user needs to modify the aforementioned values, by using a different set, the 

following steps are required: 

1) Open Data Manager from Cube Interface  by 

clicking on the icon in the red rectangle. 

2) Open Input_data.mdb in data manager, see Figure 92.  

3) Select BuildChain_CONSOL in data manager window, see Figure 93. 

4) Right click and select "Copy". 

5) Select Input_Data,mdb in Data Manager window, right click and select "Paste". 

6) Refresh Data Manager window clicking on . 
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7) Browse to BuildChain_CONSOL_1, which is the copied table from the 

BuildChain_CONSOL, and double click on it. Make the desired changes and close the 

window by clicking on “X”. The default values can be modified, as per commodity group. 

Entry =-1 means derive the value from default. For instance, CONSOL_L01 for Chain A 

is -1, the applied value is CONSOL_L for Chain A 0.4. 

8) Select Samgods application and scenario under the scenario window. 

9) Double click on scenario name to open the scenario window. 

10) Click next until reach the catalogue key Consolidation factors table. 

11) Click on "Browse", select in the left side Input_Data.mdb and in the right side 

BuildChain_CONSOL_1 (see Figure 92).  

12) Click on OK. 

13) Click "Save". 

 

Figure 92 Input data 

With the above changes the Samgods Model application is ready to be run. 

For an exhaustive description on how those parameters work in the logistic module see [2].  

 

 

Figure 93 Data Manager 
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10.2. Wait time for prompt messages 

Certain applications may trigger prompt windows during execution. These windows require 

immediate user intervention, as the process will remain paused until a selection is made, with a 

determined time of 10 minutes. These prompt windows convey information about the run, 

warnings and failure messages.  

The advanced user has the option to modify these settings and cut down the waiting time (e.g., 

to a few seconds) when several scenarios need to be run in a sequence. 

To change the waiting time, perform the following steps: 

1) Select Create the editable files application and "Scenario_Tree" scenario under scenario 

window. 

2) Double click on scenario name to open the scenario window. 

3) Under " Wait time for prompt messages during execution (default 10 minutes=600 

seconds):" catalogue key type 1 (when 1 refers to 1 second). 

4) Click "Save". 

5) Click "Close". 

10.3. Locking solutions option for Rail Capacity Management 

A feature is available in the model, allowing locking the transport chain solutions for a set of large 

flows for system trains. Locking is not possible for another sub mode, only for system trains. 

Locking is done by listing the specific relations in a table within the calibration databases (i.e., 

Input_Data_Calibration_Base2019.mdb and/or Input_Data_Calibration_MainsSc2045.mdb . Both 

files are located in folder 05_Input_Data\Calibration\). An example of its structure is shown in 

Figure 94. 

 

Figure 94 LockedSTDLogMod.txt file example. 

The values provided are: 

o Commodity: commodity group (in the example first row commodity number 

1). 

o FromNode: origin zone (e.g., 828300). 

o ToNode: destination zone (e.g., 948200). 

o SubCell: subcell in PWC matrix (e.g., 0). 

o Freq: frequency (e.g., -1). 

o Mode used (e.g., I): the locked solution is only available for system trains, 

possible submodes at I,T,U and i. 

o NNodes: number of nodes used in the locked solution (e.g., 3). 
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o List of intermediate terminals along the path (correct order is required): e.g., 

828300 – 828311 – 828011 – 806011 – 786211 – 758111 – 902111 – 

948211 – 948200. 

o The table is pointed out in the GUI of the Samgods Model application. It is 

possible, for the user, to create another table with locked solutions in the 

calibration database and change the path in the Samgods Model application 

(as long as the table format remains the same, see Figure 95).  

 

 

Figure 95 Edit box and input

The transport chain list must be checked using Input_Data.mdb\BuildChain_MODES table, and 

not the Input_Data.mdb\Modes table. The former is used in the logistic modules, while the latter 

is used in the network coding. Letters I and i have the opposite meaning of vehicle type numbers: 

I = 204 and i=211 in BuildChain_Modes, while i=204 and I=211 in network coding.  

 

The transport chains listed in this file will be excluded in the evaluation of the new alternatives 

during Standard Logmod and Rail Capacity Management process. Their impact on the rail 

capacity consumption is still accounted for in the LP-model. 

10.4. Empty vehicle fractions 

The Extract procedure reads the output files from LogMod and RCM and produces the OD 

matrices for tonnes and number of loaded and empty vehicles, respectively. It comprises a 

stepwise linear function for deriving the number of empties as fraction of the loaded vehicles. 

The applied curve is shown in Figure 96. 

 

Figure 96 Curve of empty vehicle fractions. 

The curve can be specified via the interface by updating the table "Empty vehicle fractions per 

vehicle type and distance", under the data panel (Scenario Inputs\General tables\). The structure 

of the table is as shown in Figure 97. 

 



 

151 
  

 

Figure 97 Input table for empty vehicle fractions. 

The attributes in the table represent the points of the curve that the user wants to apply: 

• DIST1: first distance (km) where the EMPFAC1 value will be applied (with a flat distribution). 

• DIST2: second distance (km) where the EMPFAC2 value will be applied (with a linear 

function between EMPFAC1 and EMPFAC2 for distances between DIST1 and DIST2). 

• If DIST1 and DIST2 are zero, a constant level curve equal to the value EMPFAC1 will be 

applied. 

The above attributes shape the function used in the extract procedure. The attribute ASYM 

provides a threshold distance, above which asymmetric flows will generate empty vehicles. The 

asymmetric part is determined as the absolute value of the difference in the loaded flows in 

pairwise, opposite OD-relations. To illustrate the calculation, consider an OD-relation (e.g., the 

asymmetric part is abs(120 – 100) = 20): 

• Distance = 70 km 

• OD-flow ij= 120 vhcls 

• DO-flow ji = 100 vhcls 

• Empty vehicle fraction at 70 km = 0.1 

If ASYM=50 the distance (70 km) is above the threshold value, so asymmetric flows will generate 

empty vehicles (according to empties := symmetric term + asymmetric term): 

• OD-flow empties ji = 0.1*100 

• DO-flow empties ij = 0.1*120 + 20
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10.5. Restart from failure 

In the event of a crash during a Samgods run different actions can be performed, by the user, 

depending on the crashed application. 

The model failure can occur under different circumstances: 

• hard disk space insufficient to save output. 

• locked mdb prevents the move of data in Input_data.mdb (if the geodatabase has been 

open in GIS interface or is MS Access the .ldb file could reside in the system and protect 

the mdb in read mode). 

• failure in running the LP solution with CLP64.exe. 

• wrong settings of catalogue keys. 

If the failure happens in Standard LogMod or RCM or in some of their sub steps (LOS, Logistic 

Module, Assignment, Report, RCM, Assignment RCM, Report RCM ) it is possible to rerun the 

process until the next sub step and after that run each remaining sub step selecting " Run only 

one step, or run all steps" with the appropriate value. 

For instance, if the process crashes in "Logistics module\Save Reports" group it is required to 

run this and next sub group "Assignment\Conversion From Logmod to VY". The instructions 

below must be performed for those two groups with the same execution order shown in the 

interface (first “Save Reports”, second “Conversion From Logmod to VY”). After this the 

Assignment, Report, Rail Capacity Management steps will be run separately. 

To rerun a specific subgroup the following actions must be undertaken from the Cube interface: 

1) Select the scenario that failed. 

2) Open the application that failed by double click on the actual application in the 

“Application window”. 

3) Click on "Run", located in the top left corner of the Cube interface (see icon in red 

rectangle in ). 

4) In pop-up menu "Run Application", select "Run Application now from Task Monitor' and 

tick "Run Current Group Only", see settings in Figure 98. 

5) Click on "OK". 
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Figure 98 Restart from failure 

The single subgroup will be run. 

10.6. Scaling factor for outputs 

The “Scaling factor for outputs” define how the results will be presented in the report tables. The 

original values from the model will be divided by: 

 

•  “Thousands” (/1,000), 

•  “Millions” (/1,000,000), or, 

•  “Billions” (/1,000,000,000). 

In the current implementation the unique and default value is ”Thousands” and the 

normal/advance user has not access to the catalogue key to modify the default. Only the 

developer mode let modify the value.  

The steps to modify the value are: 

1) Select “Scaling factor for outputs” catalogue key from scenario window: 

2) Type in the box “Millions” or “Billions”: 

3) Click on enter and “Save”. 

 

Note: The only allowed values are “Thousands”, “Millions” and “Billions”. Any other value is NOT 

accepted and it will cause the failure for the run. Moreover, the user should spell the name of the 

scaling factor correctly. 
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11. Log reports 

In this chapter, log reports from running some of the applications are presented. The reports 

include messages that help the user to analyse and understand the results. 

11.1. Edit the data application 

The Edit the data log report is created when the application Edit the data is run. Possible 

messages inside the log report file Report_ED_{SCENARIO_CODE}.txt under the scenario 

specific folder, also accessible from the Data section window under Scenario outputs\Edit the 

data Report, are listed and explained in Table 39. 

 

Table 39 Reports for Edit the data application 

Number of 

message 

inside the 

log report 

Purpose Example of messages Message explanation 

#1 
Inform whether the scenario is 

editable or not 

Report #1 – the scenario 

is still editable. 
The scenario is in editable mode.  

Report #1 – the scenario 

is locked. 

Changed the scenario into read only 

mode. It is not possible to change it 

back from the interface.  

#2 

Verify the Ports_swe table 

Report #2: the terminal 

N(6.0) TERMINAL N(6.0) 

is not a sea terminal!! 

Please check the” Ports 

Sweden” layer. 

The terminal number that is not a 

sea terminal is printed out. In the 

Ports_swe table there should be only 

sea terminals. If the terminal is not a 

port, it will not be saved in the table. 

Verify if a domestic port has the 

PortArea number specified 

Report #2: the terminal 

N(6.0) is missing the Port 

Area attribute. 

Please associate a port 

area number. See table 

"A_Port_areas" for the 

attribute names 

Each domestic port must be given to 

a port area since some calibration 

parameters are associated to this 

attribute. It is also used for reporting 

procedures. 

Correct the PortArea number with 

proper number. 

#3 
Information on the number of 

zones\terminals 

Report #3: the number of 

zones is MAX 

NETWORK(5.0) 

Maximum number of zones\terminals 

in the highway network 

#3 
Verify the coherence between 

network and nodes 

Report #3: the number of 

zones is not the same in 

the network and the node 

table. 

In the network there are 

MAX NETWORK(5.0) 

and in the nodes table 

MAX NODES(5.0). 

Please check the 

Scenario network.  

In this step, the application updates 

the variable ZONES_M inside the 

general tables and gives the report.  

MAX NETWORK(5.0) is the variable 

used to count the maximum number 

of zones in the network 

MAX NODES(5.0) is the variable 

used to count the maximum number 

of zones in the node s table. During 

the run, they will be substitute by the 

zone node numbers. 

#4 
Verify the coherence between 

tables 

Report #4: Please add 

the node ZONE(6.0) to 

the node table. 

The zone is in the network but not in 

the nodes table. 

Report #4: Please add 

the node ZONE(6.0) to 

the network. 

The zone is in the nodes table but 

not in the network. 

Report #4: Please add 

the sea terminal 

ZONE(6.0) to the 

network. 

The sea terminal is in the 

Node_Terminals but not in the 

network. 
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Number of 

message 

inside the 

log report 

Purpose Example of messages Message explanation 

Report #4: Please add 

the commodity node 

ZONE(6.0) to the 

network. 

The node is in the 

Nodes_commodities table but not in 

the network. 

Report #4: Please add 

the frequency node 

ZONE(6.0) to the 

network. 

The node is in the 

Frequency_Data_Node table but not 

in the network. 

Report #4: Please add 

the frequency node 

ZONE(6.0) to the 

network. 

The node is in the 

Frequency_Data_Link table but not 

in the network. 

#5 Verify the numbering system 

Report #5 – numbering 

system.  

Node / Code_error / 

Description 

Header of the message 

N / 1 / Missed the mode! 

– must be correct! 

Missed the mode for node N – must 

be correct in the node table 

N / 2 / Missed the ID 

COUNTRY or the ID 

REGION code – must be 

correct! 

Missed the ID_COUNTRY or the 

ID_REGION code in the node table 

for node N 

#6 

View the errors during the 

creation of NORIG numbers for 

the zones 

List of errors during the 

creation of SCBSTANN 

for the zones 

Header of the message 

NORIG is the Emme node number 

and its specification comes from a 

set of rules when edits are made in 

GIS interface. From Emme network it 

is the value already present. 

The node is without 

MODE_N. Please check 

the data. 

The mode for the zone is missing 

The node has no values 

available. Please check 

the data. 

There are no node numbers 

available for the zone 

#7 

View the errors during the 

creation of NORIG numbers for 

the nodes 

List of errors during the 

creation of NORIG for the 

nodes  

Header of the message 

No more node numbers 

are available. Please 

check the data 

There are no node numbers 

available for the node 

#8 
Check the consistency of rail 

capacity table with Rail Network 

Report#8: There are 

mistakes in the rail 

capacity table. Please 

check the rail capacity 

table. 

The link A B ID_LINK is 

not a rail link 

The link listed is not a rail link. Check 

the node numbers A and B in the rail 

network and identify the proper node 

number. (NOTE: the links must be 

only Swedish links). 

The link A B ID_LINK is 

not present in the 

network.  

The link listed is not present in the 

rail network. Two actions are: 

1) amend the A and B nodes 

because the link is in the network; 

2) add the link in the network 

because the link is missing. 

The link A B is in the rail 

capacity table but has not 

any capacity 

The links listed in the rail capacity 

table MUST have a capacity value 

greater than zero. The capacity is 

number of BIDIRECTIONAL trains 

per day. 
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Number of 

message 

inside the 

log report 

Purpose Example of messages Message explanation 

The ID_LINK sequence is 

wrong. for the following 

links: 

A B 

A B 

... 

 

Links with opposite direction but 

same node number MUST have 

same ID_LINK. 

Example: 

2001-2000 and 2000-2001 

The ID_LINK sequence is 

wrong.  

The ID_LINK must start from 1 to the 

highest number. No gaps could be 

present.  

 

#9 

To identify nodes unconnected 

to any link – this precludes the 

correct structure of spanning 

tree data later produced by 

Samgods application. This must 

be considered as sever mistake 

and always fixed. 

Report#9: There are 

mistakes in the network. 

The following nodes must 

be removed since not 

used in any link 

Node number= 12345 

 

The nodes listed must be deleted 

from the network. Open GIS 

interface, start an edit session, select 

them and delete from feature 

explorer window. Save and close. 

In addition to the controls of the data loaded into the model, there are also controls and 

consistency checks with the calibration databases (Input_Data_Calibration_Base2019.mdb and 

Input_Data_Calibration_MainSc2045.mdb) compared to the Input_Data.mdb. Reports are also 

listed in Report_ED_{SCENARIO_CODE}.txt and are explained in Table 40. Note that in order to 

apply calibration factors for a specific parameter, the parameter must be in place within the main 

database (this explains why tolls = 0 SEK are represented in main database), otherwise the 

program will crash because of inconsistencies within the data. 

 

Table 40 Calibration related reports for Edit the data application 

Number of 

messages 

inside the log 

report 

Purpose Example of messages Message explanation 

#C1 

Consistency checks of table 

Nodes, comparing 

Input_Data.mdb and relevant 

calibration database for actual 

scenario 

Report #C1. Consistency 

between Nodes in scenario and 

calibration parameters. There 

are 0 errors in the Nodes table. 

No inconsistencies appear 

between listed input data 

and calibration parameters 

for nodes 

#C2 

Consistency checks of table 

Tax_Country, comparing 

Input_Data.mdb and relevant 

calibration database for actual 

scenario 

Report #C2. Consistency 

between Tax_Country in 

scenario and calibration 

parameters. There are 0 errors 

in the Tax_Country table. 

No inconsistencies appear 

between listed input data 

and calibration parameters 

for tax country 

#C3 

Consistency checks of table 

Tax_Link, comparing 

Input_Data.mdb and relevant 

calibration database for actual 

scenario 

Report #C3. Consistency 

between Tax_Link in scenario 

and calibration parameters. 

There are 0 errors in the 

Tax_Link table. 

No inconsistencies appear 

between listed input data 

and calibration parameters 

for tax link 

#C4 

Consistency checks of table 

Toll_Link, comparing 

Input_Data.mdb and relevant 

calibration database for actual 

scenario 

Report #C4. Consistency 

between Toll_Link in scenario 

and calibration parameters. 

There are 0 errors in the 

Toll_Link table. 

No inconsistencies appear 

between listed input data 

and calibration parameters 

for toll link 

#C5 

Consistency checks of table 

Rail_Capacity, comparing 

Input_Data.mdb and relevant 

calibration database for actual 

scenario 

Report #C5. Consistency 

between Rail_Capacity table in 

scenario and calibration 

parameters. There are 0 errors 

in the Rail_Capacity table. 

No inconsistencies appear 

between listed input data 

and calibration parameters 

for rail capacity 

#C6 
Consistency checks of Network 

related data, comparing 

Report #C6. Consistency 

between Network and calibration 

No inconsistencies appear 

between listed input data 
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Number of 

messages 

inside the log 

report 

Purpose Example of messages Message explanation 

Input_Data.mdb and relevant 

calibration database for actual 

scenario 

parameters. There are 0 errors 

in the Network. 

and calibration parameters 

for network 

11.2. Samgods Model application 

The Existing Outputs log report is created when the Samgods Model application is run. The 

messages inside the log report file Report_SG_{SCENARIO_CODE}.txt under the scenario 

specific folder, also accessible from the Data Section window in Scenario outputs\Samgods 

Report\Existing Outputs, are listed and explained in Table 41. 

 

Table 41 Reports for the Samgods Model application 

Number of 

message inside 

the log report 

Purpose Example of messages Message explanation 

#1 

Analyse inconsistencies 

between input data in 

different runs 

The output for the commodity 

ID_COM(2.0) was created with a 

different Input data. Please check the 

scenario data. 

The previous run has DATE_E and the 

current run has DATE_L. 

Warning that the input data 

has been modified between 

the last run and the current 

run. 

 

 List of output files 

The results have been 

computed by Voyager. 

The output under path is 

available. 

List of all available output 

files and their locations. 

11.3. Handling scenario application 

The Report for the import phase is created when the Import function in the Handling Scenario 

application is run. The messages inside the log report file Report_HL_{SCENARIO_CODE}.txt 

under the scenario specific folder, also accessible from the Data Section window under Scenario 

Outputs\Import function Report\Report for the import phase, are listed in Table 42. 

 

Table 42 Reports for the Handling scenario application 

Messages Required actions 

All the catalogue keys have the 

correct value. No actions are 

requested. 

No action required. 

List of catalogue keys that 

have to be changed and 

how. 

Change the listed catalogue keys for the imported scenario under “Scenario 

Parameters” in the Handling scenario application and run the application again. 

Check the report again. 

 

11.4. Check-list when errors occur 

To improve setup tracking for the Samgods Model application, a new file titled 

[Scenario_Name]_CatalogKeys.csv is now generated. This file captures all user-defined run 
settings within Cube, effectively documenting the configuration for each specific execution.  
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11.5. Check-list when errors occur 

• Does the user have the required administrative rights to install and run the Samgods 

GUI? 

• Is the model user role correct?  

o Model Standard user is typically used when running scenarios etc., while Model 

Developer user typically is used during installation and setting up the system. 

Model Advanced user is used when some main parameters in the model setup 

should be changed for sensitivity tests. 

• What is the ReturnCode no? ReturnCode 2 is a fatal error – view the error report. 

• Is the name of the scenario correct? Geodatabase format does not allow:  

o Leading the name with numbers (i.e., 01_scenario is not allowed, but 

scenario_01 is OK). 

o Special characters (like space “ “ or -,+, n f t in the beginning of the name). 

o Blank space is not allowed, use underscore (“_”) instead. Note that the path of 

the Samgods catalogue cannot contain blank space either. 

o Too long names (maximum 12 characters) 

• Some errors (regarding delimiter problems with “.” and “,”), it is recommended to use 

delimiter “.”. 

• If the mode stops because the task monitor disappears, close Cube and check the 

combability of Cube.exe, it should be set to be combability with Windows 8 (see Figure 

1). 

• If the logistics module stops operating, the reason could be that the execution is split up 

into too many processors. RAM per processor should be at least 1.5 GB. The number of 

processors to use is set in the interface, via a catalogue key in the Samgods model 

application, see Section 7.5. 

Warning messages as in Figure 99: will interrupt the model run (with Return Code =3). 

They refer to the LP setup (made by a set of batch files called in sequence). In this case 

a failure is occurred in MPS.jar program or CLP64.exe program. To debug the problem, 

the user is referred to documents listed in [7] and [3]. Along the process in each 

fundamental stage, similar prompts will appear. In all cases the failure is one of the 

external programs (BuildChain, ChainChoi, ConsolidRateMode, extract, mergerep, RCM, 

LP2CC, SelectDirect). The proper folder that contains information on failure is 

LogMod\LOG folder that will contain the log file (per commodity or vehicle class) and err 

file (listing the probable reason of failure).  

• JVM (Java Virtual Machine) is not working and therefore RCM does not produce any 

result: check java pattern first, and if correct check if the correct java pattern is defined in 

PATH system variable. Guidance for setting the environmental variable is present under: 

https://www.java.com/en/download/help/path.xml. 

The value under PATH environment variable should point to the folder containing the 

java.exe. 

 

https://www.java.com/en/download/help/path.xml
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Figure 99 Run error 
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12. Maps on outputs 

The model produces outputs that can be classified into two main groups: 

• tabular reports. 

• geodatabase networks. 

The first group can be visualised via the Cube interface, Access or ArcMap. The second group 

can be visualised via the Cube interface or ArcMap. In this chapter it will be provided the 

procedure to create maps for the second group. A standard set of maps that can be exchanged 

with people without Cube license is also described in this chapter.  

12.1. List of networks 

The available networks are presented in Table 43. 

 

Table 43 Geodatabase networks in output 

ID Data panel Name Notes 

1 

Scenario 

Outputs\Samgods 

Report\Assignment 

Road Assigned Network  

Rail Assigned Network  

Sea Assigned Network  

Air Assigned Network  

2 Scenario 

Outputs\Samgods 

Report\Reports 

Assigned Network  

3 Bidirectional tons per mode STD  

4 
Scenario Outputs\RCM 

Report\Assignment 

Road Assignment Network (RCM)  

Rail Assignment Network (RCM)  

Sea Assignment Network (RCM)  

Air Assignment Network (RCM)  

5 

Scenario Outputs\RCM 

Report\Reports 

Assigned Network  

6 Report #15b Rail Capacity Network Only for RCM 

7 Bidirectional tons per mode RCM  

12.2. Create a map 

To create a map in GUI interface: 

1) Select the scenario from which the user wants to create a map. 

2) Select from data panel the geodatabase network the user wants to visualize (in the 

example Report #15b Rail Capacity Network) and double click on it. 

3) The GIS window will be open having in TOC only the network (named Rail_BiDir). 

4) Clicking on "Add data>Geodatabase Data", see Figure 100, add 

{CATALOG_KEY}\Input_Data.mdb\Samgods_zones background layer. This layer is for 

visual reference only. 
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5) Clicking on "Add data>Shapefile" add background shapefiles located under 

{CATALOG_KEY}\03_Gis_Data (see Figure 101). This is for visual reference only. 

6) In the TOC drag and drop Rail_BDir on the top of all the layers. 

7) Untick the network node layer (Rail_BDir_node). 

At this point the map looks like Figure 102. 

 

8) Click on the tab “GIS Analysis” in the interface and click on “Multi-Bandwidth tool”, see 

Figure 103. 

 

 

 

Figure 101 Add data 

Figure 102 Map with geodatabase network and general layers 

Figure 100 Samgods_zones layer in Input_data.mdb 
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9) The Highway Layer Link Bandwidth Setting window will pop up. Select the attribute to 

visualize in the map (TOT_EMPT) and Dynamic Colour in the dialog screen. This option 

allows specification of different colours for different value ranges for the selected 

attribute. 

10) Enter in the Name input frame, the name of the map (in the example Empty trains 

bidirectional per day), in Figure 104. 

11) Click on "Color" and specified in the following window (see Figure 105): Number of 

groups (6), the Color Range clicking on colored icon (green and red). Click on Apply 

Color Range and Apply Value Range. Accommodate the High Value in the range of 

values per desired class. Click on OK. 

Figure 103 Multi-Bandwidth tool 

Figure 104 Name input frame 
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12) Click on OK in the following two menus 

The resulting map will be as shown in Figure 106. 

 

Figure 105 Colour settings 

Figure 106 Present map 
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13) Click on “X” to close the map, the system will prompt if it is necessary save the map 

giving a location and a name. Select the scenario folder and give the name "RCM.mxd", 

see Figure 107. 

12.3. Copy existing maps in new scenarios 

The practice to start from scratch is not recommended and will be extremely time consuming. A 

useful option is to inherit/copy all the settings specified with Multi-Bandwidth (or any tool in the 

graphical interface) from one scenario to another scenario by copying those settings from the vpr 

file. 

The vprfile is normally created and saved alongside the output.mdb. It takes its name from the 

geodatabase which it refers to. In Samgods model its name is 

output{Commodity}_{SCENARIO_SHORTNAME}.vpr and it is placed under the scenario folder. 

If it is not present, it means that no maps are yet specified for the scenario. 

The vpr file saves all the settings specified in the mxd document which refers to elements loaded 

according to the TOC.  

To import in a new scenario the legends, Multi-Bandwidths, labels specified in another scenario 

proceed in the following manner: 

1) Right click on RailBdir_Link layer. 

2) On the window select "Copy Layer Settings From Another Layer", see Figure 108.  

Figure 107 Save the map if necessary 
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3) Select the Vpr file from scenario having the map the user wants to use (in the example 

Base2006R64 folder and Output0_Base2006R64.vpr file), see Figure 109. 

4) Select the layer having the same name of the current network (e.g., Rail_BDir), see 

Figure 110. 

Figure 108 Copy layer settings from another layer 

Figure 109 Select vpr file 
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5) Click on GIS Analysis tab in the interface and click on Multi-Bandwidth tool. The legend 

specified in the other network will be prompted automatically. 

6) Click on OK. 

7) Click on X to close the map, the system will prompt if it is necessary save the map giving 

a location and a name. Select the scenario folder and give the name "RCM_64.mdx". 

12.4. Attributes names for maps 

The available attributes that can be visualised in a map for networks 1,2,4,5 in Table 51 are 

listed under 14.4.2. Here the attributes in networks 3,6 and 7 in Table 44 are listed. 

 

Table 44 Attributes in geodatabase networks 

Attribute Meaning Network 

TOT_ROAD_TM_BD 
Bidirectional tonne flows on road in 

millions 
Loaded_Bid_STD (Bidirectional tonnes 

per mode STD) 

Loaded_Bid_RCM (Bidirectional tonnes 

per mode RCM) 

TOT_RAIL_TM_BD Bidirectional tonne flows on rail in millions 

TOT_SEA_TM_BD Bidirectional tonne flows on sea in millions 

TOT_EMPT Bidirectional empty train flows per day 

Rail_Bdir (Report #15b Rail Capacity 

Network) 

TOT_ASS 
bidirectional per day total train flows 

(empty + loaded 

TOT_LOAD 
Bidirectional number of loaded trains per 

day 

CAP Bidirectional capacity (#trains/day)  

FLAG_OVCAP 
1 if overcapacity load of 1 train/day, 

otherwise 0 

FLAG_PER 1 if overcapacity load of 1%, otherwise 0 

FLAG_TOT 1 if FLAG_PER=1 or FLAG_OVCAP=1 

DIFF_VC 
Differences in number of trains over 

capacity  

12.5. Standard Output maps 

For three specific outputs, there are available standard output maps respectively under: 

Figure 110 Select layer 
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1) Data Panel\Scenario Outputs\RCM Report\GIS maps – for total Ktons and vehicles per 

commodity group, see Figure 111 and Figure 112. 

 

 

Figure 111 Standard map on ktons by total and commodity groups. (map name: 

Output_CMD_RCM_GIS_TON.mxd) 

 

 

Figure 112 Standard map on Loaded vehicles by total and commodity groups. (map name: 

Output_CMD_RCM_GIS_VHCL.mxd) 

o  

Data Panel\Scenario Outputs\Samgods Report\GIS maps – for total Ktons and vehicles per commodity 

group, see Figure 113 and  
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2) Figure 114. 

o  

 

Figure 113 Standard map on ktons by total and commodity groups. (map name: 

Output_CMD_STD_GIS_TON.mxd) 

 

 

Figure 114 Standard map on Loaded vehicles by total and commodity groups. (map name: 

Output_CMD_STD_GIS_VHCL.mxd) 

3) Data Panel\Scenario Outputs\Compare\GIS maps – for differences on total Ktons by 

commodity group, see Figure 115. 

o  
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Figure 115 Standard map on ktons for total and commodity groups 

4) Data Panel\Scenario Outputs\SelectLink\STD\GIS Maps and Data Panel\Scenario 

Outputs\SelectLink\RCM\GIS. 

The former is produced when running Samgods Model application, the later when running 

Compare Scenarios application. 

Their setup allows the following actions: 

1) To open them from GUI interface clicking under Data Panel. 

2) To open them in GIS Desktop via mxd-file. 

3) To redistribute the maps and related layers to non-Cube users (with a valid ArcGIS 

software).  

The maps and the data sources are saved under: 

• {Scenario_Dir}\ABS_GIS{SCENARIO_SHORTNAME} for absolute values on current 

scenario. 

• {Scenario_Dir}\DIFF_GIS2045_2019 for differences between current scenario and base 

scenario. 

• {Scenario_Dir}\SelectLink\{FolderSL}\SEL_GIS. 

To share the results, it will be sufficient to zip the specific folder and send it over, all the required 

data will be present in there.
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14. Appendices 

14.1. Dimensions in the model 

The commodity types represented in the model is listed in Table 45, vehicle types and submodes 

used in the model is listed in Table 46 and allowed transport chains is represented in Table 47. 

 

Table 45 Overview of commodity types in Samgods 1.2.3 

Commodity Description 

1 Products from agriculture, forestry and fishing 

2 Coal, crude oil and natural gas 

3 Ore, other products of extraction 

4 Food, beverages and tobacco 

5 Textiles, clothing, leather and leather goods 

6 
Wood and articles of wood and cork (excl. Furniture), pulp, paper and paper 

products, printed matter 

7 Coal and refined petroleum products 

8 
Chemicals, chemical products, synthetic fibres, rubber and plastic products 

and nuclear fuel 

9 Other non-metallic mineral products 

10 Metal products excluding machinery and equipment 

11 Machinery and instruments 

12 Transport equipment 

13 Other manufacturing ex furniture 

14 Household waste, other waste and return raw material 

15 Round timber 

16 Air transport goods 
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Table 46 Overview of vehicle type numbers, and aggregate modes for container transport and non-
container transport 

Aggregate mode ModeNr VhclNr Vehicle type 

Containers 

Heavy lorry A 
104 Lorry HGV 40 ton 

105 Lorry HGV 60 ton 

Extra heavy lorry X 106 Lorry HGV 74 ton 

Kombi train D 201 Kombi train 

Long kombi train d 210 Long kombi train 

Feeder train E 202 Feeder/shunt train 

Wagonload train F 

207 Short wagon load train 

208 Medium wagonload train 

209 Long wagonload train 

Long Wagonload train f 212 Long wagonload train 

Direct Sea J 

301 Container vessel 5 300 dwt1 

302 Container vessel 16 000 dwt1 

303 Container vessel 27 200 dwt1 

304 Container vessel 100 000 dwt1 

305 Other vessel 1 000 dwt 

306 Other vessel 2 500 dwt 

307 Other vessel 3 500 dwt 

308 Other vessel 5 000 dwt 

309 Other vessel 10 000 dwt 

310 Other vessel 20 000 dwt 

311 Other vessel 40 000 dwt 

312 Other vessel 80 000 dwt 

313 Other vessel 100 000 dwt 

314 Other vessel 250 000 dwt 

315 Ro/ro vessel 3 600 dwt  

316 Ro/ro vessel 6 300 dwt 

317 Ro/ro vessel 10 000 dwt 

Feeder vessel K 

301 Container vessel 5 300 dwt 

315 Ro/ro vessel 3 600 dwt  

316 Ro/ro vessel 6 300 dwt 

Long-Haul vessel L 

303 Container vessel 27 200 dwt 

304 Container vessel 100 000 dwt 

317 Ro/ro vessel 10 000 dwt 

IWW V 322 IWW-vessel 

 

 

 

 

 

 

Non-Containers 

 

 

 

 

 

 

Light Lorry B 

101 Lorry light LGV, ≤ 3,5 ton 

102 Lorry medium 16 ton 

103 Lorry medium 24 ton 

Heavy lorry C / S14 
104 Lorry HGV 40 ton 

105 Lorry HGV 60 ton 

Extra heavy lorry c 106 Lorry HGV 74 ton 

Feeder train G 202 Feeder/shunt train 

Wagonload train H 
207 Short wagonload train 

208 Medium wagonload train 

Long wagonload train h 212 Long wagonload train 

 
14 Consolidated heavy lorry is coded as mode S in the chains file. Consolidation in heavy lorries is only available on an 
intermediate leg in a chain with at least three legs. 
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Aggregate mode ModeNr VhclNr Vehicle type 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Non-Containers 

System train 

I 204 System train STAX 22,5 

T 205 System train STAX 25 

U 206 System train STAX 30 

 i 211 Long system train 

Direct Sea M 

305 Other vessel 1 000 dwt 

306 Other vessel 2 500 dwt 

307 Other vessel 3 500 dwt 

308 Other vessel 5 000 dwt 

309 Other vessel 10 000 dwt 

310 Other vessel 20 000 dwt 

311 Other vessel 40 000 dwt 

312 Other vessel 80 000 dwt 

313 Other vessel 100 000 dwt 

314 Other vessel 250 000 dwt 

315 Ro/ro vessel 3 600 dwt  

316 Ro/ro vessel 6 300 dwt 

317 Ro/ro vessel 10 000 dwt 

Feeder vessel N 
315 Ro/ro vessel 3 600 dwt  

316 Ro/ro vessel 6 300 dwt 

Long-Haul vessel O 317 Ro/ro vessel 10 000 dwt 

IWW W 322 IWW-vessel 

Road Ferry P 

318 Road ferry 2 500 dwt  

319 Road ferry 5 000 dwt 

320 Road ferry 7 500 dwt 

Rail Ferry Q 321 Rail ferry 5 000 dwt 

Plane R 401 Freight airplane 
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Table 47 Transport chains used for Sweden  

Number  Potential chain Explanation 
Included in model year 

2019        2045 

1 A Direct transport by Heavy lorry Yes Yes 

2 ADA Heavy lorry-Kombi train-Heavy lorry Yes Yes 

3 ADJA Heavy lorry-Kombi train-Direct sea-Heavy lorry Yes Yes 

4 ADJDA 
Heavy lorry-Kombi train-Direct sea-Kombi train-

Heavy lorry 
Yes Yes 

5 ADJDX 
Heavy lorry-Kombi train-Direct sea-Kombi train-

Extra heavy lorry 
No Yes 

6 ADJX Heavy lorry-Kombi train-Direct sea-Extra heavy lorry No Yes 

7 ADKL 
Heavy lorry-Kombi train-Feeder vessel-Long-haul 

vessel 
Yes Yes 

8 ADX Heavy lorry-Kombi train-Extra heavy lorry No Yes 

9 AJ Heavy lorry-Direct sea Yes Yes 

10 AJA Heavy lorry-Direct sea-Heavy lorry Yes Yes 

11 AJDA Heavy lorry-Direct sea-Kombi train-Heavy lorry Yes Yes 

12 AJDX Heavy lorry-Direct sea-Kombi train-Extra heavy lorry No Yes 

13 AJX Heavy lorry-Direct sea-Extra heavy lorry No Yes 

14 AJdA Heavy lorry-Direct sea-Long kombi train-Heavy lorry No Yes 

15 AJdX 
Heavy lorry-Direct sea-Long kombi train-Extra heavy 

lorry 
No Yes 

16 AKL Heavy lorry-Feeder vessel-Long-haul vessel Yes Yes 

17 APA Heavy lorry-Road ferry-Heavy lorry Yes Yes 

18 APX Heavy lorry-Road ferry-Extra heavy lorry No Yes 

19 AV Heavy lorry-INW Yes Yes 

20 AVA Heavy lorry-INW-Heavy lorry Yes Yes 

21 AVX Heavy lorry-INW-Extra heavy lorry No Yes 

22 AX Heavy lorry-Extra heavy lorry No Yes 

23 AdA Heavy lorry-Long kombi train-Heavy lorry No Yes 

24 AdJA Heavy lorry-Long kombi train-Direct sea-Heavy lorry No Yes 

25 AdJX 
Heavy lorry-Long kombi train-Direct sea-Extra heavy 

lorry 
No Yes 

26 AdJdA 
Heavy lorry-Long kombi train-Direct sea-Long kombi 

train-Heavy lorry 
No Yes 

27 AdJdX 
Heavy lorry-Long kombi train-Direct sea-Long kombi 

train-Extra heavy lorry 
No Yes 

28 AdKL 
Heavy lorry-Long kombi train-Feeder vessel-Long-

haul vessel 
No Yes 

29 AdX Heavy lorry-Long kombi train-Extra heavy lorry No Yes 

30 B Direct transport by Light Lorry Yes Yes 

31 BR Light Lorry-Plane Yes Yes 

32 BRB Light Lorry-Plane-Light Lorry Yes Yes 

33 BS Light Lorry-Heavy lorry Yes Yes 

34 BSB Light Lorry-Heavy lorry-Light Lorry Yes Yes 

35 Bc Light Lorry-Extra heavy lorry Yes Yes 

36 C Direct transport by Heavy lorry Yes Yes 

37 CGH Heavy lorry-Feeder train-Wagonload train Yes Yes 

38 CGHC 
Heavy lorry-Feeder train-Wagonload train-Heavy 

lorry 
Yes Yes 

39 CGHM Heavy lorry-Feeder train-Wagonload train-Direct sea Yes Yes 

40 CGHc 
Heavy lorry-Feeder train-Wagonload train-Extra 

heavy lorry 
Yes Yes 

41 CGh Heavy lorry-Feeder train-Long wagonload train No Yes 

42 CGhC 
Heavy lorry-Feeder train-Long wagonload train-

Heavy lorry 
No Yes 

43 CGhM 
Heavy lorry-Feeder train-Long wagonload train-

Direct sea 
No Yes 



 

175 
  

Number  Potential chain Explanation 
Included in model year 

2019        2045 

44 CGhc 
Heavy lorry-Feeder train-Long wagonload train-

Extra heavy lorry 
No Yes 

45 CH Heavy lorry-Wagonload train Yes Yes 

46 CHG Heavy lorry-Wagonload train-Feeder train Yes Yes 

47 CHGC 
Heavy lorry-Wagonload train-Feeder train-Heavy 

lorry 
Yes Yes 

48 CHGc 
Heavy lorry-Wagonload train-Feeder train-Extra 

heavy lorry 
Yes Yes 

49 CHM Heavy lorry-Wagonload train-Direct sea Yes Yes 

50 CM Heavy lorry-Direct sea Yes Yes 

51 CMC Heavy lorry-Direct sea-Heavy lorry Yes Yes 

52 CMH Heavy lorry-Direct sea-Wagonload train Yes Yes 

53 CMI Heavy lorry-Direct sea-System train STAX 22,5 Yes Yes 

54 CMM Heavy lorry-Direct sea-Direct sea Yes Yes 

55 CMMC Heavy lorry-Direct sea-Direct sea-Heavy lorry Yes Yes 

56 CMT Heavy lorry-Direct sea-System train STAX 25 Yes Yes 

57 CMU Heavy lorry-Direct sea-System train STAX 30 Yes Yes 

58 CMc Heavy lorry-Direct sea-Extra heavy lorry Yes Yes 

59 CMi Heavy lorry-Direct sea-Long system train No Yes 

60 CPC Heavy lorry-Road ferry-Heavy lorry Yes Yes 

61 CUM Heavy lorry-System train STAX 30-Direct sea Yes Yes 

62 CWC Heavy lorry-Inland water way-Heavy lorry Yes Yes 

63 CWc Heavy lorry-Inland water way-Extra heavy lorry Yes Yes 

64 Ch Heavy lorry-Long wagonload train No Yes 

65 ChG Heavy lorry-Long wagonload train-Feeder train No Yes 

66 ChGC 
Heavy lorry-Long wagonload train-Feeder train-

Heavy lorry 
No Yes 

67 ChGc 
Heavy lorry-Long wagonload train-Feeder train-

Extra heavy lorry 
No Yes 

68 ChM Heavy lorry-Long wagonload train-Direct sea No Yes 

69 GH Feeder train-Wagonload train Yes Yes 

70 GHC Feeder train-Wagonload train-Heavy lorry Yes Yes 

71 GHG Feeder train-Wagonload train-Feeder train Yes Yes 

72 GHM Feeder train-Wagonload train-Direct sea Yes Yes 

73 GHMI 
Feeder train-Wagonload train-Direct sea-System 

train STAX 22,5 
Yes Yes 

74 GHMT 
Feeder train-Wagonload train-Direct sea-System 

train STAX 25 
Yes Yes 

75 GHMU 
Feeder train-Wagonload train-Direct sea-System 

train STAX 30 
Yes Yes 

76 GHMi 
Feeder train-Wagonload train-Direct sea-Long 

system train 
No Yes 

77 GHQH 
Feeder train-Wagonload train-Rail ferry-Wagonload 

train 
Yes Yes 

78 GHc Feeder train-Wagonload train-Extra heavy lorry Yes Yes 

79 Gh Feeder train-Long wagonload train No Yes 

80 GhC Feeder train-Long wagonload train-Heavy lorry No Yes 

81 GhG Feeder train-Long wagonload train-Feeder train No Yes 

82 GhM Feeder train-Long wagonload train-Direct sea No Yes 

83 GhMI 
Feeder train-Long wagonload train-Direct sea-

System train STAX 22,5 
No Yes 

84 GhMT 
Feeder train-Long wagonload train-Direct sea-

System train STAX 25 
No Yes 

85 GhMU 
Feeder train-Long wagonload train-Direct sea-

System train STAX 30 
No Yes 

86 GhQh 
Feeder train-Long wagonload train-Rail ferry-Long 

wagonload train 
No Yes 

87 Ghc Feeder train-Long wagonload train-Extra heavy lorry No Yes 
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Number  Potential chain Explanation 
Included in model year 

2019        2045 

88 HC Wagonload train-Heavy lorry Yes Yes 

89 HG Wagonload train-Feeder train Yes Yes 

90 HGC Wagonload train-Feeder train-Heavy lorry Yes Yes 

91 HGc Wagonload train-Feeder train-Extra heavy lorry Yes Yes 

92 HM Wagonload train-Direct sea Yes Yes 

93 HMC Wagonload train-Direct sea-Heavy lorry Yes Yes 

94 HQH Wagonload train-Rail ferry-Wagonload train Yes Yes 

95 Hc Wagonload train-Extra heavy lorry Yes Yes 

96 I Direct transport by System train STAX 22,5 Yes Yes 

97 IM System train STAX 22,5-Direct sea Yes Yes 

98 IMC System train STAX 22,5-Direct sea-Heavy lorry Yes Yes 

99 IMHG 
System train STAX 22,5-Direct sea-Wagonload 

train-Feeder train 
Yes Yes 

100 IMc 
System train STAX 22,5-Direct sea-Extra heavy 

lorry 
Yes Yes 

101 IMhG 
System train STAX 22,5-Direct sea-Long wagonload 

train-Feeder train 
No Yes 

102 J Direct transport by Direct sea Yes Yes 

103 JA Direct sea-Heavy lorry Yes Yes 

104 JX Direct sea-Extra heavy lorry No Yes 

105 KL Feeder vessel-Long-haul vessel Yes Yes 

106 LK Long-haul vessel-Feeder vessel Yes Yes 

107 LKA Long-haul vessel-Feeder vessel-Heavy lorry Yes Yes 

108 LKDA 
Long-haul vessel-Feeder vessel-Kombi train-Heavy 

lorry 
Yes Yes 

109 LKDX 
Long-haul vessel-Feeder vessel-Kombi train-Extra 

heavy lorry 
No Yes 

110 LKX Long-haul vessel-Feeder vessel-Extra heavy lorry No Yes 

111 LKdA 
Long-haul vessel-Feeder vessel-Long kombi train-

Heavy lorry 
No Yes 

112 LKdX 
Long-haul vessel-Feeder vessel-Long kombi train-

Extra heavy lorry 
No Yes 

113 M Direct transport by Direct sea Yes Yes 

114 MC Direct sea-Heavy lorry Yes Yes 

115 MH Direct sea-Wagonload train Yes Yes 

116 MHG Direct sea-Wagonload train-Feeder train Yes Yes 

117 MHGC Direct sea-Wagonload train-Feeder train-Heavy lorry Yes Yes 

118 MHGc 
Direct sea-Wagonload train-Feeder train-Extra 

heavy lorry 
Yes Yes 

119 MI Direct sea-System train STAX 22,5 Yes Yes 

120 MMC Direct sea-Direct sea-Heavy lorry Yes Yes 

121 MT Direct sea-System train STAX 25 Yes Yes 

122 MU Direct sea-System train STAX 30 Yes Yes 

123 Mc Direct sea-Extra heavy lorry Yes Yes 

124 Mh Direct sea-Long wagonload train No Yes 

125 MhG Direct sea-Long wagonload train-Feeder train No Yes 

126 MhGC 
Direct sea-Long wagonload train-Feeder train-Heavy 

lorry 
No Yes 

127 MhGc 
Direct sea-Long wagonload train-Feeder train-Extra 

heavy lorry 
No Yes 

128 Mi Direct sea-Long system train No Yes 

129 RB Plane-Light Lorry Yes Yes 

130 SB Heavy lorry-Light Lorry Yes Yes 

131 T Direct transport by System train STAX 25 Yes Yes 

132 TM System train STAX 25-Direct sea Yes Yes 

133 TMC System train STAX 25-Direct sea-Heavy lorry Yes Yes 
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Number  Potential chain Explanation 
Included in model year 

2019        2045 

134 TMGH 
System train STAX 25-Direct sea-Feeder train-

Wagonload train 
Yes Yes 

135 TMc System train STAX 25-Direct sea-Extra heavy lorry Yes Yes 

136 U Direct transport by System train STAX 30 Yes Yes 

137 UM System train STAX 30-Direct sea Yes Yes 

138 UMC System train STAX 30-Direct sea-Heavy lorry Yes Yes 

139 UMGH 
System train STAX 30-Direct sea-Feeder train-

Wagonload train 
Yes Yes 

140 UMGh 
System train STAX 30-Direct sea-Feeder train-Long 

wagonload train 
No Yes 

141 UMc System train STAX 30-Direct sea-Extra heavy lorry Yes Yes 

142 VA INW-Heavy lorry Yes Yes 

143 VX INW-Extra heavy lorry No Yes 

144 WB Inland water way-Light Lorry Yes Yes 

145 X Direct transport by Extra heavy lorry No Yes 

146 XA Extra heavy lorry-Heavy lorry No Yes 

147 XDA Extra heavy lorry-Kombi train-Heavy lorry No Yes 

148 XDJA Extra heavy lorry-Kombi train-Direct sea-Heavy lorry No Yes 

149 XDJDA 
Extra heavy lorry-Kombi train-Direct sea-Kombi 

train-Heavy lorry 
No Yes 

150 XDJDX 
Extra heavy lorry-Kombi train-Direct sea-Kombi 

train-Extra heavy lorry 
No Yes 

151 XDJX 
Extra heavy lorry-Kombi train-Direct sea-Extra 

heavy lorry 
No Yes 

152 XDKL 
Extra heavy lorry-Kombi train-Feeder vessel-Long-

haul vessel 
No Yes 

153 XDX Extra heavy lorry-Kombi train-Extra heavy lorry No Yes 

154 XJ Extra heavy lorry-Direct sea No Yes 

155 XJA Extra heavy lorry-Direct sea-Heavy lorry No Yes 

156 XJDA Extra heavy lorry-Direct sea-Kombi train-Heavy lorry No Yes 

157 XJDX 
Extra heavy lorry-Direct sea-Kombi train-Extra 

heavy lorry 
No Yes 

158 XJX Extra heavy lorry-Direct sea-Extra heavy lorry No Yes 

159 XJdA 
Extra heavy lorry-Direct sea-Long kombi train-Heavy 

lorry 
No Yes 

160 XJdX 
Extra heavy lorry-Direct sea-Long kombi train-Extra 

heavy lorry 
No Yes 

161 XKL Extra heavy lorry-Feeder vessel-Long-haul vessel No Yes 

162 XPA Extra heavy lorry-Road ferry-Heavy lorry No Yes 

163 XPX Extra heavy lorry-Road ferry-Extra heavy lorry No Yes 

164 XV Extra heavy lorry-INW No Yes 

165 XVA Extra heavy lorry-INW-Heavy lorry No Yes 

166 XVX Extra heavy lorry-INW-Extra heavy lorry No Yes 

167 XdA Extra heavy lorry-Long kombi train-Heavy lorry No Yes 

168 XdJA 
Extra heavy lorry-Long kombi train-Direct sea-Heavy 

lorry 
No Yes 

169 XdJX 
Extra heavy lorry-Long kombi train-Direct sea-Extra 

heavy lorry 
No Yes 

170 XdJdA 
Extra heavy lorry-Long kombi train-Direct sea-Long 

kombi train-Heavy lorry 
No Yes 

171 XdJdX 
Extra heavy lorry-Long kombi train-Direct sea-Long 

kombi train-Extra heavy lorry 
No Yes 

172 XdKL 
Extra heavy lorry-Long kombi train-Feeder vessel-

Long-haul vessel 
No Yes 

173 XdX Extra heavy lorry-Long kombi train-Extra heavy lorry No Yes 

174 c Direct transport by Extra heavy lorry Yes Yes 

175 cB Extra heavy lorry-Light Lorry Yes Yes 

176 cC Extra heavy lorry-Heavy lorry Yes Yes 
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Number  Potential chain Explanation 
Included in model year 

2019        2045 

177 cGH Extra heavy lorry-Feeder train-Wagonload train Yes Yes 

178 cGHC 
Extra heavy lorry-Feeder train-Wagonload train-

Heavy lorry 
Yes Yes 

179 cGHM 
Extra heavy lorry-Feeder train-Wagonload train-

Direct sea 
Yes Yes 

180 cGHc 
Extra heavy lorry-Feeder train-Wagonload train-

Extra heavy lorry 
Yes Yes 

181 cGh Extra heavy lorry-Feeder train-Long wagonload train No Yes 

182 cGhC 
Extra heavy lorry-Feeder train-Long wagonload 

train-Heavy lorry 
No Yes 

183 cGhM 
Extra heavy lorry-Feeder train-Long wagonload 

train-Direct sea 
No Yes 

184 cGhc 
Extra heavy lorry-Feeder train-Long wagonload 

train-Extra heavy lorry 
No Yes 

185 cH Extra heavy lorry-Wagonload train Yes Yes 

186 cHG Extra heavy lorry-Wagonload train-Feeder train Yes Yes 

187 cHGC 
Extra heavy lorry-Wagonload train-Feeder train-

Heavy lorry 
Yes Yes 

188 cHGc 
Extra heavy lorry-Wagonload train-Feeder train-

Extra heavy lorry 
Yes Yes 

189 cHM Extra heavy lorry-Wagonload train-Direct sea Yes Yes 

190 cM Extra heavy lorry-Direct sea Yes Yes 

191 cMC Extra heavy lorry-Direct sea-Heavy lorry Yes Yes 

192 cMI 
Extra heavy lorry-Direct sea-System train STAX 

22,5 
Yes Yes 

193 cMT Extra heavy lorry-Direct sea-System train STAX 25 Yes Yes 

194 cMU Extra heavy lorry-Direct sea-System train STAX 30 Yes Yes 

195 cMc Extra heavy lorry-Direct sea-Extra heavy lorry Yes Yes 

196 cMi Extra heavy lorry-Direct sea-Long system train No Yes 

197 cPc Extra heavy lorry-Road ferry-Extra heavy lorry Yes Yes 

198 cS Extra heavy lorry-Heavy lorry Yes Yes 

199 cUM Extra heavy lorry-System train STAX 30-Direct sea Yes Yes 

200 cWC Extra heavy lorry-Inland water way-Heavy lorry Yes Yes 

201 cWc Extra heavy lorry-Inland water way-Extra heavy lorry Yes Yes 

202 ch Extra heavy lorry-Long wagonload train No Yes 

203 chG Extra heavy lorry-Long wagonload train-Feeder train No Yes 

204 chGC 
Extra heavy lorry-Long wagonload train-Feeder 

train-Heavy lorry 
No Yes 

205 chGc 
Extra heavy lorry-Long wagonload train-Feeder 

train-Extra heavy lorry 
No Yes 

206 chM Extra heavy lorry-Long wagonload train-Direct sea No Yes 

207 hC Long wagonload train-Heavy lorry No Yes 

208 hG Long wagonload train-Feeder train No Yes 

209 hGC Long wagonload train-Feeder train-Heavy lorry No Yes 

210 hGc Long wagonload train-Feeder train-Extra heavy lorry No Yes 

211 hM Long wagonload train-Direct sea No Yes 

212 hQh 
Long wagonload train-Rail ferry-Long wagonload 

train 
No Yes 

213 hc Long wagonload train-Extra heavy lorry No Yes 

214 i Direct transport by Long system train No Yes 

215 iM Long system train-Direct sea No Yes 

216 iMC Long system train-Direct sea-Heavy lorry No Yes 

217 iMHG 
Long system train-Direct sea-Wagonload train-

Feeder train 
No Yes 

218 iMc Long system train-Direct sea-Extra heavy lorry No Yes 

219 A2J 
Heavy lorry-(different loading point compared to AJ)-

Direct sea 
Yes Yes 
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Included in model year 

2019        2045 

220 A2JA 
Heavy lorry-(different loading point compared to 

AJA)-Direct sea-Heavy lorry 
Yes Yes 

221 AJ2A 
Heavy lorry-Direct sea-(different loading point 

compared to AJA)-Heavy lorry 
Yes Yes 

222 C2M 
Heavy lorry-(different loading point compared to 

CM)-Direct sea 
Yes Yes 

223 C2MC 
Heavy lorry-(different loading point compared to 

CMC)-Direct sea-Heavy lorry 
Yes Yes 

224 CM2C 
Heavy lorry-Direct sea-(different loading point 

compared to CMC)-Heavy lorry 
Yes Yes 

225 J2A 
Direct sea-(different loading point compared to JA)-

Heavy lorry 
Yes Yes 

226 M2C 
Direct sea-(different loading point compared to MC)-

Heavy lorry 
Yes Yes 

14.2. Empty vehicles description 

The computation of the empty vehicles’ matrices in the current version of the model is based on 

a non-linear, non-separable model. Therefore, the output in terms of empty vehicle flows, in 

general, will depend on the set of commodities included in the logistics model simulations. The 

flows of empty vehicles will be, correctly, estimated only if the model is run for all commodities. 

An exception to this observation is the set of user-defined empty vehicle modelling functions, in 

which empty train flows are modelled as strictly proportional to the number of loaded trains. With 

this setting the rail empty flows are strictly proportional to the loaded flows, and the results can 

be aggregated to total volumes from any disaggregated level.  

To obtain comparable results between scenarios, it is therefore recommended that the model is 

run for all commodities. There are two cases: 

• EMPTY_OK: the catalogue key for selecting the commodity group is set to 0, which 

means that all commodities are selected for the logistics model simulation; This 0 is also 

added to the vehicle OD-matrix names as for example OD_Tonnes201_0.314, which 

during the railway capacity management procedure are renamed to 

OD_Tonnes201_STD.314, where STD stands for STanDard logistics model. 

• EMPTY_ERROR: all other cases, i.e., the model is run for one commodity or all 

commodity groups. In this case the empty vehicle flows will in general be according to 

non-separable relationships. 

The program generates three types of output matrices: the number of empty vehicles, the total 

number of (loaded and empty) vehicles and the number of tonnes transported. In the event of an 

EMPTY_ERROR, the total number of vehicles will be incorrect as well. This issue is addressed 

using the two methods outlined below.  

 

1: Compute the number of loaded vehicles.  

Instead of producing the total number of vehicles (empty + loaded), the program now produces 

the number of loaded vehicles. This is done by default, by computing:  

 

number of loaded vehicles = total number of vehicles – number of empty vehicles  
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held in an intermediate step in Cube, after the logistics model. This operation will always give the 

correct result, since the estimated number of empty vehicles is subtracted from the total number 

of vehicles in all OD relations. The output in the current version is presented in three matrices: 

• Number of loaded vehicles (always correct values); 

• Number of empty vehicles (comparable and correct only in case EMPTY_OK); 

• Tonnes (correct values). 

Furthermore, the total number of vehicles will be computed in the case EMPTY_OK, by adding 

the empty and loaded vehicles outputs. For the other case – EMPTY_ERROR – the total number 

of vehicles will be replaced by zeros. in order to reduce the risk of using incorrect values. This 

gives the following additional output: 

• Total number of vehicles (correct in case EMPTY_OK, set to zero otherwise). 

The output in terms of total number of vehicles appears in some of the tables, but not in any of 

the networks. Generally, in the outputs, the number of vehicles always refers to the number of 

loaded vehicles, if nothing else is expressed.  

 

 

2: Skip estimation of the empty vehicles 

The user is given the option to not produce the empty vehicle matrices at all. The choice is made 

by setting the following attribute:  

• EMPTY_V = 1  to produce empty vehicle matrices, or 

• EMPTY_V = 0  to not produce empty vehicle matrices. 

The attribute is set for each vehicle class separately, in the table “Vehicle Parameters” (see 

Section 9.4). If EMPTY_V=0, the empty vehicle matrices will be filled with zeroes. Summarizing 

all the possibilities, the following cases can appear, see Table 48. 

 

Table 48 All different cases for the empty and total vehicles calculation 

 EMPTY_V=0 EMPTY_V=1 

EMPTY_OK 
Empty vehicles = 0 

Total vehicles = loaded vehicles 

Empty vehicles ≠ 0 

Total vehicles = empty + loaded 

EMPTY_ERROR 
Empty vehicles = 0 

Total vehicles = 0 

Empty vehicles ≠ 0 

Total vehicles = 0 

 

The empty vehicles calculation was designed for lorries, but is used for all vehicles as described 

above. 

14.3. Frequency network 

The frequency networks are saved and can be displayed as GIS maps in the Samgods model. 

They can be edited, as any other GIS layers, using the Compute function or the Feature Explorer 

window. However, editing these layers in the GIS window is rather difficult and slow. New 

terminals are given default frequencies, so that the user does not have to edit the frequency 

networks, unless any specific frequencies should be changed. The reason for saving the 

frequency data as GIS layers, instead of a matrix, is that it saves hard disk space. The user 

needs to think of the node layer as the diagonal elements of the imagined frequency matrix 

(giving the frequencies within zones), and the link layer as the non-diagonal elements, giving the 

frequencies between zones. By default, the frequency network layers are initially filtered to show 

only the links and nodes connected to Stockholm.  
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14.4. Variable names and their meaning 

Below, some of the variable names in different tables in the interface are listed and explained 

(see Table 49). Table 54 in Section 14.7 also gives information to help to understand the 

contents of the tables. 

14.4.1. Variables in the output tables 

In the output tables, different variable names appear. Table 50 gives the variables, their meaning 

and in which data set (under the Data Section window) they appear. These data sets can be 

found in Scenario Outputs\Samgods Report\Logistics Module\OD Covered and Scenario 

Outputs\Samgods Report\Reports. Generally, the abbreviations listed in Table 49 are used, 

separated by an underscore. 

 

Table 49 Abbreviations used for variable names 

NV Number of vehicles 

KM Kilometre 

TON Tonne 

TKM Tonne Kilometre 

VHCLKM Vehicle Kilometre 

DOM Domestic 

DTOT Total domestic (domestic + domestic part of international) 

INT International 

TOT Total (in the sense total domestic + international) 

L Loaded (vehicle) 

E Empty (unloaded vehicle) 

A All (in the sense loaded + empty vehicles) 

 

Table 50 Variable names used in the output files in the folders Scenario Outputs\Samgods 

Report\Logistics Module\OD Covered and Scenario Outputs\Samgods Report\Reports in the Data 

Section window 

Data set Variable Meaning 

Output by vehicle type NV_DTOT Number of vehicles, total domestic 

Output by vehicle type NV_INT Number of vehicles, international 

Output by vehicle type NV_TOT Number of vehicles, total 

Output by vehicle type, Output by 

chain 
KM_DTOT Number of kilometres, total domestic 

Output by vehicle type, Output by 

chain 
KM_INT Number of kilometres, international 

Output by vehicle type, Output by 

chain 
KM_TOT Number of kilometres, total 

Output by vehicle type, Output by 

chain 
TON_DTOT Number of tonnes, total domestic 

Output by vehicle type, Output by 

chain 
TON_INT Number of tonnes, international 

Output by vehicle type, Output by 

chain 
TON_TOT Number of tonnes, total 

Output by vehicle type, Output by 

chain 
TKM_DTOT 

Number of tonne kilometres, total 

domestic 

Output by vehicle type, Output by 

chain 
TKM_INT 

Number of tonne kilometres, 

international 

Output by vehicle type, Output by 

chain 
TKM_TOT Number of tonne kilometres, total 

Output by vehicle type ALF_DOM Average loading factor, domestic 

Output by vehicle type ALF_INT Average loading factor, international 

Output by vehicle type ALF_TOT Average loading factor, total 
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Data set Variable Meaning 

Output by vehicle type AVDIST_DOM Average distance, domestic 

Output by vehicle type AVDIST_INT Average distance, international 

Output by vehicle type AVDIST_TOT Average distance, total 

Output by chain COST_DOM Logistic cost, domestic 

Output by chain COST_DTOT Logistic cost, total domestic 

Output by chain COST_INT Logistic cost, international 

Output by chain COST_TOT Logistic cost, total 

Output by chain AC_TKM_DOM 
Average cost per tonne kilometre, 

domestic 

Output by chain AC_TKM_INT 
Average cost per tonne kilometre, 

international 

Output by chain AC_TKM_TOT Average cost per tonne kilometre, total 

Report #1 NV_A_TOT 
Number of vehicles, loaded + empty, 

total domestic + international 

Report #1 NV_A_DTOT 
Number of vehicles, loaded + empty, 

total domestic 

Report #1 VHCLKM_A_TOT 
Number of vehicle kilometres, loaded + 

empty, total domestic + international 

Report #1 VHCLKM_A_DTOT 
Number of vehicle kilometres, loaded + 

empty, total domestic 

Report #1 NV_L_TOT 
Number of loaded vehicles, total 

domestic + international 

Report #1 NV_E_TOT 
Number of empty vehicles, domestic + 

international 

Report #1 VHCLKM_L_TOT 
Number of loaded vehicle kilometres, 

domestic + international 

Report #1 VHCLKM_E_TOT 
Number of unloaded vehicle kilometres, 

domestic + international 

Report #1 NV_L_DTOT 
Number of loaded vehicles, total 

domestic 

Report #1 NV_E_DTOT 
Number of empty vehicles, total 

domestic 

Report #1 VHCLKM_L_DTOT 
Number of loaded vehicle kilometres, 

total domestic 

Report #1 VHCLKM_E_DTOT 
Number of empty vehicle kilometres, 

total domestic 

Report #4 TON_DTOT Number of tones, total domestic 

Report #4 TON_INT Number of tones, international 

Report #4 TON_TOT Number of tones, dom. + int. 

Report #4 TKM_DTOT 
Number of tonne kilometres, total 

domestic 

Report #4 TKM_INT 
Number of tonne kilometres, 

international 

Report #4 TKM_TOT 
Number of tonne kilometres, total 

domestic + international 

Report #9 VHCLKM_L_ROAD 
Number of loaded vehicle kilometres, 

road mode 

Report #9 VHCLKM_E_ROAD 
Number of empty vehicle kilometres, 

road mode 

Report #9 VHCLKM_A_ROAD 
Number of vehicle kilometres, empty + 

loaded vehicles on road 

Report #9 TKM_ROAD Number of tonne kilometres on road 

Report #9 VHCLKM_L_RAIL 
Number of loaded vehicle kilometres, 

rail mode 

Report #9 VHCLKM_E_RAIL 
Number of empty vehicle kilometres, 

rail mode 

Report #9 VHCLKM_A_RAIL 
Number of vehicle kilometres, empty + 

loaded vehicles on rail 

Report #9 TKM_RAIL Number of tonne kilometres on rail 
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14.4.2. Variables in the assigned networks 

Below, some of the variables found in the attribute tables of the assigned networks are listed and 

explained. The outputs in terms of assigned networks are found in the folders Scenario Outputs\ 

Samgods Report\Assignment (assigned networks per mode), Scenario Outputs\Samgods 

Report\Reports (assigned network with all modes) and Scenario Outputs\Compare\Assignment 

(differences between the current scenario and the base scenario in loaded vehicle flows for all 

modes). In the assigned networks (except the compared vehicle flows, see below), the rule for 

the variable names is the following: 

Each vehicle type has a label (the labels are found in the table Scenario Inputs\Editable 

data\Vehicles Parameters in the data Section window). For example, vehicle class 101 has the 

label LGV3. For each vehicle class there are three attributes in the network, which for the 

example for LGV3 are LGV3 (only the label), LGV3T (label + T) and LGV3E (label + E). LGV3 

then gives the number of loaded LGV3 vehicles per year on the link, LGV3T gives the number of 

tonnes transported by LGV3 vehicles per year and LGV3E gives the number of empty (unloaded) 

LGV3 vehicles per year. There is one exception from this rule and that is the attribute 

FS_TRAIN, which cannot be found in the Vehicles Parameters table. FS_TRAIN is the sum of 

the attributes FEEDV and FEEDW, which are two separated assignments for vehicle class 202 

(Feeder/shunt train). 

Except the attributes for each vehicle class, there are also aggregated numbers in the networks 

(for air mode there are no aggregated numbers, since there is only one vehicle type for air mode 

(label FLYG)), see Table 51. 

 

Table 51 Variable names in the assigned networks and their meanings. 

Variable Meaning 

TOT_ROAD Total number of loaded road vehicles 

TOT_RAIL Total number of loaded rail vehicles 

TOT_SEA Total number of loaded sea vehicles 

TOT_ROAD_T Total numbers of tonnes transported by road vehicles 

TOT_RAIL_T Total numbers of tonnes transported by trains 

TOT_SEA_T Total numbers of tonnes transported by sea vehicles 

TOT_ROAD_E Total number of empty road vehicles 

TOT_RAIL_E Total number of empty rail vehicles 

TOT_SEA_E Total number of empty sea vehicles 

VOLTO Total number of loaded vehicles 

TONTO Total number of tonnes transported 

EMPTO Total number of empty vehicles 

 

For the compared assigned network, only the loaded vehicle flows are included and they are 

represented by the vehicle class label, with the prefix DIF. For the example used above, the 

variable DIF_LGV3 gives the difference in number of loaded LGV3 vehicles, between the current 

scenario and the base scenario. Moreover, there are differences in aggregated loaded vehicle 

flows, represented by e.g., DIF_ROAD and DIF_VOLTO (the latter gives the compared flows 

summed for all vehicle types).
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14.5. Intra zonal flows treatment 

The intrazonal flows are presented in a number of reports. The different cases are related to 

which procedure or program is running. As simple principle, all the reports derived from the 

external programs will contain the intrazonal tons values, meanwhile all the reports from Voyager 

assignment will exclude those values. The following scheme represents the cases presented in 

Table 52. 

 

Table 52 Reports including or excluding intrazonal tonnes values 

Report name 

Intrazonal 

Values 

included 

Report_1 Tot VHCKM by VHC Type No 

Report_2_Logistics Module Yes 

Report_2_LM_CHAINS Yes 

Report_2_LM_DEMAND Yes 

Report_3_TonKm_Per_Mode_With_2006Statistics Yes 

Report_4_Total tonne kms by VHC Type No 

Report_5_Total logistic cost at zone-level Yes 

Report_6_Goods flow through terminals (number of tonnes in and out per year) Yes 

Report_6_b_Goods flow through terminals (total number of tonnes per year without land-based 

transfers) 
Yes 

Report_7_Domestic tonne kms with container per mode (road, rail, sea, air) and vehicle cl Yes 

Report_8_Domestic vehicle kms with container per mode (road, rail, sea, air) and vehicle cl Yes 

Report_9_Vehicle kms and Tonne kms per geographic region No 

Report_10_Transport work (tonne kms) per mode and vehicle cl, total and split per commodity, 

domestic, tdomestic and international 
Yes 

Report_11_ Transported goods volume per mode and vehicle cl, total and split per commodity, 

domestic, tdomestic and international 
Yes 

Report_12_node and link costs per vehicle and product group Yes 

Report_13_Tons_per_PortArea_and_Commodity_Group No 

Report_14_Oresund Bridge_Kiel Canal and Jylland No 

Report_15_Trains per day (tot, empty, loaded) No 

Report_16_VHCLKM and distribution by county - totals  No 

Report_17_VHCLKM and distribution by county - E10 roads  No 

Report_18_VHCLKM and distribution by country - Other roads  No 

Report_19_Loaded_Unloaded_Tons_Rail  Yes 

Report_20 Inventory and order cost per commodity group  

Report_21_Domestic Total and International Tonkm and VhclKm per commodity group RCM - Rail No 
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14.6. Error handling within model structure 

Table 53 List of batch files calling external program, location and scripts which manage potential failure 

ID Name and location during the run Purpose Script creating the batch file Script having error handling 

1 
{SCENARIO_DIR}\LogMod_{OverallLoo

pMax}\RCM\1_RUN_SelectDirect.bat 

Select link analysis for STD and 

RCM 

{CATALOG_DIR}\02_APPLICATIONS\10_SELECT

LINK\CFMAT01M.S 

{CATALOG_DIR}\02_APPLICATIONS\10_SELECTLINK

\PNPIL00A.S 

2 

{SCENARIO_DIR}\LogMod_{OverallLoo

pMax}\RCM\2_RUN_SelectDirect_CBA.

bat 

Select link analysis for CBA 
{CATALOG_DIR}\02_APPLICATIONS\10_SELECT

LINK\CFMAT01M.S 

{CATALOG_DIR}\02_APPLICATIONS\10_SELECTLINK

\PNPIL00A.S 

3 
{SCENARIO_DIR}\LogMod\RCM\CB_R

UN_LOS.BAT 

create LOS matrices without 

rescaling factors 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LO

MAT01B.S 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LOPIL0

1A.S 

4 
{SCENARIO_DIR}\LOGMOD\RUNALL_

CBA.BAT 
run LP2CC for CBA 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP

2CC\RLMAT01A.S 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP2CC\

RLPIL01B.S 

5 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY_CBA.BAT 
sub bat file for ID 4 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP

2CC\RLMAT01B.S 
 

6 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R_CBA.BAT 
parallel process for ID 4 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP

2CC\RLMAT01E.S 
 

7 
{SCENARIO_DIR}\LOGMOD\MERGER

EP\MERGEREPALLCBA.BAT 
Mergerep program 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP

2CC\RLMAT01D.S 
 

8 

 

{SCENARIO_DIR}\LogMod\RCM\COM

MODITY_CBA.BAT 

 Produce Commodity_CBA.dat and 

VehicleTrpEmpInv_Input_CBA.dat 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP

2CC\RLMAT01F.S 

{CATALOG_DIR}\02_APPLICATIONS\11_CBA\LP2CC\

RLPIL01A.S 

9 
{SCENARIO_DIR}\LOGMOD\RUNALL.

BAT 

Run STD log mod Build Chain, 

Chainchoi and ConsolidRateMode 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG

ISTICMODVY\RLMAT01A.S 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOGISTI

CMODVY\RLPIL01B.S 

10 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY.BAT 
sub bat file for ID 9 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG

ISTICMODVY\RLMAT01B.S 
 

11 
{SCENARIO_DIR}\LOGMOD\EXTRACT

\EXTRACTALL.BAT 
Extract vehicle and ton matrices 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG

ISTICMODVY\RLMAT01C.S 
 

12 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R.BAT 
Parallel process for ID 9 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG

ISTICMODVY\RLMAT01E.S 
 

13 
{SCENARIO_DIR}\LOGMOD\MERGER

EP\MERGEREPALL.BAT 
Mergerep program 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\LOG

ISTICMODVY\RLMAT01D.S 
 

14 
{SCENARIO_DIR}\LOGMOD\RCM\CO

MMODITY_STD.BAT 

Produce COMMODITY_STD.dat 

file (tons and vehicle figures by 

commodity group) which is 

translated into 

Loaded_Bid_STD_Link 

{CATALOG_DIR}\02_APPLICATIONS\2_RUN\RES

ULTS\BDMAT01B.S 

{SCENARIO_DIR}\02_APPLICATIONS\2_RUN\RESUL

TS\BDPIL01C.S 

15 
{SCENARIO_DIR}\LogMod\RCM\0_Co

mpact.bat 
Compact spanning tree data 

{CATALOG_DIR}\02_Applications\9_RCM1\DATAP

REP_LP\DPMAT01B.S 

{CATALOG_DIR}\02_Applications\9_RCM1\DATAPREP

_LP\DPPIL01A.S 

16 
{SCENARIO_DIR}\LogMod\RCM\1_RU

N_MPS_LP0_step1.BAT 
LP step W 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0

\LPMAT00B.S 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0\LPP

IL00B.S 
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ID Name and location during the run Purpose Script creating the batch file Script having error handling 

17 
{SCENARIO_DIR}\LogMod\RCM\2_run

LP.bat 
LP Solve 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0

\LPMAT00C.S 
No 

18 
{SCENARIO_DIR}\LogMod\RCM\3_RU

N_MPS_LP0_step2.BAT 
LP step LXR 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0

\LPMAT00D.S 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP0\LPP

IL00G.S 

19 
{SCENARIO_DIR}\LOGMOD\RUNALL_

RCM.BAT 

Run RCM Build Chain and 

Chainchoi 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1

\RLMAT01A.S 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1\RLP

IL01E.S 

20 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY_RCM.BAT 
sub bat file for ID 19 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1

\RLMAT01B.S 
 

21 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R.BAT 
parallel process for ID 19 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1

\RLMAT01E.S 
 

22 
{SCENARIO_DIR}\LogMod\RCM\1_RU

N_MPS_LP@RCM_Loop@_step1.BAT 
LP 1+ step w 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1

\FPMAT00B.S 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1\FPP

IL00E.S 

23 
{SCENARIO_DIR}\LogMod\RCM\2_run

@RCM_Loop@.bat 
LP Solve 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1

\FPMAT00C.S 
No 

24 
{SCENARIO_DIR}\LogMod\RCM\3_RU

N_MPS_LP@RCM_Loop@_step2.BAT 
LP 1+ step LXR 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1

\FPMAT00D.S 

{CATALOG_DIR}\02_Applications\9_RCM1\LP\LP1\FPP

IL00F.S 

25 
{SCENARIO_DIR}\LOGMOD\RUNALL_

FIN.BAT 
Run LP2CC for FINAL 

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\

RLMAT01A.S 

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\RLPI

L01B.S 

26 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY_FIN.BAT 
sub bat file for ID 25 

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\

RLMAT01B.S 
 

27 
{SCENARIO_DIR}\LOGMOD\EXTRACT

\EXTRACTALL_FIN.BAT 
Extract vehicle and ton matrices 

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\

RLMAT01F.S 
 

28 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R.BAT 
Parallel process for ID 25 

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\

RLMAT01G.S 
 

29 
{SCENARIO_DIR}\LOGMOD\MERGER

EP\MERGEREPALLFIN.BAT 
Mergerep program 

{CATALOG_DIR}\02_Applications\9_RCM1\FINAL\

RLMAT01D.S 
 

30 
{SCENARIO_DIR}\LOGMOD\RCM\CO

MMODITY_XTD.BAT 

Produce COMMODITY_XTD.dat 

and 

VehicleTrpEmpInv_Input_XTD.dat 

{CATALOG_DIR}\02_Applications\9_RCM1\RESUL

TS\BDMAT01B.S 

{CATALOG_DIR}\02_Applications\9_RCM1\RESULTS\B

DPIL01C.S 

31 
{SCENARIO_DIR}\LOGMOD\RUNALL.

BAT 
Run STD log mod 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\1_RUN\3_LOGISTICMOD\RLMAT01A.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

1_RUN\3_LOGISTICMOD\RLPIL01B.S 

32 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY.BAT 
sub bat file for ID 9 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\1_RUN\3_LOGISTICMOD\RLMAT01B.S 
 

33 
{SCENARIO_DIR}\LOGMOD\EXTRACT

\EXTRACTALL.BAT 
Extract vehicle and ton matrices 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\1_RUN\3_LOGISTICMOD\RLMAT01C.S 
 

34 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R.BAT 
Parallel process for ID 9 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\1_RUN\3_LOGISTICMOD\RLMAT01E.S 
 

35 
{SCENARIO_DIR}\LOGMOD\MERGER

EP\MERGEREPALL.BAT 
Mergerep program 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\1_RUN\3_LOGISTICMOD\RLMAT01D.S 
 

36 
{SCENARIO_DIR}\LogMod\RCM\0_Co

mpact.bat 
Compact spanning tree data 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\1_DATAPREP_LP\DPMAT01B.S 

 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\1_DATAPREP_LP\DPPIL01A.S 
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ID Name and location during the run Purpose Script creating the batch file Script having error handling 

37 
{SCENARIO_DIR}\LogMod\RCM\1_RU

N_MPS_LP0_step1.BAT 
LP step W 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\LPMAT00B.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\2_LP_STEPS\LPPIL00B.S 

38 
{SCENARIO_DIR}\LogMod\RCM\2_run

LP.bat 
LP Solve 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\LPMAT00C.S 
No 

39 
{SCENARIO_DIR}\LogMod\RCM\3_RU

N_MPS_LP0_step2.BAT 
LP step LXR 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\LPMAT00D.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\2_LP_STEPS\LPPIL00G.S 

40 
{SCENARIO_DIR}\LOGMOD\RUNALL_

RCM.BAT 

Run RCM Build Chain and 

Chainchoi 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\RLMAT01A.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\2_LP_STEPS\RLPIL01E.S 

41 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY_RCM.BAT 
sub bat file for ID 19 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\RLMAT01B.S 
 

42 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R.BAT 
parallel process for ID 19 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\RLMAT01E.S 
 

43 
{SCENARIO_DIR}\LogMod\RCM\1_RU

N_MPS_LP@RCM_Loop@_step1.BAT 
LP 1+ step w 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\FPMAT00B.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\2_LP_STEPS\FPPIL00E.S 

44 
{SCENARIO_DIR}\LogMod\RCM\2_run

@RCM_Loop@.bat 
LP Solve 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\FPMAT00C.S 
No 

45 
{SCENARIO_DIR}\LogMod\RCM\3_RU

N_MPS_LP@RCM_Loop@_step2.BAT 
LP 1+ step LXR 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\2_LP_STEPS\FPMAT00D.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\2_LP_STEPS\FPPIL00F.S 

46 
{SCENARIO_DIR}\LOGMOD\RUNALL_

FIN.BAT 
Run LP2CC for FINAL 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\3_FINAL\RLMAT01A.S 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTICITY\

2_RCM\3_FINAL\RLPIL01B.S 

47 
{SCENARIO_DIR}\LOGMOD\COMMOD

ITY_FIN.BAT 
sub bat file for ID 27 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\3_FINAL\RLMAT01B.S 
 

48 
{SCENARIO_DIR}\LOGMOD\EXTRACT

\EXTRACTALL_FIN.BAT 
Extract vehicle and ton matrices 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\3_FINAL\RLMAT01F.S 
 

49 
{SCENARIO_DIR}\LOGMOD\CALL_JA

R.BAT 
Parallel process for ID 27 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\3_FINAL\RLMAT01G.S 
 

50 
{SCENARIO_DIR}\LOGMOD\MERGER

EP\MERGEREPALLFIN.BAT 
Mergerep program 

{CATALOG_DIR}\02_APPLICATIONS\12_ELASTI

CITY\2_RCM\3_FINAL\RLMAT01D.S 
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14.7. Structure of Data Section window 

Table 54 List of inputs and outputs accessible from the Data Section window 

Folder Name Description 
Used by 

application 

Scenario Inputs 

List of scenarios 

This folder contains all the inputs for the 

scenarios 

Given a base scenario with standard costs, the 

process applies variation of costs expressed as 

variation in % 

All 

Elasticity Module 

Logit parameters by 

commodity and f2f type 

Table with logit parameter for Chain Choice by 

commodity group and flow-to-flow type 

Samgods 

Model/Elasticity 

Module 

Number of missing 

calibration parameters 

Report providing information on consistency 

checks between calibration parameters and 

input data – produced after full run of Edit the 

data application 

Edit the data 

KielParameter Kiel scaling factor  

Samgods 

Model/Elasticity 

Module 

Scenario Inputs\Model 

Operating instructions 

Model Operating 

Instructions 

Rtf file with a brief description on how to run the 

Samgods GUI 
All 

Scenario 

Inputs\General tables 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Link Categories Lookup table for the categories in the network All 

NodeClass description 
Lookup table for the numbering system (no 

longer required for the VY part) 
All 

Transfer Type at 

terminals 

Lookup table for the transfer type coded in the 

Nodes_Commodities data 

Samgods 

Model/Elasticity 

Module 

List and codes for 

modes (only visible in 

developer mode) 

Alphanumerical codes for modes All 

Zoning System 
Lookup table for the ID_Region and ID_Country 

codes 
All 

Modes Lookup table for codes used for modes All 

V101 Speed Flow 

Curves 

Speed flow table with parameter values for 

defining the delay functions for vehicle class 101 

(light lorry) 

Samgods 

Model/Elasticity 

Module 

V102 Speed Flow 

Curves 

Same as previous but for vehicle classes 102-

105 

Samgods 

Model/Elasticity 

Module 

Ranges for node 

classes (only visible in 

developer mode) 

For node classes from 12 to 19 the range of 

allowed values for node numbers 
Edit the data 

Default values for the 

frequency matrices 

(only visible in 

developer mode) 

Default frequencies for different vehicle classes 

based on the terminal type 
Edit the data 

Port area classification Port areas classification for Swedish ports Edit the data 
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Folder Name Description 
Used by 

application 

Empty vehicle fractions 

per vehicle type and 

distance 

Function applied in extract procedure per vehicle 

type. The empty vehicles are calculated as 

fraction of loaded ones based on function 

depending on distance. 

Samgods 

Model/Elasticity 

Module 

County names 
List of Sweden counties (in Swedish: län) and 

related identification code 

Samgods 

Model/Elasticity 

Module 

Other statistics 2019 

Statistics on Kiel Canal, Öresund bridge and 

Jylland in year 2019 used in the calibration 

procedure 

Samgods 

Model/Elasticity 

Module 

Trakbandel definition 
Trakbandel codes with their description of 

section and corridor 

Samgods 

Model/Elasticity 

Module 

NEW- LBD_Ratio 
The Lower Bound Ratio used in the new rule 

implementation for consolidation 

Samgods 

Module\Logistics 

Module 

 NEW-Max Capacity 

and Consolidation 

exceptions 

The Max Capacity and Consolidation exceptions 

used in the new rule implementation for 

consolidation 

Samgods 

Module\Logistics 

Module 

Scenario 

Inputs\General 

tables\Logistics module 

(only visible in 

developer mode and 

advanced user) 

  

  

  

  

  

Main vehicle class for 

BuildChain 

The main vehicle type used in the BuildChain 

process by submode id (i.e., vehicle submode A-

U) and commodity (P1-P16). 

Samgods 

Model/Elasticity 

Module 

Vehicle types by chain 

and submode 

(ChainChoi) 

List of vehicle types (VHCL_NR) by submode id 

and commodity for ChainChoi 

Samgods 

Model/Elasticity 

Module 

Direct Access 

Whether direct access is active by commodity 

(P1-P16) and type of firm-to-firm flow (0-9, see 

table Type of Flow MATRIX below) 

Samgods 

Model/Elasticity 

Module 

Type of Flow MATRIX Lookup table with codes for type of flow matrices 

Samgods 

Model/Elasticity 

Module 

 Vessel Type 

(vessel/ship) 

Lookup table with codes for container and non-

container vessels 

Samgods 

Model/Elasticity 

Module 

Consolidation factors by 

chain (i. e. General and 

by product groups) 

Individual consolidation bounds for all sub 

modes [LB, UB] Default values and values by 

commodity group (-1 value means keep default 

values) 

Samgods 

Model/Elasticity 

Module 

List of Chains 2019 List of Chain types 

Samgods 

Model/Elasticity 

Module 

List of Chains 2045 List of Chain types 

Samgods 

Model/Elasticity 

Module 

Scenario 

Inputs\Editable data 
Input_Data.mxd General map to visualize all georeferenced data Edit the data 
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Folder Name Description 
Used by 

application 

  

  

  

  

EMME Network (211 

format) 

The Emme transport network with all link and 

node attributes  
Edit the data 

EMME Speed table Emme speed table  Edit the data 

General parameters 

(only visible in 

developer mode) 

Table with the scenario parameters catalogue 

key settings 
Edit the data 

Logistics model 

parameters (only visible 

in developer mode) 

Table with logistics module parameters Edit the data 

Cargo Table General values per commodity  Edit the data 

General Vehicles 

Parameters (by vhcl 

class only) 

Costs and capacity values by vehicle type. The 

attribute “EMPTY_V” (1 or 0) concerns whether 

the number of empty vehicles will be calculated 

(1) or not (0)  

Edit the data 

Specific Vehicles 

Parameters (by vhcl 

class and commodity 

group) 

Cost values by vehicle type and commodity 

group 
Edit the data 

Scenario Network 
Network (links and nodes) for all modes (GIS 

map) 
Edit the data 

Nodes Commodities 

GIS map with all terminals and specifications on 

allowed transfer types and commodities per 

terminal 

Edit the data 

Nodes 
GIS map of zones and terminals with values for 

the logistics module and port area classification 
Edit the data 

Ports Sweden 
GIS map of Swedish ports with the pilot fees by 

vehicle type (sea mode only) 
Edit the data 

Frequency network 

GIS map with service frequencies (transports per 

week) per mode/combination of modes and 

origin-destination connection. For more 

information on the frequency network, see the 

appendix 

Edit the data 

Tax by country Table Tax by country and vehicle type Edit the data 

Tax by Linkclass Table Tax by link type and vehicle type Edit the data 

Tax by link Table Tax for specific links by vehicle type Edit the data 

Toll bridges Table Bridge tolls per vehicle type Edit the data 

Rail capacity table Daily bidirectional capacity for domestic rail links Edit the data 

Scenario Inputs\Emme 

tables 

Default values for the 

EMME macros (only 

visible in developer 

mode) 

Table containing matrix names for LOS matrices 

in Emme format 
Edit the data 

Scenario Inputs\Others 

In-zone distances – 

default values (only 

visible in developer 

mode) 

Default values for distances within each zone 

(diagonal values in the distance matrices). 

Applied when origin and destination are in the 

same zone 

Samgods Model 
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Folder Name Description 
Used by 

application 

Geodatabase file for 

exported matrices 
Location of the geodatabase file 

Change matrix 

format 

Rail capacity table with 

EMME node numbers 

As Rail capacity table with added information of 

EMME nodes 
Samgods Model 

Folder of Scenario JA 

(CBA) 

Folder location of scenario JA used in CBA 

(Example: 

{CATALOG_DIR}\Scenario_Tree\Year_2019\Ba

se2019\) 

Cost Benefit 

Analysis - ASEK 

Values 

Scenario 

Inputs\PWC_Matrices 

PWC matrix by 

commodity 

Displays the PWC matrix in Voyager format for a 

specific commodity, see Section 7.8 for 

instructions 

PWC_Matrices 

Scenario 

Inputs\Calibration 

factors 

  

  

  

  

  

Port area differences 

(RCM) - output (only 

visible in developer 

mode) 

Differences between modelled and surveyed 

tonnes per port area and commodity group 

Samgods 

Model/Elasticity 

Module 

Parameters for Port 

Area Calculation (only 

visible in developer 

mode) 

Step length, minimum value, cut off value and 

default minimum value for calibration of port area 

throughputs 

Samgods 

Model/Elasticity 

Module 

Parameters for Kiel 

Canal Calculation (only 

visible in developer 

mode) 

Step length, minimum value, cut off value and 

default minimum value for calibration of Kiel 

Canal flows 

Samgods 

Model/Elasticity 

Module 

Port Area Scaling 

factors (only visible in 

developer mode) 

Resulting scaling factors applied by commodity 

group and port area to TIME skims 

Samgods 

Model/Elasticity 

Module 

Kiel Canal Scaling 

factor (only visible in 

developer mode) 

Resulting scaling factor for the Kiel canal applied 

to TOLL value 

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for Vehicle 

class parameters Part B 

Calibration parameters for vehicle costs by 

commodity group Part B 

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for Vehicle 

class parameters Part A 

Calibration parameters for vehicle costs by 

commodity group Part A 

Samgods 

Model/Elasticity 

Module 

Lock Solution by year Lock Solution by year 

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for 

technological factors 

under nodes 

Calibration parameters for the technological 

factors in nodes table 

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for rail 

capacities 

Calibration parameters to rescale rail capacities  

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for tax 

countries 

Calibration parameters for taxes by country 

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for tax links 
Calibration parameters for taxes on link level 

Samgods 

Model/Elasticity 

Module 

Parameters (Factors 

and Terms) for toll links 
Calibration parameters for tolls on links 

Samgods 

Model/Elasticity 

Module 
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Folder Name Description 
Used by 

application 

Parameters (Factors 

and Terms) for speeds 

and sea constraints in 

the network 

Calibration parameters for sped and capacity 

constraints on sea mode 

Samgods 

Model/Elasticity 

Module 

Scenario Outputs 

Existing Outputs (Log 

report) 
List of available outputs in the Samgods Report Samgods Model 

Number of 

inconsistencies in 

calibration factors 

Lists the number of inconsistencies observed 

between input data and calibration factors  

Edit the data/ 

Samgods Model 

Record File 1 Not relevant for the user  

Record File 2 Not relevant for the user  

Scenario 

Outputs\Scenario_Impo

rt_function_Report 

Report for the import 

phase (Log report) 

Report with any warnings or messages from the 

Scenario import function (in the Handling 

scenario application) (see Section 7.7) 

Handling 

scenario 

Scenario Outputs\Edit 

the data Report 

Report for the edit 

phase (Log report) 

Report with any warnings or error messages 

from the Edit the data application (see Section 

7.4) 

Edit the data 

Scenario 

Outputs\Scenario 

Tables_costs taxes tolls 

Network with costs for 

checking 

Binary network with Toll, Taxes and Fees 

integrated 

Samgods 

Model/Elasticity 

Module 

Tax_Country Scenario 

Table 
Taxes by Country ID applied in current scenario  

Samgods 

Model/Elasticity 

Module 

Tax_Category Scenario 

Table 
Taxes by Category applied in current scenario 

Samgods 

Model/Elasticity 

Module 

Tax_by_Link Scenario 

Table 

Specific taxes on links applied in current 

scenario 

Samgods 

Model/Elasticity 

Module 

Toll_by_link Scenario 

Table 
Tolls present in current scenario 

Samgods 

Model/Elasticity 

Module 

Vehicle_parameters 

Scenario Table 

Vehicle costs applied by vehicle type and 

commodity group in current scenario 

Samgods 

Model/Elasticity 

Module 

Scenario 

Outputs\Samgods 

Report\LOS matrices 

generation 

LOS Road Mode 
LOS matrices between zones (both terminals 

and actual zones) per vehicle type for: 

Samgods Model 
LOS Rail Mode time – T [hours], 

LOS Sea Mode distance – D [km], 

LOS Air Mode extra costs – X [SEK], 

 domestic distances – DD [km] 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Vehicles 

MAT 

Road – Vehicle Flows 

OD matrices of loaded vehicle flows by vehicle 

type. The sheet name indicates the vehicle type 

and the scenario name 

Samgods Model Rail – Vehicle Flows 

Sea – Vehicle Flows 

Air – Vehicle Flows 
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Folder Name Description 
Used by 

application 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Tonnes 

MAT 

Road – Goods Flows 

OD matrices in tonnes by vehicle type. The 

sheet name indicates the vehicle type and the 

scenario name 

Samgods Model Rail – Goods Flows 

Sea – Goods Flows 

Air – Goods Flows 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Empty 

Vehicles MAT 

Road – Empty vehicle 

Flows 

OD matrices of empty vehicle flows by vehicle 

type. The sheet name indicates the vehicle type 

and the scenario name. 

Samgods Model 

Rail – Empty vehicle 

Flows 

Sea – Empty vehicle 

Flows 

Air – Empty vehicle 

Flows 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Covered 

  

  

  

  

  

  

  

  

  

  

  

Output by vehicle class 

(spreadsheet for 

summary report no. 2: 

Logistics module) 

Summary table with information by vehicle type 

(number of shipments, number of loaded 

vehicles, transport distances, tonnes, tonne kms, 

average loading factors, average distances), 

split up on domestic, international and total 

Samgods Model 

Output by chain 

(spreadsheet for 

summary report no. 2: 

LM chains) 

Summary table with information by chain type 

(total numbers of shipments, transport distances, 

tonnes, tonne kms, logistic costs, average costs 

per tonne km), split up on domestic, international 

and total 

Samgods Model 

Loaded Demand 

(spreadsheet for 

summary report no. 2: 

LM Demand) (new) 

Summary table of the tonnes transported and 

the tonnes in the PWC-matrices together with 

allocation success rates 

Samgods Model 

Report #5 Logistics 

costs at zone level 

(spreadsheet for 

summary report no. 5) 

Logistics costs per zone by commodity group 

(P01-P16) and from/to flows to a zone 
Samgods Model 

Report #6 Goods flow 

through terminals 

(spreadsheet for 

summary report no. 6) 

Goods flow (tonnes) through terminals per 

commodity (P01-P16) and divided by direct 

access to (DAIMPORN), and from (DAEXPORN) 

or regular (REGULARN). Regular refers to flows 

not having direct access 

Samgods Model 

Report #6b Goods flow 

through terminals 

(excluding land-based 

transfers) (spreadsheet 

for summary report no. 

6b) STD 

Total goods flow (tonnes) through terminals per 

commodity (P01-P16) excluding land-based 

transfers 

Samgods Model 

Report #7 Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) 

(spreadsheet for 

summary report no. 7) 

Transport work (tonne kms) in Sweden for 

containers per commodity and vehicle type 
Samgods Model 
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Folder Name Description 
Used by 

application 

Report #8 Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) 

(spreadsheet for 

summary report no. 8) 

Traffic work (vehicle kms) in Sweden for 

container transports per commodity and vehicle 

type 

Samgods Model 

Report #10 Tonnes km 

per mode, commodity, 

domestic, total 

domestic and 

international 

(spreadsheet for 

summary report no. 10) 

Transport work (tonne kms) per commodity, 

mode. Split into three categories: domestic, total 

domestic and international respectively 

Samgods Model 

Report #11 Tonnes per 

mode, commodity, 

domestic, tdomestic 

and international 

(spreadsheet for 

summary report no. 11) 

Transported tonnes per commodity. Split into 

three categories: domestic, total domestic and 

international respectively 

Samgods Model 

Report#12 node and 

link costs per vehicle 

and product group 

(spreadsheet for 

summary report no. 12) 

Link and node costs per vehicle type, per 

commodity and split into total domestic and 

international respectively 

Samgods Model 

Report #19 Loaded and 

unloaded tons on rail 

terminals (spreadsheet 

for summary report no. 

19) 

Loaded and unloaded tons on Rail terminals per 

product group 
Samgods Model 

Scenario 

Outputs\Samgods 

Report\Assignment 

Road Assigned 

Network 
GIS network with the assignment of the freight 

flows to the transport network per vehicle type, in 

tonnes and in number of vehicles (loaded and 

empty). 

Samgods Model 
Rail Assigned Network 

Sea Assigned Network 

Air Assigned Network 

Scenario 

Outputs\Samgods 

Report\Reports 

  

  

  

  

  

  

  

  

  

  

Assigned Network 

GIS network with the assignment of the freight 

flows to the transport network with all vehicle 

types in the same network, in tonnes and in 

number of vehicles (loaded and empty). 

Samgods Model 

Report #1 VHCLKM 

(spreadsheet for 

summary report no. 1) 

Summary table of number of vehicle kms per 

vehicle type and mode (split up into 2 regional 

categories domestic and total domestic and 3 

aggregation levels loaded/empty/all vehicles).  

Samgods Model 

Report #3 Tonkm per 

Mode with statistics 

STD (spreadsheet for 

summary report no. 3) 

Tonne-kms in millions on domestic movements 

per main mode (Road, Rail, Sea) and 

international (Air) in standard logistics module 

Samgods Model 

Report #4 TONNESKM 

(spreadsheet for 

summary report no. 4) 

Summary table of tonne kms (domestic, 

international and total) per vehicle type and 

mode road, rail, sea and air. 

Samgods Model 

Report #9 Vehicle kms, 

tonne kms, empty 

vehicle kms and total 

vehicle kms per 

geographic region per 

mode (road, rail) 

Summary table of vehicle kms (split up into 

loaded, empty and all vehicles) and tonne kms 

per geographic region and mode (road and rail).  

Samgods Model 
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Folder Name Description 
Used by 

application 

(spreadsheet for 

summary report no. 9) 

Report #13 Port area 

statistics STD 

(spreadsheet for 

summary repost no. 13) 

Tonnes per port area and commodity group and 

comparison with statistics (results from standard 

logistics module) 

Samgods Model 

Report #14 Oresund 

Kiel canal STD 

(spreadsheet for 

summary report no. 14) 

Results on Öresund bridge, Kiel canal and 

Jylland and comparison with statistics (results 

from standard logistics module) 

Samgods Model 

Bidirectional tonnes per 

mode STD 

Network with bidirectional tonnes/100.000 per 

mode road, rail and sea (results from standard 

logistics module) 

Samgods Model 

Report #16 VHCLKM 

and distribution per 

road vehicle type and 

county – totals 

(spreadsheet for 

summary report no. 16) 

Vehicle kms per county and vehicle type and 

their distribution on all the roads (results from 

standard logistics module) 

Samgods Model 

Report #17 VHCLKM 

and distribution per 

road vehicle type and 

county – Category 11 

(spreadsheet for 

summary report no. 17) 

Vehicle kms per county and vehicle type and 

their distribution on E10 (European roads = 

category 11) (results from standard logistics 

module) 

Samgods Model 

Report #18 VHCLKM 

and distribution per 

road vehicle type and 

county – Other roads 

(spreadsheet for 

summary report no. 18) 

Vehicle kms per county and vehicle type and 

their distribution on all types roads except E10 

(results from standard logistics module) 

Samgods Model 

Scenario 

Outputs\Samgods 

Report\GIS Maps 

GIS map with Ktons by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group - Ktons 
Samgods Model 

GIS map with vhcl by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group Loaded Vhcl 
Samgods Model 

Scenario Outputs\RCM 

Report 

Rail Capacity table for 

current scenario 

Definition of rail bidirectional capacities per day 

for the current scenario 
Samgods Model 

  
Kiel Oresund Jylland 

RMSE calculation 

Comparison by mode of ml tonkm modelled vs 

observed and related RMSE 
Samgods Model 

 
Number of links over 

capacity 

Number of links where flows over capacity ratio 

is greater than one. In the event the number is 

zero, RCM process is skep since not required.  

Samgods Model 

Scenario Outputs\RCM 

Report\Logistic 

Module\OD Vehicles 

MAT 

Road – Vehicle Flows 

OD matrices of loaded vehicle flows by vehicle 

type (results from Rail Capacity Management 

module). The sheet name indicates the vehicle 

type and the scenario name. 

Samgods Model 

Rail – Vehicle Flows 

Air – Vehicle Flows 

Sea – Vehicle Flows 

Scenario Outputs\RCM 

Report\Logistic 

Module\OD Tonnes 

MAT 

Road – Goods Flows 

OD matrices in tones by vehicle type (results 

from Rail Capacity Management module). The 

sheet name indicates the vehicle type and the 

scenario name 

Samgods Model 
Rail – Goods Flows 

Air – Goods Flows 

Sea – Goods Flows 
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Folder Name Description 
Used by 

application 

Scenario Outputs\RCM 

Report\Logistic 

Module\OD Empties 

MAT 

Road – Empty vehicle 

Flows 

OD matrices of empty vehicle flows by vehicle 

type. 
Samgods Model 

Rail – Empty vehicle 

Flows 

Air – Empty vehicle 

Flows 

Sea – Empty vehicle 

Flows 

Scenario Outputs\RCM 

Report\Logistic 

Module\OD Covered 

  

  

  

  

  

  

  

  

  

  

  

Output by vehicle class 

(RCM) 

Summary table with information by vehicle type 

(number of shipments, number of loaded 

vehicles, transport distances, tonnes, tonne kms, 

average loading factors, average distances) and 

regional diff DTI. 

Samgods Model 

Output by chain (RCM) 

Summary table with information by chain type 

(total numbers of shipments, transport distance, 

tonnes, tonne kms, logistic cost, average cost 

per tonne km) and regional diff DTI. 

Samgods Model 

Loaded Demand (RCM) 

Summary table of the tonnes transported and 

the tonnes in the PWC-matrices together with 

allocation success rates 

Samgods Model 

Report #5 Logistic costs 

at zone level (RCM) 

(spreadsheet for 

summary report no. 5) 

Logistics costs per zone per commodity (P01-

P16) and from/to flows to a zone 
Samgods Model 

Report #6 Goods flow 

through terminals 

(spreadsheet for 

summary report no. 6) 

Goods flow (tonnes) through terminals per 

commodity (P01-P16) and divided by direct 

access to (DAIMPORN), and from (DAEXPORN) 

or regular (REGULARN). Regular refers to flows 

not having direct access 

Samgods Model 

Report #6b Goods flow 

through terminals 

(excluding land-based 

transfers) (spreadsheet 

for summary report no. 

6b) 

Total goods flow (tonnes) through terminals per 

commodity (P01-P16) excluding land-based 

transfers 

Samgods Model 

Report #7 Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) 

(RCM) (spreadsheet for 

summary report no. 7) 

Transport work (tonne kms) in Sweden for 

container transports per commodity and vehicle 

type 

Samgods Model 

Report #8 Domestic 

vehicle kms container 

per mode (road, rail, 

sea, air) (RC) 

(spreadsheet for 

summary report no. 8) 

Traffic work (vehicle kms) in Sweden for 

container transports per commodity and vehicle 

type 

Samgods Model 

Report #10 Tonnes km 

per mode, commodity, 

domestic, tdomestic 

and international (RCM) 

(spreadsheet for 

summary report no. 10) 

Transport work (tonne kms) per commodity, 

vehicle type and regional diff DTI 
Samgods Model 
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Folder Name Description 
Used by 

application 

 domestic/total domestic/international  

Report #11 Tonnes per 

mode, commodity, 

domestic, tdomestic 

and international 

(spreadsheet for 

summary report no. 11) 

Tonnes per commodity, vehicle type and 

regional diff DTI 
Samgods Model 

Report #12 node and 

link costs per vehicle 

and product group 

(RCM) (spreadsheet for 

summary report no. 12) 

Link and node costs per vehicle type, per 

commodity and regional diff DTI 
Samgods Model 

Report #19 Loaded and 

unloaded tons on rail 

terminals (spreadsheet 

for summary report no. 

19) (new) 

Loaded and unloaded tons on Rail terminals per 

product group 
Samgods Model 

Scenario Outputs\RCM 

Report\Assignment 

Road Assignment 

Network (RCM) 

GIS network with the assignment of the freight 

flows to the transport network per vehicle type, in 

tonnes and in number of loaded and empty 

vehicles respectively 

Samgods Model 

Rail Assignment 

Network (RCM) 

Sea Assignment 

Network (RCM) 

Air Assignment Network 

(RCM) 

Scenario Outputs\RCM 

Report\Reports 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Assigned Network 

GIS network with the assignment of the freight 

flows to the transport network with all vehicle 

types in the same network, in tonnes and in 

number of loaded and empty vehicles 

respectively 

Samgods Model 

Report #1 VHCLKM 

(RCM) (spreadsheet for 

summary report no. 1) 

Summary table of number of vehicle kms per 

vehicle type and mode (split up into regional diff 

DT and into loaded/empty total number of 

vehicles). 

Samgods Model 

Report #3 Tonkm per 

mode with statistics 

RCM (spreadsheet for 

summary report no. 3) 

Tonne-km in millions on domestic movements 

per main mode (Road, Rail, Sea) and 

international (Air) 

Samgods Model 

Report #4 TONNESKM 

(RCM) (spreadsheet for 

summary report no. 4) 

Summary table of tonne kms by regional DTI per 

vehicle type and mode 
Samgods Model 

Report #9 Vehicle kms, 

tonne kms, empty 

vehicle kms and total 

vehicle kms per 

geographic region per 

mode (road, rail) (RCM) 

(spreadsheet for 

summary report no. 9) 

Summary table of vehicle kms (split up into 

#LEA-vehicles) and tonne kms per geographic 

region and mode (road and rail) 

Samgods Model 

Report #13 Port area 

statistics (RCM) 

(spreadsheet for 

summary report no. 13) 

Tons per port area and commodity group and 

comparison with statistics 
Samgods Model 

Report #14 Oresund 

Kiel canal (RCM) 

(spreadsheet for 

summary report no. 14) 

Results on Öresund bridge, Kiel canal and 

Jylland and comparison with statistics 
Samgods Model 
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Folder Name Description 
Used by 

application 

Report #15 Trains per 

day (tot, empty, loaded) 

from RCM procedure 

(spreadsheet for 

summary report no. 15) 

Number of loaded and empty trains per day 

bidirectional and differences between totals and 

capacities and associated marginal costs 

Samgods Model 

Report #15b Rail 

Capacity Network 

Network with capacities and #LEA-trains per day 

(same statistics as in Report #15 but shown in 

the network) 

Samgods Model 

Bidirectional tonnes per 

mode RCM 
Network with bidirectional tonnes/100.000 Samgods Model 

Report #16 VHCLKM 

and distribution per 

road vehicles and 

county – totals (RCM) 

(spreadsheet for 

summary report no. 16) 

Vehicle kms per county and vehicle type and 

their distribution on all the roads 
Samgods Model 

Report #17 VHCLKM 

and distribution per 

road vehicles and 

county – Category 11 

(RCM) (spreadsheet for 

summary report no. 17) 

Vehicle kms per county and vehicle type and 

their distribution on E10 (European roads = 

category 11) 

Samgods Model 

Report #18 VHCLKM 

and distribution per 

road vehicles and 

county – Other roads 

(RCM) (spreadsheet for 

summary report no. 18) 

Vehicle kms per county and vehicle type and 

their distribution on other road types than E10 
Samgods Model 

Comparison Ml Tons 

RCM vs Standard per 

mode 

Absolute and percentage differences per mode 

road, rail and sea (in millions of tonnes) between 

RCM and STD 

Samgods Model 

Report Tons by 

commodity groups and 

total (Ktons) (related 

map under GIS maps\ 

GIS map with Ktons by 

commodity group) 

GIS network with total Ktons and divided by 

commodity group, and rail utilization as well (as 

percentage of capacity) 

Samgods Model 

Report #21 Domestic 

Total and International 

Tonkm and VhclKm by 

commodity group RCM 

- RAIL 

Table with tonkm, loaded and unloaded vhclkm 

per total domestic and international (tons are per 

year, vehicles per day) on rail. 

Samgods Model 

Scenario Outputs\RCM 

Report\GIS Maps 

GIS map with Ktons by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group - Ktons 
Samgods Model 

GIS map with vhcl by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group Loaded Vhcl 
Samgods Model 

Scenario Outputs\CBA 

Report > Main Reports 

Logistic Cost Changes 

used for CBA  

Table with results produced using methodology 

for CBA 

Cost Benefit 

Analysis - ASEK 

Values 

Vehicles, loaded and 

empty, within Swedish 

territory 

Report of vhcl-km for loaded and empties for 

emission model (ferries are expressed as ferry 

vehicles) 

Cost Benefit 

Analysis - ASEK 

Values 
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Folder Name Description 
Used by 

application 

Scenario Outputs\CBA 

Report\OD Covered 

  

  

  

  

  

  

  

  

  

  

  

  

Output by vehicle class 

(CBA) 

Summary table with information by vehicle type 

(number of shipments, number of loaded 

vehicles, transport distances, tonnes, tonne kms, 

average loading factors, average distances) and 

regional diff DTI. 

Cost Benefit 

Analysis - ASEK 

Values 

Report B 

Costs_D_I_X_T by 

vehicle type 

Summary table with information by vehicle type 

and vehicle on ferry of transport/ inventory and 

empty costs both in RCM and CBA 

Cost Benefit 

Analysis - ASEK 

Values 

Output by chain (CBA) 

Summary table with information by chain type 

(total numbers of shipments, transport distance, 

tonnes, tonne kms, logistic cost, average cost 

per tonne km) and regional diff DTI. 

Cost Benefit 

Analysis - ASEK 

Values 

Loaded Demand (CBA) 

Summary table of the tonnes transported and 

the tonnes in the PWC-matrices together with 

allocation success rates 

Cost Benefit 

Analysis - ASEK 

Values 

Report #5 Logistic costs 

at zone level (CBA) 

(spreadsheet for 

summary report no. 5) 

Logistics costs per zone per commodity (P01-

P16) and from/to flows to a zone. Cost based on 

ASEK values. 

Cost Benefit 

Analysis - ASEK 

Values 

Report #6 Goods flow 

through terminals 

(CBA) (spreadsheet for 

summary report no. 6) 

Goods flow (tonnes) through terminals per 

commodity (P01-P16) and divided by direct 

access to (DAIMPORN), and from (DAEXPORN) 

or regular (REGULARN). Regular refers to flows 

not having direct access 

Cost Benefit 

Analysis - ASEK 

Values 

Report #6b Goods flow 

through terminals 

(excluding land-based 

transfers) (CBA) 

(spreadsheet for 

summary report no. 6b) 

Total goods flow (tonnes) through terminals per 

commodity (P01-P16) excluding land-based 

transfers 

Cost Benefit 

Analysis - ASEK 

Values 

Report #7 Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) 

(CBA) (spreadsheet for 

summary report no. 7) 

Transport work (tonne kms) in Sweden for 

container transports per commodity and vehicle 

type 

Cost Benefit 

Analysis - ASEK 

Values 

Report #8 Domestic 

vehicle kms container 

per mode (road, rail, 

sea, air) (CBA) 

(spreadsheet for 

summary report no. 8) 

Traffic work (vehicle kms) in Sweden for 

container transports per commodity and vehicle 

type  

Cost Benefit 

Analysis - ASEK 

Values 

Report #10 Tonnes km 

per mode, commodity, 

domestic, tdomestic 

and international (CBA) 

(spreadsheet for 

summary report no. 10) 

Transport work (tonne kms) per commodity, 

vehicle type and regional diff DTI 

Cost Benefit 

Analysis - ASEK 

Values 
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Report #11 Tonnes per 

mode, commodity, 

domestic, tdomestic 

and international (CBA) 

(spreadsheet for 

summary report no. 11) 

Tonnes per commodity, vehicle type and 

regional diff DTI 

Cost Benefit 

Analysis - ASEK 

Values 

Report #12 node and 

link costs per vehicle 

and product group 

(CBA) (spreadsheet for 

summary report no. 12) 

Link and node costs per vehicle type, per 

commodity and regional diff DTI 

Cost Benefit 

Analysis - ASEK 

Values 

Report #19 Loaded and 

unloaded tons on rail 

terminals (spreadsheet 

for summary report no. 

19) (CBA) 

Loaded and unloaded tons on Rail terminals per 

product group 

Cost Benefit 

Analysis - ASEK 

Values 

Report #20 Order and 

inventory costs for 

TDOM and INT (CBA) 

Order and inventory cost per product group and 

total domestic/international using ASEK values 

Cost Benefit 

Analysis - ASEK 

Values 

Scenario 

Outputs\Compare\LOS 

matrices generation 

LOS Road Dif 

Absolute cost differences between the current 

scenario and the scenario used for comparison 

for the LOS matrices 

Compare 

Scenarios 

LOS Rail Dif 

LOS Sea Dif 

LOS Air Dif 

Scenario 

Outputs\Compare\Logis

tics Module\OD 

vehicles MAT 

Road OD Dif 

Absolute differences in loaded vehicles between 

the current scenario and the scenario used for 

comparison for the OD matrices 

Compare 

Scenarios 

Rail OD Dif 

Sea OD Dif 

Air OD Dif 

Scenario 

Outputs\Compare\Logis

tics Module\OD Tonnes 

MAT 

Road TON Dif 

Absolute differences in tonnes between the 

current scenario and the scenario used for 

comparison for the OD matrices 

Compare 

Scenarios 

Rail TON Dif 

Sea TON Dif 

Air TON Dif 

Scenario 

Outputs\Compare\Logis

tics Module\OD empty 

MAT 

Road EMP Dif 

Absolute differences in empty vehicles between 

the current scenario and the scenario used for 

comparison for the OD matrices. 

  

Compare 

Scenarios 

Rail EMP Dif 

Sea EMP Dif 

Air EMP Dif 

Scenario 

Outputs\Compare\Logis

tics Module\Tot Gen Att 

TRIPEND Road Dif 

Total generation (sum of each row) and 

attraction (sum of each column) for the vehicle 

OD matrices and absolute differences to the 

scenario used for comparison 

Compare 

Scenarios 

TRIPEND Rail Dif 

TRIPEND Sea Dif 

TRIPEND Air Dif 

Scenario 

Outputs\Compare\Assig

nment 

Compared Load Net 

STD 

GIS network with absolute differences between 

the current scenario and the scenario used for 

comparison of loaded vehicles flows for all 

vehicle types and modes from Standard logmod 

Compare 

Scenarios 

 Compared Load Net 

RCM 

GIS network with absolute differences between 

the current scenario and the scenario used for 
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comparison of loaded vehicles flows for all 

vehicle types and modes after RCM 

Scenario 

Outputs\Compare\GIS 

maps 

GIS map with 

differences (Ktons) 

GIS map with absolute differences between the 

current scenario and the scenario used for 

comparison of total tonnes and by commodity 

group 

Compare 

Scenarios 

Scenario 

Outputs\SelectLink\STD 

Flows and Tonnes 

Network STD 

GIS network loaded vehicles flows and tons for 

all vehicle types and modes using the set of 

links, nodes and commodities provided for the 

analysis 

Select Link 

Analysis 

Scenario 

Outputs\SelectLink\STD 

\OD Vehicles MAT 

Road - vehicle flows 

Select link matrices by mode for loaded vehicles 
Select Link 

Analysis 

Rail – vehicle flows 

Sea – vehicle flows 

Air – vehicle flows 

Scenario 

Outputs\SelectLink\STD 

\OD Tonnes MAT 

Road - good flows 

Select link matrices by mode for tonnes 
Select Link 

Analysis 

Rail – good flows 

Sea – good flows 

Air – good flows 

Scenario 

Outputs\SelectLink\STD 

\OD Empty Vehicles 

MAT 

Road -Empty vehicle 

flows 

Select link matrices by mode for unloaded 

vehicles 

Select Link 

Analysis 

Rail – Empty vehicle 

flows 

Sea – Empty vehicle 

flows 

Air – Empty vehicle 

flows 

Scenario 

Outputs\SelectLink\STD 

\GIS Maps 

GIS map with Ktons by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group Ktons 

Select Link 

Analysis 

  
GIS map with vhcl by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group Loaded Vhcl 

Select Link 

Analysis 

Scenario 

Outputs\SelectLink\RC

M 

Flows and Tonnes 

Network RCM 

GIS network loaded vehicles flows and tons for 

all vehicle types and modes using the set of 

links, nodes and commodities provided for the 

analysis 

Select Link 

Analysis 

Scenario 

Outputs\SelectLink\RC

M \OD Vehicles MAT 

Road - vehicle flows 

Select link matrices by mode for loaded vehicles 
Select Link 

Analysis 
Rail – vehicle flows 

Sea – vehicle flows 

Air – vehicle flows 

Scenario 

Outputs\SelectLink\RC

M \OD Tonnes MAT 

Road - good flows 

Select link matrices by mode for tonnes 
Select Link 

Analysis 
Rail – good flows 

Sea – good flows 

Air – good flows 

Scenario 

Outputs\SelectLink\RC

Road -Empty vehicle 

flows 

Select link matrices by mode for unloaded 

vehicles 

Select Link 

Analysis 
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M \OD Empty Vehicles 

MAT 

Rail – Empty vehicle 

flows 

Sea – Empty vehicle 

flows 

Air – Empty vehicle 

flows 

Scenario 

Outputs\SelectLink\RC

M\GIS Maps 

  

GIS map with Ktons by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group Ktons 

Select Link 

Analysis 

GIS map with vhcl by 

commodity group 

Standard GIS map with layers per Mode and 

commodity group Loaded Vhcl 

Select Link 

Analysis 

Scenario 

Outputs\SelectLink\Trav

ersalMat\STD 

Folder location for Road 

Traversal Matrices 

(STD) 

Traversal matrices in Emme format (314) on 

road mode 

Select Link 

Analysis 

Scenario 

Outputs\SelectLink\Trav

ersalMat\RCM 

Folder location for Road 

Traversal Matrices 

(RCM) 

Traversal matrices in Emme format (314) on 

road mode 

Select Link 

Analysis 

Scenario 

Reports\Logistic 

Module (contains the 

summary reports for 

standard logistic 

module) 

  

  

  

  

  

  

Report_1_Tot VHCKM 

by VHC Type 

Number of vehicle-kms per vehicle type (#LEA). 

And regional diff DT. 
Samgods Model 

Report_2_Logistics 

Module 

Summary table of no. of shipments, no. of 

loaded vehicles, transport distances, tonnes, 

tonne kms, average load factors and average 

distance by vehicle type by regional diff DTI 

Samgods Model 

Report_2_LM_CHAINS 

Summary table of no. of shipments, costs, 

vehicle kms, tonnes, tonne kms and average 

logistic costs per tonne km, by transport chain 

type 

Samgods Model 

Report_2_LM_DEMAN

D 

Summary table of the tonnes transported and 

the tonnes in the PWC-matrices together with 

allocation success rate 

Samgods Model 

Report_3_TonKm_by_

Mode_with_2016Statisti

csSTD 

Tonne-kms in millions on domestic movements 

per main mode (Road, Rail, Sea) and 

international (Air) 

Samgods Model 

Report_4_Total tkms by 

VHC type 

Summary table of tonne-kms (regional diff DTI) 

per vehicle type 
Samgods Model 

Report_5_Total logistic 

cost at zone-level 

Total logistics costs per commodity type (P01-

P16) split by import and export at geographical 

zone level 

Samgods Model 

Scenario 

Reports\Logistic 

Module (contains the 

summary reports for 

standard logistic 

module) 

  

  

  

  

  

  

  

  

  

Report_6_Goods flow 

through terminals 

(number of tonnes in 

and out per year) 

No. of tonnes through terminals (described as 

zones) per commodity (P01-P16), split into 

from/to flows for direct access and flow for other 

terminals (without direct access) 

Samgods Model 

Report_6_b_Goods 

flow through terminals 

(total number of tonnes 

per year without land-

based transfers) 

No. of tonnes through terminals (described as 

zones) per commodity (P01-P16), (without land-

based transfers) 

Samgods Model 

Report_7_Domestic 

tonne kms with 

container per mode 

Domestic tonne kms with container transports 

per mode and vehicle type, split by commodity. 
Samgods Model 
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(road, rail, sea, air) and 

vehicle cl 

Report_8_Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) and 

vehicle cl 

Domestic vehicle kms with container transports 

per mode and vehicle type, split by commodity 

Total volume is also reported 

Samgods Model 

Report_9_Vehicle kms 

and Tonnes kms per 

geographic region 

Vehicle kms (for #LEA-vehicles) and tonne kms 

per geographical region (road and rail mode). 
Samgods Model 

Report_10_Transport 

work (tonne kms) per 

mode and vehicle cl, 

total and split per 

commodity, domestic, 

tdomestic and 

international 

Transport work (tonne kms) per mode and 

vehicle type and commodity. Regional diff DTI 
Samgods Model 

Report_11_ 

Transported goods 

volume per mode 

vehicle cl, total and split 

per commodity, 

domestic, tdomestic 

and international 

Transported goods (in tonnes) per mode and 

vehicle type and commodity, as well as regional 

diff DTI 

Samgods Model 

Report_12_node and 

link costs per vehicle 

and product group 

Node and link costs per vehicle type and product 

group, divided in total domestic and international 
Samgods Model 

Report_13_Tons_per_P

ortArea_and_commodit

y_Group 

Tonnes per port area and commodity group and 

comparison with statistics 
Samgods Model 

Report_14_Oresund 

Bridge_Kiel Canal and 

Jylland 

Results on Öresund bridge, Kiel canal and 

Jylland and comparison with statistics 
Samgods Model 

Report_16_VHCLKM 

and distribution by 

county - totals STD 

Vehicle kms per county and vehicle type and 

their distribution on all the roads 
Samgods Model 

Report_17_VHCLKM 

and distribution by 

county - E10 roads STD 

Vehicle kms per county and vehicle type and 

their distribution on E10 (category 11) 
Samgods Model 

Report_18_VHCLKM 

and distribution by 

county Other roads 

STD 

Vehicle kms per county and vehicle type and 

their distribution on all the roads except E10 
Samgods Model 

Report_19_Loaded_Unl

oaded_Tons_Rail 

Loaded and unloaded tons on rail terminals per 

product group 
Samgods Model 

Scenario Reports\Rail 

Capacity Management 

(contains the summary 

reports for rail capacity 

management)  

  

  

  

  

Report_1_Tot VHCKM 

by VHC Type (RCM) 
Number of vehicle-kms (#LEA) Regional diff DT Samgods Model 

Report_2_Logistics 

Module (RCM) 

Summary table of no. of shipments, no. of 

loaded vehicles, transport distances, tonnes, 

tonne kms, average load factors and average 

distances by vehicle type, split up into regional 

diff DTI 

Samgods Model 
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Report_2_LM_CHAINS 

(RCM) 

Summary table of no. of shipments, costs, 

vehicle kms, tonnes, tonne kms and average 

logistic costs per tonne km, by transport chain 

type 

Samgods Model 

Report_2_LM_DEMAN

D (RCM) 

Summary table of the tonnes transported and 

the tonnes in the PWC-matrices together with 

allocation success rate 

Samgods Model 

Report_3_TonKm_per_

Mode_with_2016Statisti

cs (RCM) 

Tonne-kms in millions on domestic movements 

per main mode (Road, Rail, Sea) and 

international (Air) 

Samgods Model 

Report_4_Total tkms by 

VHC type (RCM) 

Summary table of tonnes and tonne-kms 

(regional diff DTI) per vehicle type 
Samgods Model 

Report_5_Total logistic 

cost at zone-level 

(RCM) 

Total logistics costs per commodity (P01-P16) 

split by from/to flow at geographical zone level 
Samgods Model 

Report_6_Goods flow 

through terminals 

(number of tonnes in 

and out per year) 

(RCM) 

No. of tonnes through terminals per P01-P16. Samgods Model 

Report_6_b_Goods 

flow through terminals 

(total number of tonnes 

per year without land-

based transfers) (RCM) 

No. of tonnes through terminals (described as 

zones) per commodity (P01-P16), (without land-

based transfers) 

Samgods Model 

Report_7_Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) and 

vehicle cl (RCM) 

Domestic tonne kms with container transports 

per mode and vehicle type, split by commodity 

Total volume is also reported 

Samgods Model 

Report_8_Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) and 

vehicle cl (RCM) 

Domestic vehicle kms with container transports 

per mode and vehicle type, split by commodity 

Total volume is also reported 

Samgods Model 

Report_9_Vehicle kms 

and Tonnes kms per 

geographic region 

(RCM) 

Vehicle kms (#LEA) and tonne kms per 

geographical region (road and rail mode). 
Samgods Model 

Report_10_Transport 

work (tonne kms) per 

mode and vehicle cl, 

total and split per 

commodity, domestic, 

tdomestic and 

international (RCM) 

Transport work (tonne kms) per mode, vehicle 

type and commodity, and regional diff DTI 
Samgods Model 

Report_11_ 

Transported goods 

volume per mode 

vehicle cl, total and split 

per commodity, 

domestic, tdomestic 

and international (RCM) 

Transported goods (in tonnes) per mode and 

vehicle type, commodity, and regional diff DTI 
Samgods Model 

Report_12_node and 

link costs per vehicle 

and product group 

(RCM) 

Node and link costs per vehicle type and product 

group, divided into regional diff DTI 
Samgods Model 
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Report_13_Tons_per_P

ortArea_and_Commodit

y_Group (RCM) 

Tons per port area and commodity group and 

comparison with statistics 
Samgods Model 

Report_14_Oresund 

Bridge_Kiel 

Canal_Jylland (RCM) 

Results on Öresund bridge, Kiel canal and 

Jylland and comparison with statistics 
Samgods Model 

Report_15_Trains per 

day (tot, empty, loaded) 

(RCM) 

Number of loaded and empty trains per day 

bidirectional and differences between totals and 

capacities 

Samgods Model 

Report_16_VHCLKM 

and distribution by 

county - totals (RCM) 

Vehicle kms per county and vehicle type and 

their distribution on all the roads 
Samgods Model 

Report_17_VHCLKM 

and distribution by 

county - E10 roads 

(RCM) 

Vehicle kms per county and vehicle type and 

their distribution on E10 (category 11) 
Samgods Model 

Report_18_VHCLKM 

and distribution by 

country - Other roads 

(RCM) 

Vehicle kms per county and vehicle type and 

their distribution on all the roads except E10 
Samgods Model 

Report_19_Loaded_Unl

oaded_Tons_Rail 

(RCM) 

Loaded and unloaded tons on rail terminals per 

product group 
Samgods Model 

Report_21_Domestic 

Total and International 

Tonkm and VhclKm per 

commodity group RCM 

- Rail 

Vehicle kms and tonne-kms for total domestic 

and international by commodity group 
Samgods Model 

Scenario Reports\CBA  

  

Report_2_Logistics 

Module 

Summary table of no. of shipments, no. of 

loaded vehicles, transport distances, tonnes, 

tonne kms, average load factors and average 

distance by vehicle type by regional diff DTI 

Cost Benefit 

Analysis - ASEK 

Values 

Report_2_LM_CHAINS 

(CBA) 

Summary table of no. of shipments, costs, 

vehicle kms, tonnes, tonne kms and average 

logistic costs per tonne km, by transport chain 

type 

Cost Benefit 

Analysis - ASEK 

Values 

Report_2_LM_DEMAN

D (CBA) 

Summary table of the tonnes transported and 

the tonnes in the PWC-matrices together with 

allocation success rate 

Cost Benefit 

Analysis - ASEK 

Values 

Report_5_Total logistic 

cost at zone-level 

Total logistics costs per commodity type (P01-

P16) split by import and export at geographical 

zone level 

Cost Benefit 

Analysis - ASEK 

Values 

Report_6_Goods flow 

through terminals 

(number of tonnes in 

and out per year) 

No. of tonnes through terminals (described as 

zones) per commodity (P01-P16), split into 

from/to flows for direct access and flow for other 

terminals (without direct access) 

Cost Benefit 

Analysis - ASEK 

Values 

Report_6_b_Goods 

flow through terminals 

(total number of tonnes 

per year without land-

based transfers) 

No. of tonnes through terminals (described as 

zones) per commodity (P01-P16), (without land-

based transfers) 

Cost Benefit 

Analysis - ASEK 

Values 
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Report_7_Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) and 

vehicle cl 

Domestic tonne kms with container transports 

per mode and vehicle type, split by commodity. 

Cost Benefit 

Analysis - ASEK 

Values 

Report_8_Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) and 

vehicle cl 

Domestic vehicle kms with container transports 

per mode and vehicle type, split by commodity 

Total volume is also reported 

Cost Benefit 

Analysis - ASEK 

Values 

Report_10_Transport 

work (tonne kms) per 

mode and vehicle cl, 

total and split per 

commodity, domestic, 

tdomestic and 

international 

Transport work (tonne kms) per mode and 

vehicle type and commodity. Regional diff DTI 

Cost Benefit 

Analysis - ASEK 

Values 

Report_11_ 

Transported goods 

volume per mode 

vehicle cl, total and split 

per commodity, 

domestic, tdomestic 

and international 

Transported goods (in tonnes) per mode and 

vehicle type and commodity, as well as regional 

diff DTI 

Cost Benefit 

Analysis - ASEK 

Values 

Report_12_node and 

link costs per vehicle 

and product group 

Node and link costs per vehicle type and product 

group, divided in total domestic and international 

Cost Benefit 

Analysis - ASEK 

Values 

Report_19_Loaded_Unl

oaded_Tons_Rail 

Loaded and unloaded tons on rail terminals per 

product group 

Cost Benefit 

Analysis - ASEK 

Values 

Report_20_Inventory 

and order cost per 

commodity group 

Order and inventory cost per product group and 

total domestic/international using ASEK values 

Cost Benefit 

Analysis - ASEK 

Values 
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